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Video Capture, Tracking, Behavioral, and Editing System

CAUTION
Camera Damage
Never connect or disconnect the camera
while the power is on. The camera can be
permanently damaged.



NOTE TO CINEPLEX V1 AND V2 USERS
The V3 version of CinePlex is not compatible with hardware, soft-
ware, or licensing for prior versions. DO NOT ATTEMPT TO 
INSTALL V3 ON SYSTEMS RUNNING PRIOR VERSIONS. It 
will not operate correctly, or, possibly, not at all.

Caution
Electrostatic Discharge
Some devices can be damaged by improper handling. Use appropri-
ate electrostatic discharge (ESD) procedures when handling these 
devices. See http://www.esda.org/ for additional information on ESD 
procedures.

CAUTION
Camera Damage
Never connect or disconnect the camera while the power is on. The 
camera can be permanently damaged.

Caution
USB Security Key Damage
Before installing Sentinel System security key drivers remove all 
Sentinel USB keys from the PC. If a system driver is installed with a 
USB key in the port, the key may become unusable.

http://www.esda.org/
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Publication History
February 2010

Document Version 3.0 is a complete rewrite for versions 3.0 of CinePlex Studio 
and CinePlex Editor.

February 2008
Document Version 2.0 is a complete rewrite for software versions 2.0 of CinePlex 
Studio and CinePlex Editor.

March 2007
Document Version 1.4 adds new user interface features, menu items, screenshots, 
and updates for CinePlex Studio text and CinePlex Editor text as well as additions 
and modifications to the appendices.

August 2006
Document Version 1.3 adds new features, menu items, screenshots, and minor 
updates to text.

December 2005
Document Version 1.2 adds new menu items, new snap-to capability,  a control 
for continuous channel loading, and other minor changes.

May 2005
Document Version 1.1 adds Recorder functionality.

March 2005
Version 1.0 is the first release of CinePlex.



iv CinePlex Plexon Inc

Version 3.0



Plexon Inc v

Contents

CinePlex

Publication History  iii

Chapter 1 
CinePlex System Overview  1

About the CinePlex System  2
CinePlex Studio Features  2
CinePlex Editor Features  3
CinePlex System Installation  4
About CinePlex Studio  4
About CinePlex Editor  6

Using the CinePlex System with a Plexon NDAQ  8
CinePlex System Hardware and Software Components  9

CinePlex Hardware Components  9
CinePlex Software Components  10
Multi-MAP Architecture  10
System Data Flow  12

Data Analysis  13
Effects on Monitor Functionality  13

Chapter 2 
Using CinePlex Studio  15

Getting Started  16
Designing the Experiment  17
Setting up the Equipment  18

Setting up the CinePlex System with a Plexon NDAQ  18
Performing an Operational Test  19

CinePlex Studio and a Plexon NDAQ  19
 Start-Up Sequence (MAP)  19
Start-Up Sequence (OmniPlex)  23

Setting up CinePlex Studio  24
Arranging CinePlex Studio Windows  24
Selecting File Locations  24
Positioning Camera 1  24
Tracking Mode Considerations (if tracking option is available)  25
Tracking Mode Settings (if the tracking mode is available)  31
Behavior Mode Settings (If the Behavior Option is available)  47

Executing the Experiment Plan  55



vi CinePlex Plexon Inc

Version 3.0

Digital Video Recording  55
Dropped Frames  56
Frame Rate  56
Digital Video Recorder AVI Format Files  56
File Naming  57
Synchronizing Files from Two Video Cameras  61
Synchronizing Video Files with Neural Data Files  61
Recording Synchronized Video and Neural Data  62
Managing Video Files  64
Transferring Recorded Files  65

Global Configuration Pane  69
Processing Camera Video  69
Processing File Video  70

Source Pane  71
Frame Rate  71
Compression  71

CinePlex Studio Tracking Pane (if available)  72
Tracking Window  72
Arena Definition in the Areas Tab  72
Selecting Tracking Modes for the Experiment  74
Object Contour Mode Tracking  75
LED Mode Tracking  82
Reflective Colors Mode Tracking  85

Operating CinePlex Studio with RASPUTIN Sort Client  91
Using VTViewer  93
Recording Remotely from MAP Sort Client  100

CinePlex Studio Offline Mode  101
Entering Offline Mode  101
Offline Settings  101
Offline Functionality  102

Importing and Analyzing Position Data with NeuroExplorer  104
CinePlex Studio Test Mode  105
Operation with the Quad MAP Controller  107
Using the Extractor  115

Chapter 3 
CinePlex Studio Reference  119

Overview  120
Main Window  120

Static Configuration Pane  121
Dynamic Configuration Pane  137
Video Pane(s)  146
Messages Pane  147
Event Statistics Pane  148
Status Bar  149

Menus  151
File Menu  151
View Menu  152
DVR Menu  153
Tracker Menu  153
Window Menu  153
Help Menu  154
Shrink  154

Toolbars  155



Plexon Inc CinePlex vii

Version 3.0

File Toolbar  155
DVR Toolbar  155
Tracker Toolbar  155

Digital VideoTracker (DVT) Files  156
Object Contour Mode  156
LED Mode  156
Reflective Colors Mode  156
Conversion of DVT Coordinates to Pixels  157

Using Studio in File Mode  158
Default Mode  158
Manual Selection of File Mode  158
Source Settings  159
Dynamic and Static Data  159
Arenas, Zones, Sequences, Combination Events, and Re-recording  159

Chapter 4 
Using CinePlex Editor  161

Understanding CinePlex Editor Files  162
Creating a Project File  162
Importing Data Files  162
Changing and Saving Project Files  163
Reopening Project Files  163
Exporting Files  163

Getting Started  164
Using the Quick Start Files  164
Setting Up a New Project  165
Understanding the CinePlex Editor Main View  167
Defining a New Marker  169
Creating Marker Occurrences  170
Saving and Exporting the Data  171
Re-opening a Project File  173

Using the Activity Window  174
Understanding Looping  174

Customizing the User Interface  175
Using Markers and Marker Occurrences  175

Defining Markers  175
Inserting Marker Occurrences  176
Editing Markers and Marker Occurrences  181
Automatically Generating Marker Occurrences  183
Using the Levels Editor  185
Using the Zones Editor  188
Operating with Marker Occurrences  190
Selecting and Editing Marker Occurrences  196
Entering or Editing Coordinate Markers  197

CinePlex Editor How-Tos  201
Printing  201
Denoting Interesting Behavior In the Video  201
Invalidating Artifact Waveforms  202
Freeze Detection  204
Entering Tracker Coordinates  205
Repairing Tracking Coordinates  206
Simple Place Cell Analysis  207

Chapter 5 



Plexon Inc CinePlex viii

Version 3.0

CinePlex Editor Reference  209
Overview  210
Main Window  211

Video Window  211
Activity Window  216
Markers Window  220
Input Window  223
Channels Window  224
File Info Window  225
Audio Output Window  227
Messages Window  228
Marker Occurrences Window  229
Scalar Window  232

Menus  235
File Menu  235
Edit Menu  245
View Menu  249
Animate Menu  250
Looping Menu  251
Find Menu  253
Tools Menu  254
Window Menu  272
Run Menu  272
Help Menu  272

Toolbars  273
Standard Toolbar  273
Edit Toolbar  273
Views Toolbar  273
Animate Toolbar  273
Looping Toolbar  274
Find Toolbar  274
Tools Toolbar  274

How CinePlex Editor Creates Initial Project Files  275
Reading Video (AVI) Files  275
Reading Plexon (PLX) Files  275
Reading NeuroExplorer (NEX) Files  276
Reading Digital VideoTracker (DVT) Files  276
Non-Typical Initial File Creation  276

Understanding Markers and Marker Occurrences  278
Marker Occurrences and the Marker Occurrences Window  279

Correcting for Video Latency  282
Aligning Tracker Coordinates to Frames  284
Interpreting Frame and Event Timestamps  286
Analyzing CinePlex Studio data with NeuroExplorer  287

Appendix A 
Installation  A-1

Installation - Hardware  A-2
Installation - Software  A-5
Licensing  A-32
Plexon Technical Support  A-34

Technical Support  A-34
Demo Mode  A-34



Plexon Inc CinePlex ix

Version 3.0

Appendix B 
Problem Resolution  B-1

Physical Installation Issues  B-2
Other Issues  B-4

Other Typical Problems and Solutions  B-9
CinePlex Studio Messages  B-11

Appendix C 
Lens Selection, Experiment Design, and Camera Installation  C-1

Introduction  C-2
Lens Selection  C-3
Experiment Design  C-5

Field of View  C-5
Colors  C-7
Visibility  C-7

Camera Installation  C-8
The Plexon Camera Mounting Kit and Accessories  C-8
Bracket Mounting Choices to Make  C-11
Installing the Camera  C-14
Examples Using Optional Accessories  C-18
Camera Removal  C-19

CinePlex Screen Capture  C-20

Appendix D 
Plexon User Interface  D-1

Plexon User Interface  D-2
Screen Elements  D-3

Menus  D-3
Toolbars  D-5
Windows  D-6

Standard Menu Items and Dialogs  D-11
Window Menu  D-11
Run Menu  D-13
Help Menu  D-13
Messages Window  D-17
Right-click Menus  D-18
Current Selections  D-18
. Undo  D-18

Customization  D-19
Toolbars Customization  D-19
Commands Customization  D-20
Keyboard Customization  D-20
Run Menu Customization  D-22
Options Customization  D-23

Appendix E 
Cabling Guide  E-1

Overview  E-2
Typical MAP/CPX Cabling Diagram  E-3
Typical MAP/CPX System Cabling  E-5

MAP/CPX System with One Video Camera, No CHUB  E-6
MAP/CPX System with Two Video Cameras, No CHUB  E-7



Plexon Inc CinePlex x

Version 3.0

MAP/CPX System with One Video Camera, CHUB  E-8
MAP/CPX Cable Images  E-9
Close-up Images of MAP/CPX Cables Installed  E-10

Connections to MAP Box  E-10
Connections to Video Camera  E-12
Connections to Computer  E-12



Plexon Inc

CinePlex 1

Chapter 1 
CinePlex System Overview

1.1 About the CinePlex System ............................................................2

1.2 Using the CinePlex System with a Plexon NDAQ .........................8

1.3 CinePlex System Hardware and Software Components.................9

1.4 Data Analysis ................................................................................13



1  

2  CinePlex

1.1 About the CinePlex System

The term CinePlex System is used in this manual to refer to the Plexon CinePlex 
Video Capture, Tracking, Behavioral, and Editing System. The CinePlex System 
is a digital video recording, tracking, behavioral, and editing tool. With the Cine-
Plex System, the user may record (capture) video in Windows-standard audio-
video interleaved (AVI) format. The user may also synchronize the video capture 
with simultaneously recorded neural data files. With the CinePlex System, the 
user may play the synchronized video and neural data recordings and add behav-
ioral event markers and time-interval variables. The user may then export the 
marked-up data from the CinePlex System for further analyses with other pro-
grams. 

The CinePlex System consists of two elements: CinePlex Studio and CinePlex 
Editor. CinePlex Studio consists of hardware and software to enable the user to 
simultaneously capture, track, analyze, and record video data synchronized with 
neural data from a Plexon Neural Data Acquisition System (hereafter Plexon 
NDAQ). CinePlex Studio also allows re-tracking and re-analysis of previously 
recorded video files. CinePlex Editor is a software tool that enables the user to 
view and edit the resulting video and neural data files together.

1.1.1 CinePlex Studio Features

CinePlex Studio includes the following features:

• General

— CinePlex Studio is a normal Windows application

— CinePlex Studio runs on a Plexon NDAQ computer with or without a 
network

— CinePlex Studio can run on a regular computer in offline mode (i.e. 
analyzing files produced by the PC to which cameras are connected)

• Video

— A video capture capability, which can be synchronized with neural 
recordings from a Plexon NDAQ

— Names video files to correspond to names given to synchronized neural 
data files

— Produces standard video AVI files in MPEG format

— Allows user-specified prefixes for filenames when recording non-syn-
chronized files

— Essentially unlimited AVI file size (Microsoft extension to NTFS for-
mat eliminates the 4 GB file size limit)

— Selectable image quality settings by changing nominal bit rate

— Recording directly to internal hard drive



Version 3.0 3

— All-digital imaging with one or two StingrayTM camera (640 x 480 reso-
lution, up to 80 frames per second)

— Near IR (infrared) tracking (optionally available)

• Online and Offline Tracking and Analysis

— Features Smart Tracking that uses robust algorithms for LED track-
ing, object contour tracking, and reflective color tracking

— Uses strobed word format to deliver tracking coordinates directly to the 
MMF

— Records position and time data in text files

— Analyzes contour motion across adjacent video frames to detect freez-
ing behavior in fear-conditioning experiments

• Behavioral Analysis and Digital Events

— Monitors animal speeds to create digital events when over/under 
threshold

— Monitors vectors between objects to create digital events when within/
outside of an angle and tolerance

— Allows user to define static and dynamic zones of interest and zone 
sequences

— Monitors objects traversing zones and sequences to generate logical 
and digital events

— Allows user to define combinations of events from one or two cameras 
to generate digital events

• Offline extraction of selected static and dynamic data from CinePlex video 
files

— Reads any MPEG file created by CinePlex Version 3 or later

— Allows selection of a time range or all of the file to be extracted

— Allows selection of tab or comma delimited output files with or without 
header row

— Allows selection of desired static data columns

— Allows selection of dynamic data columns

— Writes text file with selections implemented

1.1.2 CinePlex Editor Features

CinePlex Editor includes the following features:

• Viewing
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— Integrated viewing of neural data files (Plexon PLX, NEX) and AVI 
files

— Display of tracking position data overlaid on video

— Seek and search based on event markers

— Full digital video playback capabilities

• Editing

— Video-aided insertion of event markers and intervals

— Removal of temporal segments of neural data during artifact-generat-
ing behaviors (chewing, grooming, etc.)

— Ability to enter and edit position coordinate data created by CinePlex 
Studio

— Ability to play a sound (standard or user-selected) when event markers 
or neural spikes occur during playback

— Supports Microsoft’s extension to NTFS file format to be able to utilize 
AVI files larger than 4GB

— Save neural data to Plexon (PLX) and NeuroExplorer (NEX) files, or 
export to Excel, MATLAB, or text files

1.1.3 CinePlex System Installation

For system requirements and installation instructions, see ”Appendix A - Installa-
tion”.

1.1.4 About CinePlex Studio

CinePlex Studio is the data acquisition portion of the CinePlex System. It can 
also be used to process existing data in File Mode. As shown in Figure 1-1, 
"CinePlex General Arrangement for a Plexon NDAQ", CinePlex Studio consists 
of 

• at least one Firewire camera and lens

• a MAP computer, which runs the CinePlex Studio software and associated 
MAP software

• a monitor that displays the CinePlex Studio user interface 

• a keyboard to allow user input such as file names

• a mouse, to control the CinePlex Studio software

• associated cables

CinePlex Studio provides three main capabilities:

1 Digital Video Recording (DVR): CinePlex Studio provides the ability to 
capture video to an AVI file for later viewing and analysis. Frames are time-
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stamped with corresponding MAP times. For more information on this capa-
bility, see “Digital Video Recording” on page 55. 

2 Position Tracking: If the Tracking option is licensed, CinePlex Studio pro-
vides the ability to track the position of subject(s) in the video images, in real 
time, and deliver the tracked position coordinates to a Plexon NDAQ. Track-
ing can also be used with existing pre-recorded files. When the Tracking 
option is enabled, there are three different modes of operation: 

a Object Contour Mode: In this mode, CinePlex Studio uses a setup 
procedure to color contrast and threshold the image until the subject 
being tracked is all white and the background is all black. For each 
frame, CinePlex Studio computes the centroid of the white pixels to 
obtain the tracking coordinates. This mode of tracking operation is 
described in “Object Contour Mode Tracking” on page 75. 

b LED Tracking Mode: In this mode, CinePlex Studio tracks up to five 
light emitting diodes (LED) on the subject or subjects being tracked. To 
improve tracking, LED Tracking Mode applies filters that remove the 
halo surrounding bright LEDs. This mode of tracking operation is 
described in “LED Mode Tracking” on page 82. 

c Reflective Colors Tracking Mode: In this mode, CinePlex Studio 
tracks up to three colors (tape or paint, for example) on the subject or 
subjects being tracked. This mode of operation is described in “Reflec-
tive Colors Mode Tracking” on page 85. 

Guidelines for choosing which tracking mode to use for a particular experiment 
are discussed in “CinePlex Studio Tracking Pane (if available)” on page 72.

Note: The user may configure CinePlex Studio to capture video only, or to track posi-
tions only, or to both capture video and track positions simultaneously.

For either function, the user must mount the CinePlex Studio video camera(s) a 
short distance away from an appropriately designed experimental arena. Adjust 
the camera(s) to have the appropriate field of view (see Lens Selection on 
page C-3) so that the entire experimental arena is visible on the video images.

Arena functions are enabled when Tracking is available. Using the tools pro-
vided, an outline of the experimental arena can be drawn over the video image(s). 
Once drawn, Studio ignores objects outside of the arena when processing the 
images. This results in lower CPU usage and reduces false object detections due 
to reflections and shadows. It also allows the experimenter to exclude areas of the 
image that have no relevance to the experiment. Arena tools allow drawing cir-
cles, ellipses, rectangles, and freehand objects. Arena logical operations (AND, 
OR, NOT, XOR) allow combining multiple arena shapes to produce a single 
complex arena shape.

3 Behavior Monitoring: If the Behavior option is available, tracked objects 
representing experimental subjects can cause logical and digital events by tra-



1  

6  CinePlex

versing zones within the arena, sequences of zones, matching angle targets for 
head vectors, and meeting speed targets. In addition users with two cameras 
can define combinations of events that, in turn, can cause other digital events.

a Zones: A zone is a defined portion of the arena that has significance in 
an experiment. Zones that do not move with respect to the image or the 
arena are referred to as static zones. For example, a static zone could be 
an area the animal should avoid to receive a reward or it could be an 
area the animal must traverse to receive the reward. It could even be 
one of the zones in a sequence of zones the animal should traverse. 
CinePlex Studio provides tools to allow the user to draw zone outlines 
on top of the video image. These tools operate in the same way as the 
arena tools, allowing complex shapes and logical operations. CinePlex 
Studio also allows the definition of dynamic zones that are circular 
areas around the center of gravity of a tracked animal or color. 
Dynamic zones are treated the same logically as static zones. Many 
zones can be defined simultaneously.

b Sequences: An ordered list of zones in an arena (called a sequence) can 
be defined. Many different sequences can be defined.

c Events: Logical events can be defined so that, when an animal enters or 
leaves a zone, or completes a sequence, the event becomes true. Many 
events can be specified. Their current states are dynamically displayed 
in the Event Statistics pane.

d Combination Events: A combination event is an event that becomes 
true when two or more other events are true. The events used in a com-
bination event can be generated from one or both cameras. This allows 
events to be generated by simultaneous occurrences in two different 
images, if desired.

e Digital Outputs: The experimenter can specify that a digital output be 
generated when any event occurs. Up to 24 different digital outputs can 
be specified, any of which can be pulsed, high or low when active.

CinePlex Studio can be started from an icon or the Programs Menu. For a full 
description of the user interface elements, “Main Window” on page 120.

1.1.5 About CinePlex Editor

CinePlex Editor is a software tool that enables the user to view and edit video 
and neural data files. With CinePlex Editor, the user may view time-correlated 
video, neural, and positional data. The user may also use CinePlex Editor to add 
and edit annotations and perform other operations on the data, such as artifact 
removal. CinePlex Editor records user actions to its own separate CinePlex 
project file, so the user may continue annotation and editing work over several 
sessions. When the the markup process is completed, the user may save the 
results and export the data for further analysis. For a complete list of CinePlex 
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Editor features, see “Offline extraction of selected static and dynamic data from 
CinePlex video files” on page 3.

CAUTION
Upgrade Notice
If the system has been upgraded to CinePlex 3.0, CinePlex Editor 
should also be updated. The upgraded CinePlex Editor is backwards 
compatible and will also read AVI files created by CinePlex Cap-
ture 1.0, 1.1, 1.2, 1.4, and 2.0.
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1.2 Using the CinePlex System with a Plexon NDAQ

The following illustration shows the general arrangement of the CinePlex System 
as used in conjunction with a Plexon NDAQ. 

Figure 1-1

CinePlex General Arrangement for a Plexon NDAQ

The CinePlex Studio computer receives and processes the raw video from the 
FireWire camera. The user may view the raw video on the Control Monitor or the 
optional CinePlex Studio monitor. CinePlex Studio compresses and stores the 
captured video on the internal hard drive, as an AVI file. Through the Timing 
cable, the MAP system signals the CinePlex Studio computer to start, stop, pause, 
and resume recording video to the AVI file. The MAP system also provides a 1 
MHz clock signal that enables CinePlex Studio to time stamp each video frame.

Note: Starting with CinePlex version 2.0, the host and CinePlex Studio functions can 
be combined in a single computer. This also results in a single monitor for the 
host and CinePlex Studio.
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1.3 CinePlex System Hardware and Software Components

In addition, if the CinePlex System includes the Tracking option (see “CinePlex 
Studio Tracking Pane (if available)” on page 72), CinePlex Studio simultaneously 
analyzes each frame of video data to determine the positions of the objects being 
tracked. The computer encodes this position information into digital words and 
sends the information back to the Plexon NDAQ into the neural data buffer, 
appropriately time-stamped.

After a recording session, the user may transfer the AVI files and the Digital 
VideoTracker (DVT) files to a different computer where the neural data files are 
stored. For more information on DVT files, see “Digital VideoTracker (DVT) 
Files” on page 156. With all files accessible from the same computer, the user 
may then use CinePlex Editor on that computer for simultaneously viewing, 
annotating, and processing the video, neural data, and position data. CinePlex 
Studio can be run on the same computer in File mode, as well.

1.3.1 CinePlex Hardware Components

The following illustration shows the major hardware components for a single 
MAP/CPX system.

The CinePlex System computer allows up to two cameras to be connected via a 
FireWire card. Control for the CinePlex System is received at the CPX DIO 
board from the MAP system TIM board. Additional control between the MAP 
and CPX computer is via a serial connection. Neural data is transmitted between 
the MAP and CPX via the DIO link in the CPX computer and the HLK2 in the 
MAP. The CPX computer supports up to two monitors. The CPX computer also 
allows digital outputs via an optional DO board and field potential inputs via an 
optional A/D card.
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1.3.2 CinePlex Software Components

The following illustration shows the major software components for a single 
MAP/CPX system.

The MAP provides control for CPX Studio. CPX Studio controls the camera(s) 
and receives video from the camera(s). CPX writes AVI file to file storage and 
also sends coordinate data to the circular buffer which, in turn, sends the data to 
Sort Client. The circular buffer also receives neural data from Server. Sort Client 
writes PLX files to file storage. CPX Editor reads/writes PLX and AVI files from/
to file storage. NeuroExplorer reads/writes PLX files from/to file storage. 

1.3.3 Multi-MAP Architecture

The following illustration shows the multi-MAP architecture.
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The Quad MAP Controller (QMC) can control up to four MAP/CPX systems 
from a single start button as shown in the previous illustration. One MAP/CPX 
system acts as a master system, and the others are slaves.
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1.3.4 System Data Flow

The following illustration shows a logical view of the data flow in a complete 
video and neural data acquisition system using a Plexon NDAQ and other Plexon 
products:

Figure 1-2

CinePlex Data Schematic for a Plexon NDAQ

In the preceding illustration, CPX Studio writes AVI files directly to file storage. 
These AVI files have static headers, time-stamped video frames, and dynamic 
coordinate and event data. CPX Studio also writes DVT files containing dynamic 
coordinate data. CPX Studio also sends selected event data and coordinated data 
to the circular buffer which, in turn, sends the data to Sort Client which writes 
AVI files containing neural and CPX data to file storage. The CinePlex System 
also includes a utility program called VTViewer (see “Using VTViewer” on 
page 93), which works only with the MAP system to read position data. The user 
may use VTViewer to display, in real time, the position tracking data generated 
by CinePlex Studio.
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1.4 Data Analysis

After recording, the user may process the PLX file with other software, available 
from Plexon; for example, the user may spike sort the data with Offline Sorter 
(OFS), or analyze it with NeuroExplorer (NEX). The user may save the results of 
this processing to another PLX file or to a NEX file. For more information on 
OFS and NEX, go to www.plexon.com.

If the user transfers the recorded AVI file from the internal CinePlex Studio hard 
drive to an offline analysis computer, the file can be opened in CinePlex Editor 
along with either the original PLX file or the files from OFS or NEX. CinePlex 
Editor presents the time-correlated video, neural, and positional data, and enables 
the user to add and edit annotations and perform other operations on the data, 
such as artifact removal. CinePlex Editor records the actions the user performs on 
the data to a CinePlex project file (CPJ), so that the user may do the annotation 
and editing work over several sessions. When the user completes the markup pro-
cess, the results can be saved back into PLX or NEX files, or exported into text 
files, MATLAB files, or Excel spreadsheets for further analysis.

1.5 Effects on Monitor Functionality

When Studio is running, the screen saver and power saver functions for the mon-
itor are diabled. This is because DirectX rendering is damaged and causes video 
to go black. This is a result of using DirectX and cannot be coded around. Screen 
saver and power saver settings are restored if Studio exits normally.

http://www.plexon.com
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2.1 Getting Started

This section provides an overall procedure for using CinePlex Studio. Each step 
in the procedure is covered in detail in the subsequent sections.

When embarking on a project, the user should have a detailed plan in place. The 
more detailed the plan, the more successful its execution will be. When using 
CinePlex Studio in an experiment, perform the following steps:

• Designing the experiment - this step is concerned with animal selection, 
stimuli and rewards, physical design, environmental conditions, execution 
plan, and/or anything else pertinent to the overall design of the desired exper-
iment. Detailed discussion of this step is beyond the scope of this manual.

• Setting up the equipment - this step is concerned with setting up all of 
the equipment to be used in the experiment (CinePlex Studio workstation, 
Plexon NDAQ, computers, monitors, and any other peripheral equipment and 
their interconnection).

• Performing an operational test - this step is concerned with checking 
out each piece of equipment, all connections, and all cables for proper opera-
tion.

• Setting up CinePlex Studio - this step is concerned with positioning the 
camera so that the desired physical experiment area is within the field of view 
of the camera, deciding on the tracking mode to be used, and arranging the 
windows, setting the necessary properties of the selected tracking mode, 
determining file locations, synchronizing with other equipment, and any other 
considerations that may be pertinent.

• Executing the experiment plan - this step is concerned with implement-
ing the execution plan created in the Designing the experiment step. 
Detailed discussion of implementing the execution plan is beyond the scope 
of this manual.
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2.2 Designing the Experiment

The prime consideration from the CinePlex Studio point of view is whether 
CinePlex Studio will work properly with the experimental design. Some possible 
examples where CinePlex Studio may not work include:

• The design of the experiment requires tracking of the entire body of a dark-
colored animal in the dark. Contact Plexon for near infrared tracking options.

• The ratio of the size of the trackable arena to the size of the animal is such 
that the animal’s image is too small or too large to be tracked.

If assistance is needed in determining whether CinePlex Studio is applicable to 
the experimental design, please contact Plexon at 214-369-4957.
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2.3 Setting up the Equipment

The following sections cover the different configurations of the CinePlex System 
with various equipment.

2.3.1 Setting up the CinePlex System with a Plexon NDAQ

The illustrations below shows how CinePlex Studio may be connected to a 
Plexon NDAQ.

If using the post 2.0 CinePlex Studio computer, see Installation - Hardware on 
page A-2.
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2.4 Performing an Operational Test

Before beginning the experiment, it is best to check out the equipment for proper 
operation. The sections below give pointers on what to check for different equip-
ment configurations.

2.4.1 CinePlex Studio and a Plexon NDAQ

Set up the CinePlex Studio System as shown by the illustration below.

In this configuration the primary points to check are the camera, both monitors, 
all of the connections, and all of the cables.

The primary points to check in this configuration are the camera, the monitor, all 
of the connections, and all of the cables.

2.4.2  Start-Up Sequence (MAP)

The starting sequence for a MAP/CinePlex combination system is important for 
correct operation of CinePlex. If not followed, video may not be visible or Cine-
Plex control by the MAP may not be possible.
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1 Power up the computer and log in.

2 Turn on power to the MAP box.

3 Start Server program and verify no errors. The easiest way is to double-click 
the Server desktop icon.

If there are no problems, the Server main window appears.

Startup
The startup sequence is extremely important. RASPUTIN must be 
started before Studio is started so that the client registration process 
works properly. Otherwise, when a recording is eventually started by 
RASPUTIN neither the file name string nor the recording time 0 mes-
sages are received.

If RASPUTIN exits or is closed for any reason, it should be brought 
back up, then Studio should be closed and restarted, as well.



Version 3.0 21

4 Start Sort Client program and verify no errors. The easiest way is to double-
click the Sort Client desktop icon.

The Sort Client window displays.
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5 Read a stored parameters file into Sort Client, if desired. Just click the Open 
Sorting Parameters File... item in the File menu.

6 Press Start button on Sort Client.
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7 Start CinePlex Studio program. The easiest way is to double-click the 
CinePlex Studio desktop icon.

The CinePlex Studio main window displays.

8 Select Camera 1 mode (from the dropdown shown below), if not already 
selected. Video should now be displayed on the Video 1 window.

9 If proper video is observed at the monitor, it is reasonable to assume the 
camera, computer, and monitor are working correctly.

If there is no video, check the cabling, connections, AC power, on/off 
switches, lighting, and the iris, zoom, and focus of the camera. The cables 
may not be connected properly, one or more cables may be broken internally, 
a pin or pins on a cable could be bent or broken, the iris on the camera could 
be shut, the zoom on the camera could be set improperly, or the focus could 
be set so that everything is a blur.

2.4.3 Start-Up Sequence (OmniPlex)

(Reserved for future expansion)



2  

24  CinePlex

2.5 Setting up CinePlex Studio

2.5.1 Arranging CinePlex Studio Windows

The default window layout will be sufficient for most instances. However, to 
change the window layout, see Appendix D  Plexon User Interface1. To load or 
save a layout configuration, see Window Menu on page D-11.

2.5.2 Selecting File Locations

Decide on the locations to store the recording files. 

1 To set their locations, select Change Data Folders from the File menu. The 
Choose Folders dialog box appears.

2 Click the Browse button at the right of the Recording Folder text box to 
change the Recording Folder. The Browse for Folders dialog box appears.

3 Navigate to the desired folder and click Open. A new folder may be created 
by using the “Make New Folder” button.

4 When finished choosing a storage folder, click OK.

2.5.3 Positioning Camera 1

1 In general, it is better to position the camera as far from the experiment as 
possible, then zoom as much as possible in order to fill the field of view with 
the area of interest without distortion. To compute the distance from the 
camera to the arena so that the whole arena is visible, see Appendix C for 
more details.

2 When tracking is desired, ensure that the ratio of the object size to the arena 
size is such that the system will be able to track the object. If the ratio is too 
small (the image size of the object would be less than a few pixels) the system 
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will not be able to distinguish the object from noise. If the ratio is too large 
(more that 1/4 of the video image) the system will not track the object.

3 If there are two cameras, Camera 1 will be the one with the lowest Serial 
Number. If there is only one camera, it is Camera 1. Calibration only works 
accurately when Camera 1 is orthogonal to the arena.

4 Obtain an initial video image using the default CinePlex Studio settings and 
changing only the lens parameters (iris, focus, zoom).

5 If the previous step does not result in a good image, manually change 
Camera Settings in CinePlex Studio. Adjust the settings in this order: 
Contrast, Brightness, Sharpness, and Saturation.

6 When tracking, create an Arena that includes all areas of interest in the video.

2.5.4 Tracking Mode Considerations (if tracking option is available)

2.5.4.1 Tracking Mode Choices

The table below shows which tracking mode to use under various circumstances.

2.5.4.2 LED and Reflective Colors Tracking

If using LED or Reflective Colors tracking, consider the lighting conditions. The 
illustrations below show examples of the video window with LED or Reflective 
Colors tracking modes under different lighting conditions.

Table 1: 

Using
LEDs are the Brightest 

Spots in Arena
Tracking Mode to Use

LEDs Yes LED or Reflective Colors

LEDs No Reflective Colors

Colored Markers NA Reflective Colors

No LEDs, no Colored 
Markers

NA Object Contour
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2.5.4.2.1 LEDs in Darkness with LED Tracking Mode. 

In darkness the LEDs are the brightest spots in the window, and the LED Track-
ing mode is excellent for this condition.

2.5.4.2.2 LEDs in Darkness with Reflective Colors Tracking Mode. 

In darkness the user may also use Reflective Colors tracking mode with the LEDs 
being the reflective colors.
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2.5.4.2.3 LEDs in Light with Reflective Colors Tracking Mode. 

In lighted conditions the user may use Reflective Colors Tracking mode with the 
LEDs being the reflective colors.

2.5.4.2.4 Reflective Colors Tracking Mode in Light. 

In lighted conditions without LEDs the user may use the Reflective Colors Track-
ing mode with the reflective colors shown in the illustration.
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2.5.4.3 Object Contour Tracking

When using Object Contour tracking, consider the background color and any 
background objects. The illustrations below show different background and color 
conditions in conjunction with Object Contour tracking. For example, suppose 
the user wishes to track a dark animal as shown in the illustration below.

2.5.4.3.1 Animal with No Background. 

This illustration shows the animal to be tracked without any background object in 
the window. The background color is uniform and provides a good contrast to the 
animal’s color.

2.5.4.3.2 System Tracking Background Object. 

This illustration shows an animal to be tracked along with a background object of 
approximately the same color. The background object is larger than the animal 
and the system is tracking the background object (the red cross hair is centered on 
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the object and the yellow rectangle is surrounding the object). To avoid this situa-
tion, define an arena in which to track or use background subtraction.

2.5.4.3.3 Arena Defined. 

This illustration shows a defined arena (in green) that the system will use to track 
the animal. The arena excludes the background object so that the system will 
never lock onto the object by mistake.

2.5.4.3.4 Background Object. 

This illustration shows the background object with nothing else in the window. 
The user may capture the image of this window to use for background subtrac-
tion. Background subtraction allows the system to disregard the background 
object or objects.



2  

30  CinePlex

2.5.4.3.5 Background Subtraction. 

This illustration shows the background object and the animal together using 
background subtraction. Note that the system is tracking the animal.

2.5.4.3.6 Low Color Contrast. 

Background subtraction will allow the user to do body tracking even at a low 
color contrast between the animal and background.
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2.5.4.3.7 Multicolored Animal. 

The user will be able to track multicolored animals using Plexon’s special algo-
rithm of background subtraction. In this case be sure that all colors contrast with 
the background color. The user may use different background colors to try to 
improve the quality. For example, a brick red background works well for Long-
Evans rats.

2.5.5 Tracking Mode Settings (if the tracking mode is available)

Adding Arenas

1 Click the Add arena button.
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2 An Arena Settings pane is added.

3 Zones may be added to the arena, if desired. See “Adding Zones” on 
page 47.

4 Shapes may be added to the arena, if desired. To draw a shape, click the 
desired shape on the toolbar (Circle, Ellipse, Rectangle, or Polygon) and then 
click the left mouse button in the video window and drag the shape to its 
desired size.

5 To delete a shape, select the desired shape in the Arena pane (or in the 
Video pane) and press the Delete key on the computer keyboard. In the 
images below note that the ellipse is selected for deletion.
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Selecting the Tracking Mode

1 Select the desired tracking mode by clicking the appropriate icon on the 
Tracker toolbar.

2 The Tracking pane for the selected tracking mode displays in the Static 
Configuration pane.

3 Perform adjustments as described in section below that corresponds to the 
the selected tracking mode.

2.5.5.1 LED Tracking
1 In the Visualization group check Show Contour and Fill Contour so that the 

objects found by the system are visible.

2 Check the Pure Colors checkbox in the LED Tracker area.
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3 Check each color to track in the LED properties area.

4 Change the Threshold (common to all LEDs) so that the correct objects are 
filled and outlined on the Video window. Their color crosses (representing the 
centers of gravity) should be centered on the correct objects.

5 If pure colors do not give good results, use the pick-up tool to select the color 
from the video (see “Using the Color Pick-up Tool” on page 84). Adjust the 
Threshold as needed.

2.5.5.2  Reflective Colors Tracking
1 In the Visualization group check Show Contour and Fill Contour so that the 

objects found by the system are visible.

2 Check the Pure Colors checkbox in the Reflective Colors Tracker area.
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3 Check the color to track (by clicking the corresponding checkbox).

4 Click on the ‘+’ of any markers whose settings need to be changed.
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5 Adjust the Threshold of the selected color (see diagram above) so that the 
correct object is filled and outlined on the Video window and its color cross is 
properly centered.

Note: If working with pure RGB colors, the Threshold should be moved to 
lower values to provide stable tracking.

6 If pure colors do not give good results, select the color from the video (using 
the pick-up tool - see “Using the Color Pick-up Tool” on page 84). Adjust the 
Threshold higher to find and track the object.

7 Repeat steps 2-4 for each color selected.

2.5.5.3 Object Contour Tracking
1 In the Visualization group check Show Contour and Fill Contour so that the 

objects found by the system are visible.

2 If the animal has a good contrast relative arena image, and the background is 
uniform, i.e., there are no other objects with similar contrast - work without 
subtraction of the background image. Adjust the threshold to fill the whole 
animal.

3 With a non-uniform background, use background subtraction to track better.

4 Remove animal from the tracking area.

5 Capture background image by clicking the Camera icon. The Use 
Background control will activate so that it may be clicked.

6 Check the Use Background checkbox (see diagram above).

7 Replace the animal in the tracking area.

8 Adjust the Threshold (see diagram above) to fill the whole animal.

Use Detail Filter to remove non-required features of the detected objects (tail, 
etc.) or to remove parasite objects in the whole image. Note that object features, 
such as the tail, slightly shifts the center of gravity of the body, and filtering helps 
to correct it.

Pressing the eye icon brings up a window containing the latest background 
image.

For systems with a second camera, repeat Steps 2.5.3, 2.5.4, 2.5.5, and 2.5.6.

2.5.5.4 Calibration

Once the tracking method has been selected and other parameters adjusted as 
desired, the experimenter may desire to calibrate the Camera 1 video image so 
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that sizes, positions and velocities are reported in the desired units of measure 
instead of pixels.

Note: Calibration applies only to Source 1. Dimensions of arenas, zones, and track 
lengths are in pixels for Source 2. Speed events are not allowed for Source 2 
because it is never calibrated.

CinePlex Studio provides two methods of calibration - single axis and dual axis. 
Use single bar unless Camera 1 is not orthogonal to the experimental surface - 
then use the dual bar method.

Calibration is the final section of the Source 1 pane. 

Calibrating CinePlex Studio

1 Open up the Calibration (if it is not already open) section by clicking on the 
“+” sign.

2 Check the box labeled Use Calibration. Note that the title of the section 
changes from Calibration to Calibrated. This is because the current 
calibration Global Factor is being applied.

3 Select the unit of measure - either cm for centimeters or in. for inches.

4 Select the method of calibration - either One-Bar or Two-Bar.
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5 When one-bar has been selected:

a Click the “+” sign next to Global Factor and then the “+” next to Refer-
ence Size to expand their subsections, if needed. If they are already 
shown as “-” signs, this is not needed.

b If the current color in the box next to the Color item will not provide good 
contrast with the video image, click in the box and select a suitable color. 
The color selected is the color of the measurement bar used for calibra-
tion.

c Choose a feature in the experimental area whose video image extends 
over much of the field of view. As an illustration, the inside diameter of the 
clock frame in the image below will be used as the desired dimension.
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d Measure its longest dimension in the units desired, and record it for refer-
ence. The inside diameter of the clock frame measured 30.5 cm.

e Click the Adjust button. The cursor will go to the video image and a line 
will appear in the color selected. Select one end of the colored line and 
move it to one end of the feature just measured. Select the other end of 
the line and move it to the other end of the feature. Right-click to record 
the length of the bar in pixels.
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In the image above note the green line through the middle of the clock with 
the box on each end. This is the sizing bar.

In the above image note that the left end of the sizing bar has been moved to 
the inside edge of the clock’s frame. Select the other end of the sizing bar and 
move it to the opposite inside edge of the clock frame and ensure the sizing 
bar crosses the intersection of the clock hands.
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In the above image note that the sizing bar now measures the inside diameter 
of the clock’s frame.

f Go to the slider next to the Actual item and move it so that it reads the 
dimension recorded above. Studio is now calibrated to the measured dis-
tance.

In the image above note that the Actual setting has been changed to the mea-
sured inner diameter of the clock’s frame (30.5 cm).

g Click all three “-” signs once the adjustment is satisfactory to hide the 
adjustments.

6 When two-bar has been selected:

a Click the “+” sign next to Horizontal Factor and then the “+” next to Ref-
erence Size to expand their subsections, if needed. If they are already 
shown as “-” signs, this is not needed.
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b If the current color in the box next to the Color item will not provide good 
contrast with the video image, click in the box and select a suitable color.

c Choose a horizontal feature (horizontal relative to the video image) in the 
experimental area whose video image extends over much of the field of 
view. Once again the inner diameter of the clock’s frame will be used.
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d Measure the feature’s horizontal dimension in the units desired, and 
record it for reference. The inner diameter is 30.5 cm.

e Click the Adjust button in the Horizontal section. The cursor will go to the 
video image and a line will appear in the color selected.

In the image above note the green line through the middle of the clock with 
the box on each end. This is the sizing bar.

f Move the sizing bar vertically so that it rests on the intersection of the 
clock hands. Select one end of the sizing bar and move it to the inside 
edge of the clock frame. Select the other end of the sizing bar and move it 
to the inside edge of the clock frame. Right-click to record the length of 
the bar in pixels.
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In the above image note that the sizing bar now measures the inside diameter 
of the clock’s frame.

g Go to the slider next to the Horizontal Actual item and move it so that it 
reads the dimension recorded above.

h Click the “+” sign next to the Vertical Factor and then the “+” next to Ref-
erence Size to expand their subsections, if needed. If they are already 
shown as “-” signs, this is not needed.
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i If the current color in the box next to the Color item will not provide good 
contrast with the video image, click in the box and select a suitable color.

j Choose a vertical feature (vertical relative to the video image) in the 
experimental area whose video image extends over much of the field of 
view. Once again the inner diameter of the clock’s frame will be mea-
sured.
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k Measure the feature’s vertical dimension in the units desired, and record it 
for reference. The inner diameter of the clock’s frame is 30.5 cm.

l Click the Adjust button in the Vertical section. The cursor will go to the 
video image and a line will appear in the color selected.

In the image above note the vertical green line with a box at each end. This 
line is the sizing bar.

m Select the sizing bar and move it horizontally until the sizing bar rests on 
the intersection of the clock hands. Select one end of the sizing bar and 
move it so that one end of the sizing bar touches the inside edge of the 
clock frame. Select the other end of the sizing bar and move it to the 
opposite inside edge of the clock frame. Right-click to record the length of 
the bar in pixels.

In the image above the bottom of the sizing bar has been set within the clock 
frame.
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n Go to the slider next to the Vertical Actual item and move it so that it 
reads the dimension recorded above (30.5 cm).

Now Studio has been calibrated in both horizontal and vertical directions.

o Click all five “-” signs once the adjustments are satisfactory to hide the 
adjustments.

2.5.6 Behavior Mode Settings (If the Behavior Option is available)

The behavior option adds zones, sequences of zones, combination events, and 
digital outputs to CinePlex Studio.

Adding Zones

1 On the Areas tab click the Add static zone to current arena or Add 
dynamic zone to current arena icon. 

2 Select the drawing tool that makes the most sense for the zone that needs to 
be created. 
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3 Draw the zone outline over the image corresponding to the first physical zone 
of interest. For the image below a red circle was added.

4 Adjust size and shape so that the complete zone, and nothing else, is 
enclosed by the outline. For the image below, the circle was adjusted to fit 
around the clock by moving and adjusting the circle by the handles on the 
yellow square.

5 Select a different drawing tool if needed. 

Note: Remember that complex zones can be created by AND, XOR, NOT, 
and NOR operations on additional shapes as they are added to the 
zone. 

Note: Dynamic zones are created by clicking the Dynamic Zone icon and 
selecting the color around which to draw it. 
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6 Repeat these steps for each additional zone to be defined.

Defining Sequences of Zones

Note: Before defining sequences of zones, two or more zones must be 
defined. 

1 After two or more zones have been added, use the Sequences tab.

2 Click the Add new sequence icon to add a sequence. 

A new sequence is added to the pane.
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3 Click the Add zone to selected sequence icon to add a zone to the 
sequence.

A zone is added to the sequence.

4 Select available zones from the drop down list for the new sequence. 

The selected zone is displayed in the Zone 1 setting.

5 Repeat these steps for each additional sequence to be defined.
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Defining Logical Events

Logical events can be defined so that, when an animal enters or leaves a 
zone, or completes a sequence, the event becomes TRUE. 

1 Use the Events tab.

2 Select a zone or sequence of zones.
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3 Select a tracked object to traverse the zone or sequence.

4 Define the conditions.

The event will become TRUE when the conditions are satisfied. At that point, 
the event count will be incremented and times and track lengths will be 
extended.

Defining Combination Events

1 Use the Combination Events tab.
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1 Click the Add new combination of tracking events icon. 

2 Select the logical operation to use.

3 Select each event in the sequence from the drop down list of available events.
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Specifying Digital Outputs

Digital outputs are an option when creating a logical event.

1 Use the Events tab.

2 To specify that a digital output occurs when an event is TRUE, select the 
desired output line from the drop down list associated with the event.

 Up to 24 different digital outputs can be specified, any of which can be 
pulsed, high, or low when TRUE.
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2.6 Executing the Experiment Plan

The steps performed in this part of the process depend on the experiment plan. 
Since implementing the experiment plan depends on the contents of the plan and 
there are an unlimited number of experiment plans, detailed discussion of this 
section is beyond the scope of this manual.

2.6.1 Digital Video Recording

The Digital Video Recording (DVR) feature of CinePlex Studio stores the video 
recording from one or more cameras on an internal hard drive. In most experi-
ments, the user simultaneously collects a neural data file in an AVI file. With 
CinePlex Studio, the user may start, stop, and time stamp these AVI files in a way 
that enables the user to subsequently correlate them offline with the simulta-
neously-captured neural data. For information on starting, pausing, and stopping 
recording of files, see “DVR Menu” on page 153. For more information, see 
“Understanding CinePlex Editor Files” on page 162.

To enable offline analysis, bring the pairs of AVI and neural data files together on 
the same computer—the “analysis computer”—with CinePlex Studio and Editor. 
The user may use a variety of means to transfer the AVI files from the CinePlex 
Studio internal hard drive to the analysis computer, if needed. Likewise, if the 
neural data files are stored elsewhere, the user may transfer the neural data files to 
the analysis computer, perhaps by using a network connection or some other 
means. If the analysis computer is the Plexon Neural Data Acquisition/CinePlex 
computer, it typically stores the neural data files on a local disk.

Recording and transferring video files

1 Use CinePlex Studio to record one or more AVI or DVT files on the internal 
hard drive. If the Recording Folder has not been set, a notification message 
will display.

2 Transfer the AVI files or DVT files, or both, onto the analysis computer, if 
different. When finished copying the files to the analysis computer, rename 
the files, if desired. 

3 Use CinePlex Editor (or some other method) to match up the AVI file with its 
partner neural data file, or DVT file, or both, and analyze the data. 

Note: For a detailed version of this procedure, see “Recording Synchro-
nized Video and Neural Data” on page 62 or “Managing Video Files” 
on page 64.

CAUTION
Camera Damage
Never connect or disconnect the camera while the power is on. The 
camera can be permanently damaged.
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2.6.2 Dropped Frames

With CinePlex Version 3 dropped frames occur much less frequently than for ear-
lier versions. However, in the event that dropped frames ever cause problems, 
please contact Plexon Support.

2.6.3 Frame Rate

The instantaneous frame rate observed by Studio is displayed at the bottom of the 
Studio window. It should steadily display the user-selected frame rate while 
recording. If it does not, the computer is experiencing partial congestion. Partial 
congestion is normally caused by non-Plexon applications. Partial congestion 
does not result in dropped frames, but tracking and other processing may be 
slightly delayed.

2.6.4 Digital Video Recorder AVI Format Files

CinePlex Studio typically records video into motion-JPEG AVI files at a resolu-
tion of 640x480 pixels at up to 80 frames per second, which implies a raw data 
rate of over 300 GB/hour. However; to reduce disk usage, CinePlex Studio com-
presses the video before it writes it to the AVI file. Studio offers a choice of 
MJPEG and MPEG formats. With each format the user may vary the file com-
pression to find a suitable balance between AVI file size and image quality. 

2.6.4.1 Motion JPEG Recordings (MJPEG)

The quality settings for MJPEG range from 20 to 90. At an image quality setting 
of 65, an AVI file grows at a rate of approximately 2.1 GB/hour. This growth rate 
depends on the complexity of the video image, which affects the compressibility. 

2.6.4.2 MPEG Recordings

MPEG is the default recording format because it produces files that are routinely 
75 to 90% smaller than the equivalent MJPEG formatted files.

The quality settings for MPEG range from 1 to 10. The values represent the nom-
inal bit rate divided by 500,000.

While it records, CinePlex Studio continually calculates and displays the amount 
of recording time left until the target hard drive fills up. As the hard drive capac-
ity is neared, CinePlex Studio stops recording.

Note: Experiment to find the minimum quality setting that yields an acceptable image. 
For example, if the user increases the MJPEG quality setting from 65 to 90, the 
size of the AVI file doubles using the same recording time—but it does not dra-
matically increase the quality of the image. Conversely, if the user reduces the 
quality setting from 65 to 20, the size of the AVI file halves using the same 
recording time—however, the quality of the image degrades significantly. 

The AVI files created by CinePlex Studio are industry-standard AVI-format files 
that the user may play with many standard tools, including Microsoft Windows 
Media Player, which is pre-installed on most Windows computers. The user may 



Version 3.0 57

also use a variety of commercial software applications to edit and perform other 
operations on AVI files. 

Note: Windows Media Player and other video players render files slower than real 
time if the files were recorded at 40 frames per second or greater. This can be 
confusing because the slider moves faster than the video plays such that the 
slider reaches the end of its travel before the video finishes playing.

The AVI format allows the embedding of additional data segments within AVI 
files. Each embedded data segment has an identification tag. Typically, an AVI 
file reader that does not recognize a tag for an embedded data segment skips that 
data segment. CinePlex Studio always produces AVI files with a Plexon-specific 
additional tagged data segment that contains dynamic data for each video frame. 
CinePlex Editor can read this additional data segment in the AVI files generated 
by CinePlex Studio and thus recover the timestamp of each frame. Other AVI file 
readers like Windows Media Player ignore this data. This Plexon-specific nonde-
structive embedded data is not visible on the video frame. However, CinePlex 
Studio contains an optional feature that can overlay this time stamp in visible 
numerals on the video image itself; see “DVR Group” on page 125. 

2.6.5 File Naming

2.6.5.1 CinePlex Studio File Handling

This section discusses the sequence of events when starting CinePlex Studio 
remotely (i.e. clicking the Arm toolbar button on CinePlex Studio and then click-
ing the Start button on Sort Client). The events in the Message pane will illus-
trated the sequence of events.
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Sequence of Events

1 The Arm toolbar button on CinePlex Studio is clicked.

When the Arm button is clicked, Studio opens one or two (one if one camera 
is used, two if two cameras are used) temporary AVI files. The reasons that 
the files are temporary is that no time is lost opening the files when the Start 
button is clicked and that Sort Client sends the filename to Studio and since 
Studio does not know the filename in advance, the newly opened files must 
be temporary. The file format is yyyymmdd001tmp.avi if one camera is used. 
If two cameras are used, then two temporary files are created with the format 
yyyymmdd001tmp_1.avi for camera 1 and yyyymmdd001tmp_2.avi for 
camera 2 where yyyy is the year, mm is the month, and dd is the date. The 
001 is the current file number. This number increments with each recording 
during the day.

2 The Start button on Sort Client is clicked.
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When the Start button is clicked, Sort Client sends Studio the filename. How-
ever, Studio cannot rename the files because they are open. Thus, Studio will 
have to wait until recording is stopped before renaming the files

3 Studio reports how must disk space is remaining, that the files are being 
recorded, and the beginning recording time.

4 At some later time recording is stopped.

Studio’s Message pane reports that recording is stopped for both cameras 
and also that the temporary files were renamed. Studio also opens new tem-
porary files in anticipation of the next recording.

Note: If the recording is stopped abnormally (i.e. system crash, etc.), the 
temporary files are not renamed.
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2.6.5.2 CinePlex Studio File Formats

CinePlex Studio automatically generates filenames for AVI or DVT files. There 
are a number of formats for the filename. The format may contain an optional 3-
character prefix, an optional date format, and a 3-digit file number. The table 
below shows the various possibilities.

Note: The table shows the format for AVI filenames. The formats for the DVT filena-
mes are identical except that the extension is DVT.

The user may choose to have a prefix and/or a date as part of the filename. The 
prefix (PPP in the table) can be defined as any text string that is legal for Win-
dows file names. There are four date formats (mmddyy, ddmmyy, mmddyyyy, 
ddmmyyyy) where mm indicates the month, dd indicates the day, and yy or yyyy 
indicates the year. The file number contains any three digits. Unless the user 
specifies a different starting number, the file number begins at 001 or at the next 
available file number if 001 is already used. CinePlex Studio determines the num-
ber nnn from the AVI files already recorded and stored on the internal hard drive. 
The latest file name is always one greater than the largest-numbered AVI file 
already on the selected hard drive. If using one of the date formats and midnight 
occurs, the first file recorded after midnight restarts at 001. The last possible file 
number is 999. When recording that file number, the Next Available File prop-
erty displays N/A (Not Available).

Table 2: 

Prefix Date File # Filename Format

None None nnn nnnAVI

PPP None nnn PPPnnnAVI

None mmddyy nnn mmddyynnnAVI

None ddmmyy nnn ddmmyynnnAVI

None mmddyyyy nnn mmddyyyynnnAVI

None ddmmyyyy nnn ddmmyyyynnnAVI

PPP mmddyy nnn PPPmmddyynnnAVI

PPP ddmmyy nnn PPPddmmyynnnAVI

PPP mmddyyyy nnn PPPmmddyyyynnnAVI

PPP ddmmyyyy nnn PPPddmmyyyynnnAVI
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Note: If Studio is armed on one day, but the start signal is not received until the next 
day, the filename remains the one for the previous day.

2.6.6 Synchronizing Files from Two Video Cameras

In some cases of synchronizing files from two video cameras, one file can be sev-
eral frames larger than another due to minor software delays handling the Stop 
signal. The critical functionality is that the cameras start together and that triggers 
for corresponding frames occurr at exactly the same time.

2.6.7 Synchronizing Video Files with Neural Data Files

To synchronize the video files to the neural data files, a system must:

• derive all time stamps from the same clock

• start the recording of both files at the same time

• stop recordings at approximately the same time

Use of the same clock to generate the time stamps in each file avoids longer-term 
“drifting” of the time-base of one file relative to the other. For example, say the 
clock controlling the time stamp generation for video frames has a frequency dif-
ference of 1% from the clock controlling the time stamp generation of neural fir-
ing events in the neural data files; after 100 seconds, the occurrences that should 
appear as simultaneous in the neural data and AVI files appear instead as one sec-
ond apart. Since CinePlex Studio is integrated in a Plexon NDAQ, synchroniza-
tion occurs because CinePlex Studio is controlled with a clock signal derived 
from the main Plexon Neural Data Acquisition clock. Thus, the PLX and AVI 
files are guaranteed to have the same time-base.

Note: The CinePlex Studio clock is 1 MHz. This means that the resolution of time 
stamps generated by CinePlex Studio is 1 sec.

Simultaneous starting, stopping, pausing, and resuming of the neural data and 
video files is also essential to synchronization, because non-coincident start times 
make it difficult for the user to synchronize the behaviors captured in the video 
with their time-coincident neural activity.

Although the user may manually start, stop, pause, and resume recording an AVI 
file at any time in CinePlex Studio by simply clicking the appropriate toolbar but-
tons, Plexon does not recommend this mode of operation for recording synchro-
nized files, because it produces video files that do not have the same start time as 
the corresponding neural data files. Instead, configure CinePlex Studio to use 
Start, Stop, and Pause on the Plexon NDAQ.

CAUTION
Lighting Conditions
If lighting conditions change enough during recording that ‘objects 
too large’ or some other condition occurs, the position data may be 
meaningless.
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When using CinePlex Studio with a Plexon NDAQ, the NDAQ generates control 
signals and routes the signals through the control cable to the appropriate inputs 
for CinePlex Studio. To use this mode of operation, arm CinePlex Studio to 
respond to the electrical control signals. When armed, CinePlex Studio starts 
recording the video file one frametime after the start of the neural data file.

Note: CinePlex Studio resets the time stamp to zero when recording is started in Arm 
mode by Sort Client or when clicking the Record button to manually start 
recording a video file. Otherwise the time stamps continue to increment until 
CinePlex Studio is shut down.

2.6.8 Recording Synchronized Video and Neural Data

The system is connected as described in Appendix A so that the clock and control 
signals are sent from the Plexon Neural Data Acquisition to the CinePlex Studio 
components.

Note: For more information on setting up and running the MAP Sort Client, refer to 
the RASPUTIN User’s Guide. 

Procedure for recording time-synchronized video and neural data files

1 At the Plexon NDAQ, turn the power on and configure the Plexon NDAQ so 
that neural data appears in Sort Client; see “Operating CinePlex Studio with 
RASPUTIN Sort Client” on page 91. Do not start recording data to a PLX file. 

2 Click the CinePlex Studio icon. Wait for the CinePlex Studio application main 
window to appear on the monitor. 

3 CinePlex Studio provides a time code that tracks the time elapsed since the 
last time recording began. To view and configure the CinePlex Studio time 
display, in the Properties window in the Timecode area, click Visible. Choose 
a Location and a Format setting to configure the display. For example, the 
following illustration shows the time code in the Upper Left location in 
HH:MM:SS.SSS format.

4 In the Properties window in the Camera area, set the Contrast, Brightness, 
and Sharpness controls to get a acceptable image on the screen.

5 In the DVR area, set the Image Quality to the default setting of 4. 

Note: The user may also use other image quality settings. To evaluate 
image quality settings, manually collect a set of AVI files at different 
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settings and use the file mode to determine a minimum acceptable 
image quality setting for the use. 

6 From the CinePlex Studio DVR tool bar, click the Arm button. A yellow 
flashing cassette icon appears on the status bar.

7 At Sort Client, click Data File, then click Options. On the Start and Stop tab, 
click the CinePlex Sync check box, then click the Use User Commands 
radio button. Select and set Start and File Name Options as desired in the 
Options for User Command Start section.

8 From the Sort Client toolbar, click the icon to start recording. If a file name has 
not been selected, enter it.

Sort Client starts recording and displays status information about the neural 
data file on the Sort Client status bar; for information on the Sort Client status, 
see the RASPUTIN User’s Guide.

CinePlex Studio starts recording and displays information about the video file 
in the CinePlex Studio status bar.

Note: The Studio status bar will display the amount of free space remaining 
on the drive selected. The file can grow to fill the space available.

Note: For more information about recording files using Sort Client, refer to 
the Plexon RASPUTIN User’s Guide; see “Using Sort Client, Section 
C, Record.” 

9 To pause recording, from the Sort Client Datafile menu, click the Pause 
Recording icon. 

Sort Client pauses recording and displays status information about the neural 
data file on the Sort Client status bar; for information on the Sort Client status, 
see the RASPUTIN User’s Guide.

CinePlex Studio pauses recording and displays information about the video 
file in the CinePlex Studio status bar. The status bar flashes green and gray to 
indicate that the recording is paused.

To resume recording, click Pause Recording again.

10 To stop recording, from the Sort Client Datafile menu, click Stop Recording 
or the Stop icon.

Sort Client stops recording to the neural data file, clears the recording infor-
mation from the status bar, and saves the file to the location specified in 
Step 8. 

HINT
Reducing blurs and color streaks in the video
If the experimental subject moves quickly, blurs and color streaks 
can appear in the video. Reduce or eliminate these problems by 
increasing the shutter speed. For more information, see “Shutter” 
under “Source Tab(s)” on page 122.
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Note: When recording remotely Studio writes to temporary files. For effi-
ciency, the files are opened before recording begins. When recording 
is stopped, the temporary files are renamed, and new temporary files 
are opened in anticipation of a new recording session (see the indi-
cated section in the image above).

CinePlex Studio stops recording to the video file and saves the file to the loca-
tion shown in the status bar at Step 6. CinePlex Studio clears the recording 
information from the status bar and re-arms itself for the next recording ses-
sion.

11 To disarm CinePlex Studio, from the DVR toolbar, click Arm to clear it. The 
status bar returns to the disarmed state.

12 To view the captured video file, follow the procedure at “Managing Video 
Files” on page 64. 

13 To transfer the files to the analysis computer (if different), follow one of the 
procedures at “Transferring Recorded Files” on page 65. 

14 To view the files together, start CinePlex Editor by following the procedures 
described in Chapter 4. 

Note: The user may also view just the video files by using Windows Media 
Player on the analysis computer.

2.6.9 Managing Video Files

To manage video files, first set the location of the Recording files.

Setting the Recording folder

1 At CinePlex Studio, from the Tools menu, click Change Data Folder.

The Choose Folders dialog box opens.

When Capture starts for the first time, it creates the Recording folder “C:\Plex-
onData\” if it does not already exist. Thus, the default location of the Record-
ing folder is the internal hard drive. Since the MAP/CPX computer is supplied 
with two hard drives (C: and D:), Plexon recommends putting neural data on 
one (C: usually) and the video data on the other (D: usually).
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2 To set or change the folder location, click on the Browse button. 

The Browse for Folder dialog box opens.

Note: It is possible to delete a folder from this dialog box by selecting the 
folder and hitting the Delete key. However, the user can not delete the 
Recording folder in this manner.

3 Create a new folder or navigate to a desired existing folder and click OK when 
finished. 

The location of the Recording folder is automatically saved in the Capture 
configuration file and loaded at the next launch of the application.

Note: If the Recording drive is not NTFS, a warning message displays.

2.6.10 Transferring Recorded Files

Note: This section applies to implementations with separate capture and analysis 
computers.

To transfer the files to the analysis computer, Plexon recommends a USB drive or 
network connection. Files can be moved from the Studio computer to another 
device using standard Windows tools.



2  

66  CinePlex

Using an external USB drive or memory stick to transfer files

1 Insert the USB drive into a USB slot on the computer where the desired files 
reside.

Note: If the Plug and Play framework is enabled, just follow the instructions 
on the popup window to navigate to the files to move or copy. Then, 
move or copy the files as needed.

Note: If the Plug and Play framework is disabled, just move or copy the 
desired files by using standard move or copy methods.

2 Open Windows Explorer and navigate to the USB drive.
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3 Open a second Windows Explorer and navigate to the directory containing the 
files to be copied

.

4 Select the desired files. Hold down the CTRL key while clicking the left mouse 
button on each desired file.

.
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5 Click the left mouse button on one of the highlighted files and hold the mouse 
button down while dragging the mouse to the destination folder in the other 
Windows Explorer. All of the selected files will be copied to the USB drive.

.

Note: After selecting the files, it is also possible to copy the files by right-
clicking the mouse on one of the highlighted files, selecting Copy 
from the right-click menu, then right-clicking the mouse in the destina-
tion folder, and selecting Paste from the right-click menu.

6 Unplug the USB drive from the MAP/CPX computer.

7 Plug the USB drive into the analysis computer, and copy the files to the 
desired location.

Note: With the flexibility of the PlexUI interface, the experimenter may elect 
to dock any of the CinePlex Studio window panes in a different area 
than the default, float them completely free from the Studio window, or 
close them entirely. For simplicity of this discussion, all panes are 
assumed to be in their default positions. The user can return any 
Plexon application to its default layout by clicking the “Window” item 
in the top level toolbar, clicking “Layout”, then clicking “Reset to 
Default Layout”.
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2.7 Global Configuration Pane

The Global Configuration default position is as a tab in the upper left pane of the 
CinePlex Studio window. This pane is the first an experimenter will normally use 
when setting up CinePlex Studio, but perhaps not very often after that. It contains 
settings that pertain to frame rate to use when recording, quality of recordings to 
make, and whether the experiment involves one animal or many. There are two 
slightly different versions of this pane depending on whether the video being pro-
cessed comes from cameras or files.

2.7.1 Processing Camera Video

2.7.1.1 Frame Rate

The frame rates available for selection depend on the camera(s) attached to the 
system. The lowest frame rate available is normally 1 frame per second. The 
highest is the maximum frame rate attainable by the system as a whole after 
accounting for camera, FireWire, disk and CPU limitations. In general, if there 
are two cameras installed, the achievable frame rate per camera may be less than 
if there were only one camera installed.

2.7.1.2 Compression

Any new files that CinePlex Studio creates will always be encoded in MPEG for-
mat as defined in the applicable MPEG specification document. MPEG file sizes 
and quality vary with the nominal compression bit rate. The higher the bit rate, 
the higher the resulting video quality, but the resulting AVI files are larger as 
well. In CinePlex Studio the MPEG Quality is adjustable from 1 to 10. The larger 
the value selected, the larger the resulting AVI file will be, but it will have better 
resolution. Adjust this number to obtain acceptable results for the experiments. 
The value defaults to 4, a value Plexon has found to be a good compromise in 
most situations. For reference, the selectable values correspond to the MPEG 
nominal bit rate divided by 500,000.

2.7.1.3 Local File Name

This section allows the user to specify a file naming plan for recordings that are 
not controlled by Sort Client. If the ARM mode is entered, these file names are 
ignored and CinePlex Studio waits for file naming information from Sort Client. 
If Local Record is started, the file name will be constructed using the parameters 
selected here. These parameters include File Name Prefix if desired, Date inser-
tion, if desired, and numbering selection. The next file name for local recording is 
shown for reference.

2.7.1.4 Experiment

The only currently available experiment adjustment is a selection as to whether 
the experiments involve one animal or more than one. Make the selection “Sin-
gle” or “Multiple” appropriately. The effect on CinePlex Studio is to change the 
way it searches for multiple colors or LEDs when tracking is lost momentarily.
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2.7.2 Processing File Video

These are the available options when the video being processed comes from one 
or more files.

2.7.2.1 Frame Rate

This is a display-only field showing the frame rate at which the video file(s) were 
recorded.

2.7.2.2 Speed

This adjustment determines the speed at which CinePlex Studio will attempt to 
create the new video file(s). It does not change the frame rate of the video. This 
speed will ultimately be limited by the capabilities of the computer on which it is 
installed.

2.7.2.3 Position

This is the frame number from which recording of new files will start. It can be 
changed by adjusting the slider which can be placed anywhere within the file, 
once a file has been selected on the Source pane.

2.7.2.4 Compression

Any new files that CinePlex Studio creates will always be encoded in MPEG for-
mat as defined in the applicable MPEG specification document. MPEG file sizes 
and quality vary with the nominal compression bit rate. The higher the bit rate, 
the higher the resulting video quality, but the resulting AVI files are larger as 
well. In CinePlex Studio the MPEG Quality is adjustable fro 1 to 10. The larger 
the value selected, the larger the resulting AVI file will be, but it will have better 
resolution. Adjust this number to obtain acceptable results for the experiments. 
The value defaults to 4, a value Plexon has found to be a good compromise in 
most situations. For reference, the selectable values correspond to the MPEG 
nominal bit rate divided by 500,000.

2.7.2.5 Experiment

The only currently available experiment adjustment is a selection as to whether 
the experiments involve one animal or more than one. Make the selection “Sin-
gle” or “Multiple” appropriately. The effect on CinePlex Studio is to change the 
way it searches for multiple colors or LEDs when tracking is lost momentarily.
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2.8 Source Pane

The Source Pane default position is as a tab in the upper left pane of the CinePlex 
Studio window. This pane is the second an experimenter will normally use when 
setting up CinePlex Studio. There can be multiple Source panes if there are multi-
ple cameras on the system of if the user wishes to process multiple video files 
together. The source pane for a camera is different from the Source pane for a file. 
It contains settings that pertain to frame rate to use when recording, quality of 
recordings to make, and whether the experiment involves one animal or many.

2.8.1 Frame Rate

The frame rates available for selection depend on the camera(s) attached to the 
system. The lowest frame rate available is normally 1 frame per second. The 
highest if the maximum frame rate attainable by the system as a whole after 
accounting for camera, FireWire, disk and CPU limitations. In general, if there 
are two cameras installed, the achievable frame rate per camera may be less than 
if there were only one camera installed.

2.8.2 Compression

Any new files that CinePlex Studio creates will always be encoded in MPEG for-
mat as defined in the applicable MPEG specification document. MPEG file sizes 
and quality vary with the nominal compression bit rate. The higher the bit rate, 
the higher the resulting video quality, but the resulting AVI files are larger as 
well. In CinePlex Studio the MPEG Quality is adjustable fro 1 to 10. The larger 
the value selected, the larger the resulting AVI file will be, but it will have better 
resolution. Adjust this number to obtain acceptable results for the experiments. 
The value defaults to 4, a value Plexon has found to be a good compromise in 
most situations. For reference, the selectable values correspond to the MPEG 
nominal bit rate divided by 500,000.
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2.9 CinePlex Studio Tracking Pane (if available)

As described in Chapter 1, the CinePlex Studio Tracking option can generate 
tracking coordinates in one of three modes: Object Contour, LED, or Reflective 
Colors. The Tracking tab is blank until a tracking mode has been selected.

CinePlex Studio uses Tracking Windows and Arena Definition to track objects 
and reduce unwanted parasite objects. These elements are explained below.

2.9.1 Tracking Window

Tracking windows are used to reduce problems with unwanted parasite objects 
(e.g. reflections) and to reduce the processor load by restricting analysis to a 
small portion of the video image.

The size of the tracking window is set automatically to cover the whole object. 
Each object (whole animal, LED, or marker) has its own tracking window. The 
tracking window is repositioned automatically. A history of an object’s move-
ment is used to predict its next position. If the object disappears because of occlu-
sion by a cable or other means, its tracking window is moved according to the 
speed and movement direction in its most recently detected frames. If the system 
is tracking multiple LEDs or markers in single animal mode, the system will also 
use the positions of the found LEDs or markers to predict the position of the one 
that disappeared. If the object is not found after a certain number of frames, the 
size of the tracking window will be increased. If the object is not found within 
two seconds, the system switches to search in the whole frame (possibly 
restricted by an arena - see below).

2.9.2 Arena Definition in the Areas Tab

The Arena  Definition is also used to reduce problems with unwanted parasite 
objects outside of the working area. If a reflection of other unwanted object 
appears outside the arena, it will not be detected by CinePlex Studio.
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The Arena Definition is also used to reduce the processor load because only the 
portion of the video image restricted by the arena is analyzed. 

Special drawing tools are available in CinePlex Studio to design the arena. The 
user may draw many shapes: circles, ovals, rectangles, and freehand polygons. To 
perform operations on the arena, click the one of the Arena nodes (Arena Out-
line or Arena Transparency).

Select the shape to draw. For a rectangle or circle, left-click and hold the mouse 
on a desired point on the image and move the mouse to size the arena. For a free-
hand polygon, click the left mouse button over desired points that will be the 
nodes of the polygon. The user may move and resize the arena and also drag the 
nodes of a freehand polygon.
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2.9.3 Selecting Tracking Modes for the Experiment

In general, for a given experimental setup only one mode is appropriate. The fol-
lowing guidelines can help to determine which tracking mode to use:

• In general, the user obtains the best tracking results when light-emitting 
diodes (LED) are attached to the animal. The easiest way to do this is to 
mount the LEDs directly on the animal headstage, as is shown in Figure 2-1. 
Plexon offers headstages with LEDs mounted on them.

Figure 2-1

LED Headset

• To track not only position but head direction, use two or three LEDs. Because 
Object Contour Mode can only track the “center of gravity” of the animal’s 
contour, Object Contour mode cannot be used with LEDs.

• If the user needs Motion Measure, which can be used for fear studies where 
animal “freezing” behavior is important, use Object Contour mode.

• If the animals are multicolored, especially with high-contrast colors (e.g. 
Long Evans rats), Object Contour mode will not work well only with a con-
trasting background color, such as red.

• For LED tracking the brightest spots on the image are found, and their posi-
tion in the color space is determined. This mode is recommended when LEDs 
are to be tracked, and they are the brightest spots on the image and the rest of 
the image is dark. Check the Pure Colors option to cause the system to recog-
nize the standard red, green, and blue colors automatically. Otherwise, select 
the colors to track.
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• In Reflective Colors mode, pixels having the specified colors are analyzed as 
belonging to the corresponding object. Use this mode, if desired, for tracking 
LEDs or color markers when the arena is lit.

• In general, to obtain optimal tracking results put more effort into setting up 
Object Contour mode than either LED or Reflective Colors modes. Object 
Contour mode is also more sensitive to changes in background or lighting 
conditions.

2.9.4 Object Contour Mode Tracking

Object Contour mode tracking contrasts and thresholds a monochrome image and 
computes its centroid to track the target. Object Contour tracking includes 
options that provide detail filtering, background subtracting, contour closing, and 
motion measuring. For more information on using the CinePlex Studio optional 
capabilities for Object Contour mode, see “Options For Object Contour Mode” 
on page 78. The flowchart in Figure 2-2 illustrates the steps involved in configur-
ing both the basic setup and the setup options for Object Contour mode. Detailed 
procedures follow the flowchart. If desired, use the Tracking Wizard (see “Object 
Contour Mode Tracking” on page 75) to provide an on-screen step-by-step guide 
to the following procedure.
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Figure 2-2

CinePlex Studio Object Contour Mode Tracking Flowchart

HINT
Use Default Settings
Use the Restore defaults to factory settings toolbar button to return 
all CinePlex Studio and camera settings to their default values. Set 
the default values prior to configuring a tracking mode.
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Configuring CinePlex Studio to track in Object Contour mode

1 Turn on the CinePlex Studio computer. On the File menu, click Restore 
Factory Settings.

Note: To complete this procedure, install the CinePlex Studio system. If the 
system installation has not been completed, see Appendix A.

2 On the Tracker menu, click Object Contour.

3 While observing the display on the monitor, position the camera to capture the 
entire arena in the field of view. Minimize the capture of areas outside the 
arena.

4 In the Camera area, click to clear the Auto Contrast and Auto Brightness 
checkboxes.

5 In the Camera area, adjust the Brightness slider to get a video image that 
provides the maximum difference in intensity between the target animal and 
the arena. Then, adjust the Contrast slider to maximize the contrast between 
the target and the arena. 

6 In the Object Contour Tracker area, click Show Contour/Fill Contour to 
view the contour(s) of the object(s) that the system is tracking.

7 Adjust the Threshold setting so that the object is found. For more information 
about setting the threshold, see “Setting the Threshold” on page 87.

HINT
Reducing blurs and color streaks in the video
If the experimental subject moves quickly, blurs and color streaks 
can appear in the video. Reduce or eliminate these problems by 
increasing the shutter speed. For more information, see “Shutter” 
under “Source Tab(s)” on page 122.
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8 On the File menu, click Save Settings.

or

Click the Save Settings button ( ) on the toolbar.

2.9.4.1 Options For Object Contour Mode

CinePlex Studio Object Contour mode includes optional capabilities to handle 
special circumstances in the experimental environment:

• Detail filtering

• Background subtraction

• Close contour

• Motion measurement

2.9.4.1.1 Detail Filtering Adjustment. Use Detail Filtering to remove small fea-
tures of the image that distort the tracking results. For example, a long tail on a 
target animal can skew the centroid calculation; cables attached to the target can 
also skew the results. The Detail Filtering adjustment has 10 settings that can 
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remove progressively larger features. Use the lowest setting that provides ade-
quate results for the experiment.

To apply Detail Filtering

1 In the Properties window Object Contour Tracker area, click Show Contour 
or Fill Contour. Click Detail Filter and set the slider to 2.

2 Observe the effect on the image. Set the Detail Filter slider to lowest setting 
that removes the undesirable features from the target image.

3 On the File menu, click Save Settings.

2.9.4.1.2 Background Option. Use the Object Contour mode Masking option to 
configure CinePlex Studio to ignore areas in the image that are at the same inten-
sity as the target. Use this option to remove background clutter that cannot be 
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physically eliminated from the field of view, or image clutter that cannot be elim-
inated by using CinePlex Studio’s brightness, contrast, and threshold settings.

To apply the Background option

1 Set up CinePlex Studio to track the target in Object Contour mode. In the 
Properties window Object Contour Tracker area, click to clear the Use 
background checkbox.

2 In the Object Contour Tracker area, click Show Contour/Fill Contour.

3 In the Camera area, click to clear the Auto Contrast and Auto Brightness 
checkboxes.

4 In the Camera area, adjust the Brightness slider to get a video image that 
provides adequate discrimination of the target with the least number of white 
pixels outside the target area. Do not distort the integrity of the target shape. 
Likewise, adjust the Contrast slider to minimize the white pixels outside the 
target area.

Note: The user may also use CinePlex Studio to adjust automatically both 
brightness and contrast. To do so, in the Camera area, click Auto 
Contrast and Auto Brightness. 

5 Remove the target animal from the arena.

6 On the Tracker | Background menu, click Capture, or click ( ) on the 
toolbar. The user may also see the captured background or clear the captured 
background image by using the two buttons next to this button.

7 In the Object Contour Tracker area, click Use Background. 

8 Return the target animal to the arena and adjust the threshold so that the 
desired object is found.

2.9.4.1.3 Close Contour Option. The Close Contour capability causes the 
tracker to merge multiple objects in near proximity to each other into a single 
object. This can occur when a cable passes between the animal and the camera. 
Adjust the setting so that a single object is displayed. The illustration below is 
taken before the Close Contour setting is applied.
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The illustration below is taken after the Close Contour setting is applied.

2.9.4.1.4 Motion Measure Option. CinePlex Studio Motion Measure is an addi-
tional Object Contour mode option that can be used to detect animal “freezing” in 
fear-conditioning experiments. The Motion Measure option is separate and dis-
tinct from the target-tracking capability. If the Motion Measure option is selected, 
CinePlex Studio optionally writes both the motion-measurement data and the tar-
get position data for each video frame to the Plexon Neural Data Acquisition, or 
to a DVT file.

CinePlex Studio analyzes the images of the target animal in consecutive frames. 
The pixels that lie on the animal in the current video frame but not on the animal 
in the previous video frame (and vice versa) are counted. This number is divided 
by the total number of animal pixels in the current frame. The maximum result is 
nominally 2.0, and the range 0.0 to 2.0 is scaled to the range 0 to 1023 and written 
to the Plexon NDAQ. A value of 1023 indicates that the animal moved so quickly 
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that no pixels were in common with the previous frame. A value of 0 results 
when:

• the frame is the first frame of the file,

• the previous frame and the current frame are identical,

• the tracking window switched from small in the previous frame to large in the 
current frame,

• the tracking window switched from large in the previous frame to small in the 
current frame, or

• the object in the previous frame and the object in the current frame are of 0 
size.

CinePlex Studio writes the motion measure value to a digital VideoTracker 
(DVT) format file; for more information, see “Digital VideoTracker (DVT) Files” 
on page 156.

The Motion Measure frame-to-frame pixel overlap technique provides informa-
tion on the movement of the animal’s body over time. For example, a rotating 
animal’s centroid might not change, but the Motion Measure feature would indi-
cate that the animal is not actually “frozen” because consecutive video frames are 
not identical.

Note: The VTViewer motion measure chart does not move until the center of gravity 
is sent to the PLX file.

To apply the Motion Measure option

• On the Object Contour Tracker menu, click the Motion Measure checkbox.

2.9.5 LED Mode Tracking

This section includes the configuration procedure for configuring CinePlex Stu-
dio to track colored LEDs. The user may track up to three different colored LEDs. 
Each tracking mode operates separately. The user cannot combine Object Con-
tour mode and LED mode. Use the Tracking Wizard (see “Object Contour Mode 
Tracking” on page 75) to provide an on-screen guide to the following procedure.

HINT
Use Default Settings
Use the default settings toolbar button to return all CinePlex Studio 
and camera settings to their default values. Set the default values 
prior to configuring a tracking mode.
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Configuring CinePlex Studio to track in LED mode

1 From the File menu, select Set Defaults.

2 From the Tracker menu, select LED.

3 Place powered LEDs in the camera field of view. At the camera lens, adjust 
the zoom, focus, and iris settings for the best picture quality.

4 In the Properties window Camera area, click to clear the Auto Contrast and 
Auto Brightness checkboxes.

5 In the Camera area, adjust the Brightness and Contrast sliders to provide 
the best quality picture.

6 To select the first LED to track, in the LED Tracker area, click Color 1. 

HINT
Reducing blurs and color streaks in the video
If the experimental subject moves quickly, blurs and color streaks 
can appear in the video. Reduce or eliminate these problems by 
increasing the shutter speed. For more information, see “Shutter” 
under “Source Tab(s)” on page 122.
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7 To have CinePlex Studio recognize the standard red, green, and blue colors, 
ensure the Pure Colors checkbox is checked.

If Pure Colors is not selected, the color desired can be selected by clicking in 
the color display and positioning the cursor over a pixel of the desired color.

CinePlex Studio changes the mouse cursor to cross hairs and a magnified 
view of the screen pixels appears in a window on the image.

Position the cross hair over a colored pixel that best represents the color of 
the LED to track. Click the left mouse button to set the color. Repeat this step 
for each color to track. Also see “Setting the Threshold” on page 87.

2.9.5.1 Using the Color Pick-up Tool

To adjust Color 1, Color 2, or Color 3 in the LED Tracker or Reflective Colors 
Tracker  modes, follow the procedure below.

1 To use the color pick-up tool, click on the Color Selection box whose color to 
adjust. The image below shows a sample video window before clicking the 
Color Selection box.
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2 In the Video window a square area surrounding the mouse cursor displays as 
a magnified window. Move the magnified window over the area to be shown in 
the Color Selection box. The image below shows the magnified cursor 
window in the lower left of the diagram - note the digitization of the area.

3 Position the crosshair over a representatively colored pixel. The Color 
Selection box displays the color of the pixel directly under the crosshair. The 
image below shows a red pixel under the magnified area.

4 Click the pixel.

5 The color of the corresponding color box in the properties window will be 
changed to that of the clicked pixel.

2.9.6 Reflective Colors Mode Tracking

This section includes the procedure for configuring CinePlex Studio to track in 
Reflective Colors mode. The user may track up to three different reflective col-
ors, like painted markers or colored garbs. Each tracking mode operates sepa-
rately. It is not possible to combine Object Contour, LED, and Reflective Colors 
modes.The user may use the Tracking Wizard (see “Object Contour Mode Track-
ing” on page 75) to provide an on-screen guide to the following procedure.
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Configuring CinePlex Studio to track in Reflective Colors mode

1 From the File menu, select Restore Defaults.

2 From the Tracker menu, select Reflective Colors. 

3 Place color targets in the camera field of view. At the camera lens, adjust the 
zoom, focus, and iris settings for the best picture quality 

4 In the Properties window Camera area, click to clear the Auto Contrast and 
Auto Brightness checkboxes.

5 In the Camera area, adjust the Brightness and Contrast sliders to provide 
the best quality picture.

6 To select the first color to track, in the Reflective Colors Tracker area, click 
Color 1. 

7 To have CinePlex Studio recognize the standard red, green, and blue colors, 
ensure the Pure Colors checkbox is checked and also check the color 
channels to be tracked.



Version 3.0 87

If Pure Colors is not selected, the color desired can be selected by clicking in 
the color display and positioning the cursor over a pixel of the desired color.

CinePlex Studio changes the mouse cursor to cross hairs and a magnified 
view of the screen pixels appears in a window on the image.

Position the cross hairs over a colored pixel that best represents the color of 
the object to track. Click the left mouse button to set the color.

8 If the cursor does not track the object accurately, in the Reflective Colors 
Tracker area, adjust the Threshold for Color 1 slider until the cursor tracks 
accurately.

Note: If the cursor does not track accurately with the sensitivity at maxi-
mum, change the color or adjust the sharpness and saturation. 

9 To track additional colors, repeat Step 5 through Step 8 substituting the Color 
2 or Color 3 controls for the Color 1 control and the Threshold for Color 2 or 
Threshold for Color 3 controls for the Threshold for Color 1 control. Also 
see “Setting the Threshold” on page 87.

10 After completing the previous steps, verify that the configured CinePlex Studio 
system looks like the following illustration, which is set up to track three 
colors.

2.9.6.1 Setting the Threshold

CinePlex Studio can locate an object of a specified color by the color contrast 
between the desired color and the threshold setting. If the threshold setting is too 
low, the image could be similar to the one shown below. It will probably be nec-
essary to experiment with the setting to obtain the optimal value.
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If the size of the found target object is larger than 1/4 of the frame area, there will 
be a red blinking message on the bottom of the screen notifying that the threshold 
is probably too low and both the Arm and Record buttons will be disabled.

Try to set the threshold so that the number of parasite objects is as few as possi-
ble. To see all objects, check the “Show All Objects” checkbox.

To see the object recognized as the target object, check the “Show Contour” and 
Fill Contour” checkboxes.



Version 3.0 89

Increase the threshold to reduce the number of parasite objects.

Increasing the threshold does not work in all cases. If the threshold is too large, 
the target object will be smaller. In such cases, detail filtering is helpful.
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2.10 Operating CinePlex Studio with RASPUTIN Sort Client

Setting up CinePlex Studio to Transmit Tracking Data to a MAP

When tracking is operational, the (X,Y) location values for up to three tracked 
objects from Camera 1 (or File 1) can be time stamped and sent to the MAP 
circular buffer in real time. The values are tagged as strobed data, since they 
are strobed by the video frame trigger. Once in the buffer, they are available to 
client software, whether written by Plexon or its customers. If enabled, the 
Plexon Sort Client program displays hash marks representing the receipt of 
each packet of location values. All location data values are saved into PLX 
files, together with the associated neural data.

Note: Once an initial offset message has been received after a boot, mode 
change, or settings reload, data is sent to the circular buffer at all 
times except when in armed state.

1 Set up CinePlex Studio so that contours, LEDs, or colors are being tracked 
successfully, at least on Source 1. (This is described in detail in earlier 
sections of this chapter).

2 On the Tracking 1 window, press the PLX button next to the object or color to 
send to the MAP. In the case of LED or Color Markers mode, up to three 
colors may be selected.

3 Press the start icon on Sort Client, and then press the stop icon a few 
seconds later. This causes Sort Client to send a synchronizing time message 
to CinePlex Studio so that the time stamps of neural data and video data are 
synchronized.

4 Verify that strobed data is being received by Sort Client (see below).

5 If desired, delete the short PLX file created by Sort Client in Step 3.

Note: Note that if CinePlex Studio is restarted, a different settings file is 
loaded, or tracking mode is changed, steps 1 through 5 must be 
repeated to ensure that position data is being sent and received as 
desired.

All CinePlex Studio tracking data is recorded directly to the PLX files generated 
by RASPUTIN Sort Client. After setting up CinePlex Studio to track animal 
motion, set up Sort Client to record the tracking data. The following procedure 
explains how to set up Sort Client to record tracking data.

Startup
The startup sequence is extremely important. RASPUTIN must be 
started before Studio is started so that the client registration process 
works properly. Otherwise, when a recording is eventually started by 
RASPUTIN neither the file name string nor the recording time 0 mes-
sages are received.

If RASPUTIN exits or is closed for any reason, it should be brought 
back up, then Studio should be closed and restarted, as well.
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Note: For additional information on setting up and running Sort Client, refer to the 
RASPUTIN User’s Guide. 

Setting up Sort Client to record CinePlex Studio data

1 Turn the Plexon MAP on. Turn the computer on. 

2 At the computer, start Server. 

3 Start Sort Client.

4 On the Sort Client View menu, click Settings Window.

5 In the Settings window, click the Events tab.

6 In the Name column, locate the channel named Strobed. In the Show 
column, click to select the check box for the Strobed channel.

7 Click the Start button on Sort Client.
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To verify CinePlex Studio data acquisition

1 Configure CinePlex Studio so that it is generating position data. For more 
information, see “CinePlex Studio Tracking Pane (if available)” on page 72.

2 In Sort Client, on the View menu, click Activity Display. 

As shown in the following illustration, the Activity Display shows no activity 
on the strobed channel.

3 Click Start, or, from the Server menu, select Start Data Transfer. 

The red LED on the DSP-board input port turns on. As shown in the following 
illustration, when the red LED is on the Activity Display shows the strobed 
events from the CinePlex Studio tracking data.

Note: If the Activity Display does not show the strobed events, or the red 
LED on the DSP-board input port is not on, refer to Appendix B.

2.10.1 Using VTViewer

CinePlex includes a utility program called VTViewer. After setting up and start-
ing Sort Client, use VTViewer to see a graphical image of the animal position on 
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a 1024 by 768 grid. VTViewer provides a grid view for all tracking modes, as 
well as a selectable Motion Measure display in the Object Contour mode.

Note: VTViewer only shows tracking position data. It cannot show captured video 
frames.

Before beginning

Before using VTViewer, set up data transfer in Sort Client. To so, make sure to 
complete all the steps up to and including those in “To verify CinePlex Studio 
data acquisition” on page 93.

Note: It is extremely important to follow precisely the startup sequence given or else 
the position data may not be visible.

Starting VTViewer

1 Click the VTViewer icon on the desktop to start VTViewer.

2 As the following illustration shows, the default VTViewer window includes the 
following three areas, in addition to the location grid:

• Control View (panel on the left side)

• Toolbar

• Motion Level View (across the bottom)
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3 In the Control View, click Connect. VTViewer plots the real-time location of 
the target animal on the grid as shown in the following illustration. The 
illustration shows a Object Contour-mode plot that includes motion measure 
data. 

Note: The motion measure chart does not move until the center of gravity is 
sent to the PLX file.

4 If CinePlex Studio is set for LED tracking mode or Reflective Colors tracking 
mode, and at least one color is defined, VTViewer plots the real-time location 
of each colored LED that has been set up to track.

Note: If CinePlex Studio is tracking in LED or Reflective Colors mode, 
define at least one color to have data appear in VTViewer. If no colors 
have been defined, data does not appear at the Plexon MAP. 
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The following illustration shows a plot of a two-LED headset with one red and 
one green LED.

Note: VTViewer provides the motion measure plot for Object Contour mode 
tracking only. If CinePlex Studio is set to LED mode or Reflective Col-
ors mode, and Motion Level View from the View menu is selected, 
VTViewer briefly displays the motion level plot below the grid. 
Because there is no motion measure data to plot, VTViewer removes 
the motion measure display after a few seconds.
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2.10.1.1 Control View

VTViewer displays the Control View by default. 

Control View provides the following controls:

• Connect, Pause, and Erase buttons

• The Mode area, which shows the CinePlex Studio tracking mode.

• The Position area, which displays X, Y data points in real-time. 

• The Options button, which opens the VTViewer Options dialog box.

• The Fit Window checkbox, which expands the 1024 X 768 plot to fit the size 
of the current window.

• The Auto-Scrolling checkbox, which enables scrolling of Object Contour 
mode displays when the window containing the display is smaller than 1024 
X 768.

• The Draw Arrows checkbox, which enables the display of arrows in LED 
mode. For more information, see “Arrows In the LED Mode” on page 98.
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To expand the display area, close the Control View by clicking the close button, 
or, from the View menu, click to clear the Control View checkbox.

2.10.1.2 Arrows In the LED Mode

The user may set VTViewer to display arrows that point from LED to LED in the 
order of their selection. For example, to have an arrow to point to the nose of the 
target animal, select the LED nearest the tail first. Then select the LED nearest 
the nose. The resulting arrow in the VTViewer plot points toward the nose of the 
animal. The following illustration shows the plot of an animal with a red LED 
nearest the tail and a green LED nearest the nose.
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2.10.1.3 VTViewer Options

The Options button opens the VTViewer Options dialog box. This dialog box 
includes controls for display colors, grids, and data input selections. The follow-
ing illustration shows the Options dialog box default settings. 

The VTViewer Options dialog box provides the following controls:

• The Background Color and Axis and Label Color controls set the display 
colors. The Current Position Marker Size control sets the size (in pixels) of 
the on-screen marker that indicates the animal’s position. The Draw Grid 
Lines control applies grid lines to the plot. The Spacing control sets the spac-
ing (in pixels) between the grid lines. The grid-line Color control sets the 
color of the grid lines.

• In the Colors For Positions area, the color controls set the display color for 
each LED being tracked. These position colors apply to the VTViewer dis-
play only and they do not apply to the CinePlex Studio image. The user may 
set these colors to match the LED colors set up to track in CinePlex Studio. 
The user may also set them to the desired choice of colors.

• In the Tails area, the controls set the characteristics of the plot line (tail) that 
tracks the current position marker. The Length control sets the length of the 
tail in data points. The Line Width control sets the width of the line in pixels. 
The Fade setting makes the tail slowly fade away as the target animal moves 
about the arena. In the Data Point Markers Along Tails sub-area, the Color 
control sets the color of the data points on the tails. The Size control sets the 
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size of the data-point markers in pixels. The Draw Every control sets the fre-
quency that VTViewer plots data-point markers along the tails.

• In the Motion Level area, the controls set the characteristics of the Motion 
Level display. The Background Color, Line Color, and Grid Color controls 
set the appearance of the Motion Level display. The Time Range to View 
control sets the number of seconds on the horizontal axis of the display.

• For Plexon NDAQs with two digital input (DI) boards, in the Multiple DI 
Board Operation area, the controls select which input board to use. The Use 
Data From control buttons can be set to 

— Either DI (default setting) to use data from either the top or the bottom 
board, whichever one has a digital input

Note: VTViewer cannot accept data from more than one board. Do 
not connect a digital input to both boards.

— First DI Only to use data from the top DI board only

— Second DI Only to use data from the lower DI board only

2.10.2 Recording Remotely from MAP Sort Client

Most users will want to synchronize completely their video data with their neural 
data. The best way to do this is to allow the MAP Sort Client to start video 
recording at the exact time that neural data recording starts. Follow the procedure 
below to make this happen.

Procedure for Recording Remotely from MAP Sort Client

1 Adjust all the CinePlex Studio recording, tracking, and behavior settings as 
needed. Save the settings to a uniquely named TXT file, if not already done 
so.

2 Press the Arm button (circle with an “A” inside) on CinePlex Studio. This 
places CinePlex Studio into armed mode and no settings can be changed.

3 Adjust all parameters in the MAP Sort Client as needed. Save the parameters 
to a uniquely named file, if not already done so.

4 Press the Record button on Sort Client.

5 Observe that the new file name is present, green and indicating recording in 
the status bar at the bottom of the Sort Client main window and the CinePlex 
Studio main window.

6 When the experiment has been completed, press the Stop button on Sort 
Client.

7 Observer that the status bars are no longer green, and that Sort Client is 
ready to record again.

8 If finished recording, press the Arm button on CinePlex Studio again to take it 
out of armed mode. If any setting changes are needed, they can be done now.

9 If not finished recording, just leave CinePlex Studio in armed mode and repeat 
from Step 3.
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2.11 CinePlex Studio Offline Mode

2.11.1 Entering Offline Mode

CinePlex Studio will come up in offline mode automatically if no cameras are 
detected. This will be the case, for example, when CinePlex Studio is installed on 
a non-MAP computer for the purposes of offline analysis of existing video files. 
Depending of the last offline activity performed on this computer, the mode will 
be automatically selected as “File 1”. “File 2”, or “Two Files”. The user can 
change from the selected offline mode to another by dropping down and selecting 
the desired mode - “File 1”, “File 2”, or “Two Files”.

The user can also change CinePlex Studio to operate in offline mode by selecting 
“File 1”, “File 2”, or “Two Files” from the drop down in the File toolbar. This can 
be done on the normal MAP computer where the camera(s) are installed, as well 
as on another computer. Depending on the last offline activity performed on this 
computer, the mode will be automatically selected as “File 1”, “File 2”, or “Two 
Files”. The user can change from the selected offline mode to another by drop-
ping down and selecting the desired mode - “File 1”, “File 2”, or “Two Files”.

2.11.2 Offline Settings

Offline mode allows existing CinePlex video file(s) to be re-recorded with differ-
ent or changed settings from the original recording. This means the user can:

• Re-record CinePlex files previously saved in MJPEG format to the much 
more compact MPEG format, thus saving storage space

• Re-record CinePlex files already in MPEG format with a reduced quality set-
ting to reduce further their size and save storage space

• Change brightness or contrast so that existing files are more usable

• Change tracking parameters (if option is available) and re-track the file

• Add behavior parameters (if option is available) to existing files that may 
have been recorded without them and apply them in the re-recording

• Modify existing tracking or behavior parameters (if option is available) and 
re-record

• Modify existing tracking or behavior parameters (if option is available) and 
allow digital outputs to occur for testing of experimental setups - note that the 
digital output capability must be installed on the computer for actual electri-
cal signals to be sent

CinePlex Studio operating settings can be taken from:

• Existing settings files saved in online mode

• Existing settings files saved in offline mode

• Settings data contained within the AVI files themselves
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• New settings made by the user while analyzing the video file(s)

• Modifications made to settings from any of the sources above

2.11.3 Offline Functionality

Most offline functionality is only marginally different from its online equivalent. 
The major exception is that the optional tracking and behavior functionality 
against a recorded file will be slightly different than that against live video. This 
is because the compression techniques used to create AVI files of manageable 
size inherently discard some of the data that was present in the original, i.e. they 
are “lossy” compression techniques. In particular, some color, details, and bright-
ness information is compromised. Normally the differences are not visible to the 
naked eye, but they will cause slight differences in the sensitive algorithms used 
for tracking and behavior analysis.

Sending tracking data to the MAP Sort Client is not enabled and does not occur in 
offline mode because there are no camera triggers and no neural data to synchro-
nize with. In addition, Sort Client may not even be installed on the computer 
where the offline analysis is being done.

Differences in the user interface are described below:

• Global Config Pane - The frame rate shown is that of the source files 
selected. Other sections are unchanged.

• Source Pane(s) - Most Camera adjustments are replaced with a file selection 
browsing tool. In their places are simple adjustments for brightness and con-
trast. Other sections are unchanged.

• Messages Pane - No differences.

• Tracking Panes (if tracking option is available) - No differences.

• Areas Pane(s) (if tracking option is available) - No differences.
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• Sequences Pane(s) (if behavior option is available) - No differences.

• Events Pane(s) (if behavior option is available) - No differences.

• Combination Event Pane(s) (if behavior option is available) - No differ-
ences.

• Event Statistics Pane (if behavior option is available) - No differences.
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2.12 Importing and Analyzing Position Data with NeuroExplorer

NeuroExplorer is a neurophysiological data analysis package that can be used to 
analyze data files offline, or it can be used in real-time with a Plexon NDAQ. For 
more information on NeuroExplorer, see http://www.plexoninc.com/NEX.htm. 

The user may import and analyze the X, Y position data in PLX files with Neu-
roExplorer (NEX), Version 3.088 or later. NEX converts the strobed digital posi-
tion data into continuous X and Y position variables, which can be used in NEX 
Place Cell Analysis, etc. For more information on position variables, refer to the 
NeuroExplorer Version 3.0 User Manual and Reference, or a later version.

The following illustration shows the strobed position data and the continuous X, 
Y position variables in the Nex 1-D Viewer.

http://www.plexoninc.com/NEX.htm
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2.13 CinePlex Studio Test Mode

Test mode is provided to enable the experimenter to verify operation of the video 
portion of their experimental setup without having to activate and connect the 
MAP, prepare animals for recording, connect preamplifiers, etc. The license keys 
normally required must be present on the computer.

When CinePlex Studio starts, it checks for the presence of the Access IO board. If 
the AccessIO board is present, Studio checks for the clock signal from the MAP.

If the AccessIO board is not present or if there is no clock signal from the MAP, 
the following message displays if one or more cameras are detected. Otherwise 
Studio opens in File mode without showing the message.

Click Yes to enter Test mode or No to enter File mode. The Test mode main win-
dow is shown below.
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Test mode has several restrictions compared to the normal mode:

• CPX switches cameras to free-running mode (using their internal trigger), 
since there is no external trigger available.

• “Arm” button is disabled, since it’s impossible to sync with MAP without the 
clock.

• Recording can be done as local ones only.

• Duration of each recording is restricted by 1 min.
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2.14 Operation with the Quad MAP Controller

The Quad MAP Controller (QMC) will synchronize the operation of two, three, 
or four MAP systems together with their associated CinePlex systems.

Procedure for Quad MAP Controller Operation

1 Each of the MAP/CinePlex combination systems should be tested and 
validated to be operational in stand-alone mode before attempting to connect 
them for synchronized use with the QMC. If this has not been done for each of 
the systems, please do so now. Then power all components of all systems 
down.

2 Select one MAP system to be the “Master” MAP system. Signals from the 
master MAP system will control all of the connected CPX systems and will 
provide power to the Quad MAP Controller.

3 Configure the TIM board of the master MAP system to supply power to the 
Quad MAP Controller. Apply a jumper at the position marked “17” and “+5V” 
on jumper block W3 as shown.

Startup
The startup sequence is extremely important. RASPUTIN must be 
started before Studio is started so that the client registration process 
works properly. Otherwise, when a recording is eventually started by 
RASPUTIN neither the file name string nor the recording time 0 mes-
sages are received.

If RASPUTIN exits or is closed for any reason, it should be brought 
back up, then Studio should be closed and restarted, as well.



2  

108  CinePlex

4 Connect a TIM cable adaptor (01-01-A-06) to the 34-pin connector on the 
master MAP TIM board as shown.

5 Connect the lower connector (marked “TO CPX”) on the TIM cable adaptor to 
the connector marked CPX CTRL IN on the QMC using a universal TIM cable 
(06-19-A-01).
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6 Connect a push button switch (09-40-A-01) to the BUTTON input of the Quad 
MAP Controller using a standard BNC cable.

7 Connect the START BNCs on the QMC to the XS2 BNC on the TIM board of 
each MAP system using equal length BNCs.

8 Connect the CLK OUT BNCs on the QMC to the CLK BNC on the TIM board 
of each MAP system using equal length BNC cables.

9 (Optional) Connect the DIGITAL INPUT on the QMC to a behavioral control 
system. Use the same cable that would normally connect the behavioral 
control system directly to a MAP system. Connect the DIGITAL OUTPUT 
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connectors on the QMC to each MAP system using a 26-pin ribbon cable (06-
17-A-03).

10 (Optional) Connect the CPX CONTROL OUT connectors on the QMC to the 
TIMING connector on the Access IO adaptor (07-02-A-03) on each CPX unit 
using a universal TIM cable (06-19-A-01).

11 Turn on each computer, CPX, and MAP system.

Note: If the system has a cCPI expansion chassis, this must be turned on 
before the computer is turned on.

12 On each computer, launch the Server and Sort Client applications. Double-
click the Server and Sort Client desktop icons.

The Server and Sort Client windows open.
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13 In each Sort Client, click the “Start” button in the upper left hand corner of the 
screen.

Note: When recording using a QMC, pressing stop on the Master MAP Sort 
Client actually stops recording neural data on the Master MAP and 
video recording on all four copies of CinePlex Studio. Stop must be 
pressed on Sort Client on the other three MAPs individually to stop 
their neural data recordings.

14 In each Sort Client, go to DataFile, Options, Start and Stop. If using a 
behavioral control system to pause and unpause recording to disk, select the 
option “Use XS2 to start, user command to stop, external level to pause/
unpause”. If not using a behavioral control system to pause and unpause 
recording to disk, select the option “Use external sync 2 (XS2) to start and 
user command to stop”.
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15 On each CPX, launch and arm CPX.

16 In each Sort Client, select DataFile, Start Recording. The systems will go into 
a paused state. The status indicator at the bottom of the Sort Client screen will 
turn green but say “paused”.

17 Press the push button switch. If using a behavioral control system to pause 
and unpause recording to disk, the systems will stay in a paused state. There 
will be no change in the status of each system until an “unpause” event is 
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received from the behavioral control system. If not using a behavioral control 
system each MAP system will start recording to disk. The status indicator will 
no longer say “paused”.

18 To stop recording to disk, in each Sort Client, select DataFile, Stop Recording.
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2.15 Using the Extractor

This chapter contains information necessary for setting up and operating the 
CinePlex Extractor program. CinePlex Extractor is an offline tool that extracts 
desired static and dynamic data from a Plexon AVI file, placing it into Plexon 
Settings file format and/or formats suitable for use by database programs such as 
Microsoft SQL Server® or data processing tools such as Microsoft Excel®.

Static data in AVI files includes system information and settings data. Dynamic 
data includes positions, speeds, angles, and other computed information.

Before attempting to use the extractor, an AVI file must be loaded from which to 
extract the data.
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Using Extractor to extract data from AVI file

1 From the File menu select Extractor... or click the Extractor icon on the 
toolbar.

2 The Extractor dialog box opens.

3 The settings from the file may be extracted by clicking the Extract Settings 
button or a DVT file may be created by clicking the Make DVT 2.0 button.

4 To extract data drag and drop entries in the Available Data section to the 
Data to Extract section. The order of the entries in the Data to Extract 
section may be rearranged by dragging and dropping as the image below 
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illustrates. Note that the Marker 4 Coords entry has been moved to position 2 
in the Data to Extract section.

5 When ready to extract the data, click the Extract Data button.

6 If it is desired to stop the data extraction before the end of the file is reached, 
click the Stop button.

7 The data is extracted to a comma-delimited file (headings located in the first 
row in the order shown in the Data to Extract section of the dialog) as shown 
by the image below.
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3.1 Overview

This chapter contains detailed reference information about CinePlex Studio. Use 
this chapter to identify and locate information for menu items, toolbar buttons, 
dialog boxes, or windows. The information in this section generally flows by 
pane and by menu item from left to right across the main window.

3.2 Main Window

The default layout of the CinePlex Studio main window is shown below.

The CinePlex Studio main window is a configurable window. In default layout, 
it contains a status bar, the main menu, toolbars, and several other panes depend-
ing on options that are licensed: 

• Static Configuration pane containing up to five tabs for global configura-
tion, video source configuration, and tracking configuration

• Dynamic Configuration pane containing up to seven tabs for setting up are-
nas, zones, events, event sequences, and combination events.

• Video pane(s) - one per camera or source

• Messages pane

• Event Statistics pane for visualization of current state of defined events.

This section describes the status bar and the windows. Later sections describe the 
menus and toolbars.
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3.2.1 Static Configuration Pane

The Static Configuration pane contains the following:

• Global Configuration Tab - containing general settings for Studio

• Source Tab(s) - one or two tabs containing video source (camera or file) set-
tings

• Tracking Tab(s) - one or two tabs containing tracking mode settings

3.2.1.1 Global Configuration Tab

The Global Configuration tab contains general settings for CinePlex Studio. 
The image below shows sample Global Configuration settings.

The Global Configuration tab contains a File group, a Compression group, and 
an Experiment group of settings.

3.2.1.1.1 File Group. The File group contains the following settings:

• Rec Folder - this setting is the recording folder path

• Frame Rate - this setting is the recording rate in frames per second

• Speed - this setting is the playback speed

• Position (frames) - this setting indicates the current frame position in the file

3.2.1.1.2 Compression Group. The Compression group contains the following 
setting:

• Quality – This setting controls the quality of recorded video. The user may 
adjust this value from 1 (low image quality) to 10 (high image quality). Video 
recordings with lower image quality settings take up less disk space. The 
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default setting is 75. For more information on video quality setting versus file 
size, see “Digital Video Recorder AVI Format Files” on page 56.

3.2.1.1.3 Experiment Group. The Experiment group has the following settings:

• Average Speed for (s) - this setting specifies the time period  or window (in 
seconds) over which the average speed is calculated. This setting is used to 
minimize jitter in the calculation of average speed. If the setting is left at 0, 
the average speed calculations will vary widely (jitter). Thus, the setting 
needs to be greater than 0 and less than the amount of time the tracked object 
spends in the arena over which the average speed is calculated. Frame rate 
also affects the jitter, so if the frame rate is changed, the Average Speed for (s) 
would probably need to be changed as well.

Note: The average speed calcualted for different LEDs attached to the same tracked 
animal may not be exactly the same value event though this setting is opti-
mized. A small amount of jitter may still be present that affects the calculations.

• Animals in Area - this setting specifies whether a single or multiple animals 
are being tracked and has dropdown selectable values of Single and Multiple. 
This setting does not appear in Object Contour mode since there is only one 
animal being tracked.

3.2.1.2 Source Tab(s)

There are one or two Source tabs, each of which contains settings its video 
source (either camera or file). If the video source is a camera, the Source tab con-
tains a Camera group, a DVR group, and a Calibration group of settings. If the 
video source is a file, the Source tab contains a File group, a DVR group, and a 
Calibration group of settings. The image illustrates the Source tabs in File mode 
and Camera mode.

HINT
Viewing Image Quality
The Video window does not show the effect of the Image Quality 
setting. View the Video in CinePlex Editor or use the Video Library 
Preview function to see the effect.
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3.2.1.2.1 Camera Group. The Camera group displays when Studio is in Cam-
era mode and is common to all tracking modes. It does not display in File mode.

It contains the following settings:

• Auto Contrast – If the Auto Contrast checkbox is checked, the camera 
automatically controls the contrast and shutter speed. If the Auto Contrast 
checkbox is unchecked, the Contrast and Shutter settings will appear.

• Contrast – This control send commands to the camera to control the contrast 
in the video image. If the user clicks Auto Contrast, the camera automati-
cally controls the contrast and shutter speed and the Contrast and Shutter 
settings disappear. Otherwise, use the Contrast slider to manually set the 
contrast to a value between 0 and 255, resulting in a pleasing image.

• Shutter – This control sends commands to the camera to adjust the shutter 
speed. The shutter speed controls the length of time that a light-induced 
charge builds up at the camera CCD (Charge Coupled Device) sensor before 
the video cycle repeats for the next frame. The user may adjust the shutter 
speed from a slow speed of 2-5 (1/32nd of a second) to a high speed of 2-11(1/



3  

124     CinePlex

2048th of a second). Rapidly moving experimental subjects can appear 
blurred in the video. To reduce blurring increase the shutter speed. However, 
faster shutter speeds usually result in a darker image and are not as reliable in 
the LED mode. Compensate somewhat for the darker image by adjusting 
Brightness and Contrast. If the image is still too dark adjust the manual iris 
on the camera lens; see Step 3 on page B-10.

Note: When recording under fluorescent lights, use a normal 2-6 (1/64th of a 
second) shutter speed. Faster shutter speeds typically result in a 
flickering effect in the video as the CCD sensor exposure interval 
interacts with the normal flicker of fluorescent lights.

• Auto Brightness – If the user checks the Auto Brightness checkbox, the 
camera automatically controls the brightness. If the Auto Brightness check-
box is unchecked, the Brightness setting will appear.

• Brightness – This control send commands to the camera to control the bright-
ness of the video image. If the user clicks Auto Brightness, the camera auto-
matically controls the brightness and the Brightness setting disappears. 
Otherwise, use the Brightness slider to manually set the video image bright-
ness to a value between 0 and 255.

• Sharpness – This control sends commands to the camera to control the sharp-
ness of the image. The range of the Sharpness control is from 0 to 255. 
Adjust this control to achieve a pleasing image.

• Saturation – This control sends commands to the camera to control the color 
saturation. The color saturation determines the amount of color added to the 
image. The range of the Saturation control is from 0 to 255. Adjust the con-
trol so that colors are pleasing, but not excessive.

Note: Because Object Contour mode is monochrome, Saturation does not 
appear under Camera when Object Contour Tracker is enabled.

3.2.1.2.2 File Group. 

The File group is present in File mode but not in Camera mode. The File group 
contains the following settings:

• File Name - this setting contains the complete path and file name of the 
source file. The source file is selected from the Browse Folder button at the 
right side of the setting.

• Compression - this setting specifies the type of compression used for the file.
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• Brightness - this setting specifies the brightness of the Video pane. Values 
range from 0.1 to 5.0.

• Contrast - this setting specifies the contrast of the Video pane. Values range 
from 0.1 to 5.0.

3.2.1.2.3 DVR Group. 

The DVR group contains three main sections - Output section, File Name sec-
tion, and Timecode section.

Output Section

• AVI File – Click this control to generate a video file in AVI format. 

• DVT File – Click this control to generate a position data file in DVT format. 
DVT-format files are useful in standalone scenarios. For information on the 
DVT file format, see “Digital VideoTracker (DVT) Files” on page 156.

File Name Section

• In Video - this checkbox allows the user to specify if the filename appears in 
the video window. The Color Selection box allows the user to select the color 
of the text of the filename.

• Location - this dropdown allows the user to specify where the filename 
appears.

Timecode Section

• In Video – Checking this checkbox will make the timecode visible in the 
video. The color selection box allows the user to define the font color of the 
timecode display.
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• Location – This setting allows the user to determine where the timecode will 
display on the screen. Choices are upper left, lower left or upper right, lower 
right.

• Format – This setting allows the user to determine the format of the dis-
played timecode. Choices are HH:MM:SS.NNNN and SSSSS.NNNN.

3.2.1.2.4 Calibration Group. 

The Calibration group contains the following settings:

• Use Calibration - checking this checkbox causes Studio to use calibration

• Units - this setting (cm or in) specifies the calibration units

• Type - this setting indicates the number of calibration bars (One-Bar or Two-
Bar).

• Color - this setting indicates the color of the reference bar(s).

• Global Factor - this setting specifies the factor of global calibration. This set-
ting is present only if the Type setting is One-Bar.

• Reference Size - this setting is present once if the Type setting is One-Bar 
and twice if the Type setting is Two-Bar (one associated with the Horizontal 
Factor and one associated with the Vertical Factor). It contains two sub-set-
tings:

— Video (pixels) - this setting is the size of the reference bar in pixels.

— Actual (cm) or Actual (in) - this setting adjusts the actual size of the 
reference bar in centimeters or inches depending on the Units setting.

• Horizontal Factor - this setting contains the horizontal calibration value. 
There is a Reference Size section under Horizontal Factor.

• Vertical Factor - this setting contains the vertical calibration value. There is 
a Reference Size section under Vertical Factor.
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3.2.1.3 Tracking Tabs

One of three panes is displayed which corresponds to the tracking mode being 
used. The panes are the Object Contour Tracker tab, the LED Tracker pane, 
and the Color Markers pane. The three panes are shown in the diagram below.

Each pane consists of an upper group that has adjustments and settings particular 
to that tracking mode; together with a bottom group with visualization settings 
tailored for the mode.

3.2.1.3.1 Visualization Group. The Visualization group is common to all 
tracker modes. It is visible only after one of the tracking modes is selected.
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It contains the following settings:

• Track – Checking this item shows the animal’s trajectory and color selection.

• Track Portion – This allows the user to show the whole trajectory or the last 
“Point Count” points.

• Points to Show – This setting (from 30 to 300) indicates how many points to 
show in the trajectory when Track Portion is selected.

• Track Transparency – This setting determines the transparency of the trajec-
tory layer. The range of the Track Transparency control is 0.0 (opaque) to 
1.0 (transparent).

• Tracking Window – Checking this item shows the tracking window.

• Center of Gravity – Checking this item shows the center of gravity.

• Averaged Cen. Grav – Up to five markers may be selected under this setting, 
and Studio displays a marker to indicated the averaged center of gravity for 
the selected markers.

• Cent. Grav. Shape – This setting determines the shape that designates the 
center of gravity of the object.

• Cent. Grav. Size – This setting determines the size of the shape showing the 
center of gravity. The range of the control is from 10 to 100.

• Contour – Checking this item shows the contour of the found object-bound-
aries.

• Fill Contour – Checking this item fills the contour of the found object.

• Fill All Objects – Checking this item shows all objects (including parasite 
spots) in the current tracking window.

• Object Transparency – This setting determines the transparency of the con-
tour of the found object. The range of the Contour Transparency is from 0.0 
(opaque) to 1.0 (transparent).

3.2.1.4 Object Contour Tracker Pane

The following illustration shows the Object Contour Tracker group on the 
Object Contour Tracker pane for Object Contour mode:
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3.2.1.4.1 Object Contour Tracker Group. From the Tracker menu, if the user 
selects Object Contour, the Object Contour Tracker group appears in this 
area. The controls are as follows:

• Object vs. Background – This setting allows the user to select Dark on 
Bright or Bright on Dark. Dark on Bright means a dark object on a brighter 
background. Bright on Dark means a bright object on a darker background.

• Background Image – This setting allows the user to set a background image. 
A background image is a reference image containing no animal. To set a 
background image, click the Camera icon. When a background image has 
been captured and Use Background is checked, each video frame is com-
pared with the background image. The pixels that are different between the 
two images will be considered as the object. This option is recommended 
when the arena contains objects which are similar in contrast (color) to that of 
the animal to be tracked. Clicking the Eye icon after capturing an image will 
display the image in a modal window. Clicking the Scissors icon will clear 
the background image.

• Use Background – Check this option to use a captured background image. If 
Use Background is checked, Object vs. Background is disabled.

• Threshold – This setting selects all pixels that are darker (or brighter) than 
the threshold as target objects. This setting depends on the Object vs. Back-
ground setting.

• Close Contour – This setting is used to eliminate the artifact created by the 
cable crossing the animal’s body and splitting the image into two parts. It can 
also be helpful when tracking multiple-colored animals (e.g., hooded rats). 
Close Contour adds and then removes an n-pixel-width layer from the image, 
resulting in an object without the occluding cable. The range for the Close 
Contour control is 0 to 10.

• Detail Filter – This setting helps remove parasite objects and unwanted 
details from the animal body (for example, the tail). The setting erodes a layer 
of pixels from the object. The range for the Detail Filter control is 0 to 10.

Note: The other modes have a checkbox called Filter Details which will erode a layer 
of pixels (1 pixel thickness) from the object. The Detail Filter control allows the 
user to specify an erosion layer thickness of more than 1 pixel.

• Min Object Size – This setting determines the minimum area (in pixels) 
required for a blob to be identified as an object. The range for the Min Object 
Size control is 1 to 10,000.

• Motion Measure – Checking this item provides a measure of the object’s 
movement.
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3.2.1.4.2 Visualization Group. The Visualization group is common to all 
tracker modes. It is visible only after one of the tracking modes is selected.

It contains the following settings:

• Track – Checking this item shows the animal’s trajectory and color selection.

• Track Portion – This allows the user to show the whole trajectory or the last 
“Point Count” points.

• Points to Show – This setting (from 30 to 300) indicates how many points to 
show in the trajectory when Track Portion is selected.

• Track Transparency – This setting determines the transparency of the trajec-
tory layer. The range of the Track Transparency control is 0.0 (opaque) to 
1.0 (transparent).

• Tracking Window – Checking this item shows the tracking window.

• Center of Gravity – Checking this item shows the center of gravity.

• Averaged Cen. Grav – Up to five markers may be selected under this setting, 
and Studio displays a marker to indicated the averaged center of gravity for 
the selected markers.

• Cent. Grav. Shape – This setting determines the shape that designates the 
center of gravity of the object.

• Cent. Grav. Size – This setting determines the size of the shape showing the 
center of gravity. The range of the control is from 10 to 100.

• Contour – Checking this item shows the contour of the found object-bound-
aries.

• Fill Contour – Checking this item fills the contour of the found object.

• Fill All Objects – Checking this item shows all objects (including parasite 
spots) in the current tracking window.
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• Object Transparency – This setting determines the transparency of the con-
tour of the found object. The range of the Contour Transparency is from 0.0 
(opaque) to 1.0 (transparent).

3.2.1.4.3 Information Box. The Information box displays information about the 
selected area in the pane, similar to Windows Tool Tips. The following illustra-
tion shows a typical item that can appear in the Information box when the user 
moves the mouse pointer over items in a tracking pane:

3.2.1.5 LED Tracker Pane

The following illustration shows the LED Tracker group for the LED Tracker 
pane:

3.2.1.5.1 LED Tracker Group. From the Tracker menu, selecting LED dis-
plays this area. The LED area contains the following controls:

• Pure Colors – Checking this item forces tracking of pure R, B, and B colors. 
When checked colors 1-3 will be set to R, G, and B respectively and cannot be 
changed.

• Min Object Size – This setting determines the minimum area (in pixels) 
required for a blob to be identified as an object.

• Filter Details – Checking this item erodes a 1 pixel layer from the objects. 
This helps avoid parasite objects.

Note: Object Contour mode has a checkbox called Detail Filter which will erode a 
layer of pixels (with a thickness of more than 1) from the object.
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• Threshold – This setting selects pixels that are darker (brighter) than the 
threshold as target objects. The range for the Threshold control is 0 to 255.

• LED1, LED2, LED3 – These controls enable color tracking via the check 
boxes and set the color for up to three tracking channels. If Pure Color is not 
checked, clicking in a color bar allows dragging the cursor to the defined 
color. Left-click to select the color; right-click to exit color selection mode.

3.2.1.5.2 Visualization Group. The Visualization group is common to all 
tracker modes. It is visible only after one of the tracking modes is selected.

It contains the following settings:

• Track – Checking this item shows the animal’s trajectory and color selection.

• Track Portion – This allows the user to show the whole trajectory or the last 
“Point Count” points.

• Points to Show – This setting (from 30 to 300) indicates how many points to 
show in the trajectory when Track Portion is selected.

• Track Transparency – This setting determines the transparency of the trajec-
tory layer. The range of the Track Transparency control is 0.0 (opaque) to 
1.0 (transparent).

• Tracking Window – Checking this item shows the tracking window.

• Center of Gravity – Checking this item shows the center of gravity.

• Averaged Cen. Grav – Up to five markers may be selected under this setting, 
and Studio displays a marker to indicated the averaged center of gravity for 
the selected markers.

• Cent. Grav. Shape – This setting determines the shape that designates the 
center of gravity of the object.
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• Cent. Grav. Size – This setting determines the size of the shape showing the 
center of gravity. The range of the control is from 10 to 100.

• Contour – Checking this item shows the contour of the found object-bound-
aries.

• Fill Contour – Checking this item fills the contour of the found object.

• Fill All Objects – Checking this item shows all objects (including parasite 
spots) in the current tracking window.

• Object Transparency – This setting determines the transparency of the con-
tour of the found object. The range of the Contour Transparency is from 0.0 
(opaque) to 1.0 (transparent).

3.2.1.5.3 Information Box. The Information box displays information about the 
selected area in the pane, similar to Windows Tool Tips. The following illustra-
tion shows a typical item that can appear in the Information box when the user 
moves the mouse pointer over items in a tracking pane:
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3.2.1.6 Color Markers Tracker Pane

The following illustration shows the Settings window for Reflective Colors 
mode:

3.2.1.6.1 Reflective Colors Tracker Group.  From the Tracker menu, selecting 
Reflective Colors displays this area. It contains the following controls:

• Pure Colors – Checking this item forces tracking of pure R, B, and B colors. 
When checked colors 1-3 will be set to R, G, and B respectively and cannot be 
changed.

• Min Object Size – This setting determines the minimum area (in pixels) for a 
blob to be identified it as an object. The range for the Min Object Size control 
is 1 to 10,000.

• Filter Details – Checking this item erodes a 1 pixel layer from the objects. 
This helps avoid parasite objects.

Note: Object Contour mode has a checkbox called Detail Filter which will erode a 
layer of pixels (with a thickness of more than 1) from the object.

• Marker1, Marker2, Marker3, Marker4, Marker5 – These controls enable 
color tracking and color selection for up to five colors. If Pure Color is not 
checked, clicking in a color bar allows dragging the cursor to the desired pixel 
color in the image. Left-click selects the color; right-click exits color selec-
tion mode.
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• Mrk1Threshold, Mrk2Threshold, Mrk3Threshold, Mrk4Threshold, 
Mrk5Threshold – These controls allow the user to set the threshold level for 
their respective colors. These controls are normally hidden until their respec-
tive Marker checkboxes are checked. The range for the Threshold Color con-
trols is 0 to 255.

Each Marker control can be expanded by clicking on the “+” (plus) sign to the 
left. This allows selecting different visualization colors for the marked track, cen-
ter of gravity symbol, contour boundary, and fill color.

Each marker control has a PLX button to the right. Pushing this button causes the 
coordinates to the sent to the MAP for inclusion in the PLX file. Only three of the 
PLX buttons can be active simultaneously.

3.2.1.6.2 Visualization Group. The Visualization group is common to all 
tracker modes. It is visible only after one of the tracking modes is selected.

It contains the following settings:

• Track – Checking this item shows the animal’s trajectory and color selection.

• Track Portion – This allows the user to show the whole trajectory or the last 
“Point Count” points.

• Points to Show – This setting (from 30 to 300) indicates how many points to 
show in the trajectory when Track Portion is selected.

• Track Transparency – This setting determines the transparency of the trajec-
tory layer. The range of the Track Transparency control is 0.0 (opaque) to 
1.0 (transparent).

• Tracking Window – Checking this item shows the tracking window.

• Center of Gravity – Checking this item shows the center of gravity.
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• Averaged Cen. Grav – Up to five markers may be selected under this setting, 
and Studio displays a marker to indicated the averaged center of gravity for 
the selected markers.

• Cent. Grav. Shape – This setting determines the shape that designates the 
center of gravity of the object.

• Cent. Grav. Size – This setting determines the size of the shape showing the 
center of gravity. The range of the control is from 10 to 100.

• Contour – Checking this item shows the contour of the found object-bound-
aries.

• Fill Contour – Checking this item fills the contour of the found object.

• Fill All Objects – Checking this item shows all objects (including parasite 
spots) in the current tracking window.

• Object Transparency – This setting determines the transparency of the con-
tour of the found object. The range of the Contour Transparency is from 0.0 
(opaque) to 1.0 (transparent).

3.2.1.6.3 Information Box. The Information box displays information about the 
selected area in the pane, similar to Windows Tool Tips. The following illustra-
tion shows a typical item that can appear in the Information box when the user 
moves the mouse pointer over items in a tracking pane:
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3.2.2 Dynamic Configuration Pane

This pane consists of tabs for setting up a logical area (arenas and zones), 
sequences, events, and combination events.

3.2.2.1 Areas Tab(s)

The Areas tab allows the user to define an arena in which any tracking is to be 
performed and zones of interest within the arena.

The Areas tab contains a toolbar and may contain one or more settings groups. 
When an arena is added and when zones are added, settings groups are added to 
the display.

3.2.2.1.1 Toolbar. The toolbar has buttons for adding arenas, static zones, and 
dynamic zones, for deleting arenas and/or zones, for adding shapes (circle, 
ellipse, rectangle, and polygon), and for performing logical operations on shapes.
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The toolbar buttons are as follows:

• Add arena -  - this button adds an arena to the Areas tab.

• Add static zone to current arena -  - this button adds a static zone to 
the current arena.

• Add dynamic zone to current arena -  - this button adds a dynamic 
zone to the current arena

• Delete arena or zone -  - this button deletes the currently selected zone 
or arena

• Draw circle -  - this button draws a circle.

• Draw ellipse -  - this button draws an ellipse.

• Draw rectangle -  - this button draws a rectangle.

• Draw polygon -  - this button draws a polygon.

• Union shapes -  - this button performs a UNION operation on shapes. 
The result contains every point that is in either shape. Mathematically, this 
may be represented by AB.

• Intersect shapes -  - this button performs an INTERSECTION opera-
tion on shapes. The result contains every point that is found in both shapes. 
Mathematically, this may be represented by AB
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• Subtract shapes -  - this button performs a SYMMETRIC DIFFER-
ENCE operation on the shapes. The result contains that is found in the first 
shape but not in the second shape. Mathematically, this may be represented 
by AB.

• XOR shapes -  - this button performs an EXCLUSIVE-OR operation 
on the shapes. The result contains every point that is in one shape or the other 
but not both. Mathematically, this may be represented by AB.

3.2.2.1.2 Arena Group. The Arena group of settings is added when the user 
clicks the Add arena button.

• Name –  this setting contains the name of the arena.

• Outline – If this checkbox is checked the outline of the area will be displayed 
using the color of the color selection box.

• Color Selection Box – Selecting a color in this control sets the color of the 
outline of the area.

Note: Checking the Area Outline checkbox requires that an area be drawn before 
tracking will work.

• Fill –  to visualize the current active area within the area by filling it.

• Transparency – This setting controls the transparency of the arena. The 
range for the control is 0.0 to 1.0.

• Shapes – This setting indicates how many shapes have been added to the 
arena. If one or more shapes have been added, the setting is expandable to 
display the shapes.

• Number of Zones – This setting indicates the number of zones that have 
been added to the arena. If one or more zones have been added, each zone’s 
settings group displays below the Arena group.

An area can contain multiple shapes. To start drawing an arena, activate the arena 
toolbar by clicking one of the arena nodes - Area Outline or Area Transpar-
ency.
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Part of an area can be moved by highlighting the shape description, placing the 
cursor inside of the arena and dragging it to the desired location.

An area can be deleted by highlighting the shape description, placing the cursor 
inside of the arena, selecting it, and pressing Delete. Alternatively, a right-click 
will bring up a small menu from which Delete Area can be selected.

The first shape is always OR’d into the video. Successive shapes can be added 
logically to the existing composite shape by selecting the operation desired first 
(Union, Intersect, Subtract, XOR) then selecting the next shape and drawing it 
inside the video.

3.2.2.2 Sequences Tab(s)

A Sequences tab contains a toolbar and one or more Sequence settings groups. 
The image below show the Sequences tab.

3.2.2.2.1 Toolbar. The toolbar has buttons for adding and deleting sequences and 
adding and deleting zones.

The toolbar buttons are as follows:

• Add new sequence -  - this button adds a new sequence group to the 
pane.

• Delete sequence -  - this button deletes the selected sequence from the 
pane.
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• Add zone to selected sequence -  - this button adds a zone to the 
selected sequence group.

• Delete zone from selected sequence -  - this button deletes the 
selected zone from the selected sequence.

3.2.2.2.2 Sequence Group. Each Sequence group has the following settings:

• Name - the name of the sequence

• Zones - the number of zones contained in the sequence. When a zone is added 
to the sequence, a sub-setting appears under Zones. 

— Zone X - this setting contains the name of the zone selectable from a 
dropdown list.The X refers to the number of the zone.
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3.2.2.3 Events Tab(s)

The image below shows the one of the Events tabs. The Events tab contains a 
toolbar and one or more groups of Event settings.

3.2.2.3.1 Toolbar. The toolbar has buttons for adding and deleting events.

The toolbar buttons are as follows:

• Add new tracking event -  - this button adds a new Event group to the 
pane.
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• Delete selected tracking event -  - this button deletes the selected 
event from the pane.

3.2.2.3.2 Event Group. There are two events in the image shown, and each event 
has several settings:

• Name - the name of the event

• Color - the color of the event

• Target - the type of target (Zone, Sequence, Speed, Head Direction). Target 
will have sub-settings based on the target type selected in the dropdown:

— Zone Sub-settings

– Zone - dropdown selectable values of zone names

– Condition - dropdown selectable values of Entering Zone and 
Leaving Zone.

Note: There is a small delay (dwell time) between the occurrence of the zone event 
and its condition going to the TRUE state. However, when the zone event is fin-
ished, the event condition will go FALSE immediately (in the first video frame 
following the end of the event).

— Sequence Sub-settings

– Sequence - dropdown selectable values of sequence names

— Speed Sub-settings 

– Value Threshold (pixel(s)) -  this setting determines the speed 
threshold. If the instantaneous speed of the object is lower or higher 
(determined by the Condition setting) than this setting during a 
period of time set by the Time Threshold setting, the event is con-
sidered to have occurred. The range of values is from 0 to 1000.

Note: There is a small delay (dwell time) between the occurrence of the speed event 
and its condition going to the TRUE state. However, when the speed event is 
finished, the event condition will go FALSE immediately (in the first video frame 
following the end of the event).

– Time Threshold(s) - this setting (in seconds) works with the Value 
Threshold setting and the Condition setting to determine if the 
event occurs. The range of values is from 0.0 to 10.0.

– Condition - dropdown selectable values of Higher than value 
threshold and Less than value threshold.

— Head Direction Sub-settings 

– Value Threshold (grad.) - the event is considered to have occurred 
if the head direction angle is higher or lower (determined by the 
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Condition setting) than the Value Threshold setting during the 
period of time set by the Time Threshold setting.

– Point 1 - this setting indicates point 1 of the head direction vector. 
This setting is dropdown selectable.

– Point 2 - this setting indicates point 2 of the head direction vector. 
This setting is dropdown selectable.

– Time Threshold - this setting is the time in seconds that determine 
occurrence of the event in conjunction with the Value Threshold 
setting and the Condition setting.

– Condition - dropdown selectable values of Higher than value 
threshold and Less than value threshold

• Object - (only present in LED and Reflective Colors tracking modes) con-
tains how tracking is done. Selections include Averaged Cent. Grav. (aver-
aged center of gravity) and Position of Object.

• Available Objects (only present in LED and Reflective Colors tracking 
modes) contains an object selectable from dropdown list

• Output Line # - dropdown selectable values for output line, if any

• Signal Type - dropdown selectable values of Pulse, Low, or High

• Pulse Duration(s) - (only present if Signal Type is Pulse) dropdown select-
able values of 0.1, 0.2, 0.5, 1.0, 2.0, and 5.0.

3.2.2.4 Combination Events Tab

The image below shows the Combination Events tab. The Combination Events 
tab contains a toolbar and one or more groups of Combination Event settings.
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3.2.2.4.1 Toolbar. The toolbar contains buttons for adding and deleting combina-
tion events.

The toolbar buttons are as follows:

• Add new combination of tracking events -  - this button adds a new  
Combination Event group to the pane.

• Delete combination of tracking events -  - this button deletes the 
selected Combination Event group from the pane.

3.2.2.4.2 Combination Event Group. The Combination Event group has the 
following settings:

• Name - the name of the combination event

• Color - the color of the combination event

• Operation - dropdown selectable values of AND, OR, NOT, and XOR

• Event1 - dropdown selectable name of event 1.

• Event2 - dropdown selectable name of event 2

• Formula - formula associated with the combination event



Version 3.0 146

• Output Line # - dropdown selectable output line number, if any

• Signal Type - dropdown selectable values of Pulse, Low, or High

• Pulse Duration(s) - (only present if Signal Type is Pulse) dropdown select-
able values of 0.1, 0.2, 0.5, 1.0, 2.0, and 5.0.

3.2.2.5 Detection Latency

The time elapsed from the actual occurrence of an event occurs and when the 
event is detected in the video is called detection latency. Detection latency is 
determined by the user settings of frame rate, shutter open time, and detection 
threshold.

3.2.2.6 Processing Latency

Processing latency is the time between the time the shutter closes on a frame in 
which the event can be detected and the time the dependent output line is toggled. 
Processing latency in current configuration of CinePlex systems is 13 to 14 milli-
seconds. The worst case is when an event occurs during a shutter open time, but 
is not detectable by CinePlex until the next frame due to high detection thresh-
olds. For these reasons, when digital outputs are needed for an experiment, shut-
ter time and frame rate should be set to the maximum usable while detection 
thresholds should be set as low as possible.

3.2.2.7 Total Event Latency

Total event latency is the time between when an event occurs and when its depen-
dent digital output is generated. Thus, total event latency consists of detection 
latency and processing latency.

3.2.3 Video Pane(s)

There may be up to two Video panes visible. The default setting is to have the 
Video 1 pane visible. The Video pane(s) displays the video image(s) from the 
camera(s). The user may optionally stretch the image to fill the size of the Video 
pane(s).
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Note: The effects of the Image Quality setting cannot be seen in the Video window; 
the user must view the AVI file to see that effect.

Right-clicking the mouse in the Video window displays the Video Right-click 
menu if there is an active arena for the video even though it may not be visible.

• Delete Arena - Clicking this item deletes the arena. This item is grayed out 
unless an arena is active. Delete the arena by selecting it and pressing the 
Delete key.

• Clear Trajectory - Clicking this item clears the trajectory.

3.2.4 Messages Pane

The Messages window displays CinePlex Studio system messages.

The Messages window displays the timestamp, message code, and description of 
each message. Right-clicking the mouse in the Messages window displays the 
Messages Right-click menu.

• Erase - Clicking this item erases all of the messages in the Messages win-
dow.

• Pause - Clicking this item pauses the display of messages. Clicking again 
resumes the display.

• Show Debug Messages - Clicking this item toggles the display of debug 
messages. If checked, debug messages will be shown. If not checked, debug 
messages will not be shown.
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• Select and Copy All - Clicking this item selects all of the messages and 
copies them to the clipboard.

• Save Log to File - Clicking this item opens a standard windows File Save 
dialog box so that the messages may be saved to a user-named file.

• Mail Log to Plexon - Clicking this item attaches the message log to an E-
mail message that can be sent to Plexon for troubleshooting.

Note: This feature will work only if an E-mail client is installed on the computer.

3.2.5 Event Statistics Pane

This pane contains statistics on events and combination events.

The statistics displayed are as follows:

• No. - this value is the number of the event or combination. event

• Event Name - this value is the name of the event or combination event.

• Target - this statistic has two sub-statistics:

— Type - this value depends on what the given line represents - an event 
or an combination event. Type will use the Target setting from an 
event or the Operation setting from an combination event.

– Event (Target = Zone) - if the Zone sub-setting in the Event pane 
is N/A, then Type will be Zone. If the Zone sub-setting is a zone, 
then Type will be Zone xyz where xyz is the zone number.

– Event (Target = Sequence) - if the Sequence sub-setting in the 
Event pane is N/A, then Type will be Sequence. If the Sequence 
sub-setting is a sequence, then Type will be Sequence xyz where 
xyz is the sequence number.

– Event (Target = Speed) - this value will be the Value Threshold 
(pixel(s)) setting from the Event pane.

– Event (Target = Head Position) - this value will be the Value 
Threshold (grad.) setting from the Event pane.

– Combination Event - this value will be the Operation setting 
from the Combination Events pane.
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— Name - this value depends on what the given line represents - an event 
or an combination event. For an event, the Name setting will either be 
N/A, the zone name if the Target setting is Zone, the sequence name if 
the Target setting is Sequence, or 0.0 for Target settings of Speed and 
Head Direction. For an combination event, the Name setting will be 
N/A.

• Object - this value will be the Available Objects setting from the Event 
pane.

• Output - this value indicates output line number, if any output lines are used

• Count - this value represents how many time the event has occurred.

• Time, s - this statistic has two values; Last and Cumulative. The Last value 
is the duration in seconds the last time the event occurred. The Cumulative 
value is the total duration in seconds of every occurrence of the event.

• Track Length, pixel - this statistic has two values; Last and Cumulative. 
The Last value is the length of the track in pixels the last time the event 
occurred. The Cumulative value is the total length in pixels of all the tracks 
of the event.

3.2.6 Status Bar

The status bar at the bottom of the screen shows the capture file information, 
remote line status, the camera frame rate, and camera noise figures. Descriptions 
of the status bar items follows.

3.2.6.1 Capture Information

The information that appears in the status bar depends on state of the video 
recorder. If CinePlex Studio is armed, the status bar flashes yellow and displays 
the name of the video AVI file to create for the video that will be captured. 

When CinePlex Studio records, the status bar turns green and displays the name 
of the video AVI file, the time recorded thus far, and the time remaining. 

If recording is paused, the status bar flashes green.

3.2.6.2 Status Information

The right end of the status bar contains the following status information:
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• Ratio - Appears only during a recording (Noise Figure below displays here 
when not recording). A fraction showing the count of frames delayed 10% or 
more as the numerator and the count of missing frames as the denominator. 
Delayed frame counts should be in the range of one to two per hour of record-
ing. There should be no dropped frames. This box will turn red if any frames 
are dropped. Excessive counts in the first position and count > 0 in the second 
position indicate there is too much other activity on the Capture computer. 
Exit any non-essential processes or programs. If the problem persists, contact 
Plexon Support.

• Camera Frame Rate - The camera frame rate panel displays the average 
frame rate of the camera. The nominal value should be within 0.1 of the rate 
selected.

Note: If the camera frame rate area flashes red, CinePlex Studio is either not receiv-
ing a clock signal or the clock signal is the wrong frequency.

• Noise Figure - The camera noise figure (RMS value) displays when not 
recording. It is found in the area that also displays the Ratio. When recording 
starts the area displays the Ratio instead of the Noise Figure.
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3.3 Menus

The CinePlex Studio File menu is shown below. Each menu is described in more 
detail. 

3.3.1 File Menu

3.3.1.1 Save Settings

This item allows the user to save the configuration settings [and name the file if a 
keyboard is connected]. Clicking this item will open the standard File Save dia-
log box.

3.3.1.2 Load Settings

This item loads previously saved configuration settings. Clicking this item will 
open the standard File Open dialog box.
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3.3.1.3 Restore Factory Settings

This item sets all software and camera settings to their factory default values.

3.3.1.4 Extractor (File Mode only)

This item brings up the Extractor dialog box which allows the user to extract 
desired static and dynamic data from a Plexon AVI file, placing it into Plexon 
Settings file format and/or formats suitable for use by database programs. For 
additional details, see “Using the Extractor” on page 115.

3.3.1.5 Exit

This item closes the application.

3.3.2 View Menu

Panes or tabs can be opened by selecting them in this menu. Clicking the Close 
button (x) in the upper right corner closes them. If windows and/or panes are 
messed up, go to Window Menu/Layout/Reset to Default Layout to return to a 
good state.
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3.3.3 DVR Menu

3.3.3.1 Arm

Clicking this item arms CinePlex Studio to accept a remote record command 
from the MAP system or other external hardware.

3.3.3.2 Record

Clicking this item starts manual recording. 

3.3.3.3 Pause

Clicking this item pauses and resumes manual recording. This function only 
appears once manual recording has started.

3.3.3.4 Stop

Clicking this item stops manual recording and closes the recorded file. 

3.3.4 Tracker Menu

3.3.4.1 Object Contour

Clicking this item sets the tracker mode to Object Contour.

3.3.4.2 LED

Clicking this item sets the tracker mode to LED.

3.3.4.3 Reflective Colors

Clicking this item sets the tracker mode to Reflective Colors.

3.3.5 Window Menu

The Window menu is a standard menu of the Plexon User Interface. For more 
details, see “Window Menu” on page 11.
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3.3.6 Help Menu

The Help menu is a standard menu of the Plexon User Interface. For more 
details, see “Help Menu” on page 13.

3.3.7 Shrink

Clicking the Shrink menu item saves the current layout to a file and reduces the 
user interface to a single small window showing the video as shown in the dia-
gram below. To restore the previous layout, click Expand and the layout previ-
ously saved by clicking the Shrink menu item is loaded and displayed. If there 
are some wrong settings preventing the Arm and Rec buttons to be enabled, the 
Shrink button is disabled as well. The Shrink mode can be useful when more vis-
ibility is desired for other applications, e.g. Sort Client for the Plexon MAP.
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3.4 Toolbars 

The File, DVR and Tracker menus may all be displayed as toolbars as desired 
(see “Menus” on page 3 for more details). The buttons from left to right on each 
tool equate to the menu commands from top to bottom on the corresponding 
menu.

3.4.1 File Toolbar

The File toolbar contains buttons that are equivalent to the File menu commands. 
For more details, see “File Menu” on page 151.

3.4.2 DVR Toolbar

The DVR toolbar contains buttons that are equivalent to the DVR menu com-
mands. For more details, see “DVR Menu” on page 153.

3.4.3 Tracker Toolbar

The Tracker toolbar contains buttons that are equivalent to the Tracker menu 
commands. For more details, see “Tracker Menu” on page 153.
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3.5 Digital VideoTracker (DVT) Files

A Digital VideoTracker (DVT) file contains timestamp and tracking information 
for an audio video interleave (AVI) format recording. The DVT file is a text file 
where each line contains position data for a video frame. An example of a DVT 
file for LED mode follows:

1,0.033000,910,35,110,366,19,247

2,0.066000,915,37,112,366,19,247

3,0.099000,927,38,112,366,19,247

…

The format of each line depends on the selected tracker mode. The first column in 
the DVT file is the row number, not the frame number. These can become 
unsynched when recording is paused.

3.5.1 Object Contour Mode

For Object Contour mode, the format of each line is:

row,time,x,y,m

where:

• row is the row number

• time is the time of the frame in seconds

• x and y is the track position of the target centroid

• m indicates the motion measure value; see “Motion Measure Option” on 
page 81

3.5.2 LED Mode

For LED mode, the format of each line is:

row,time,x1,y1,x2,y2,x3,y3

where:

• row is the row number

• time is the time of the frame in seconds

• x1 and y1 is the track position of color #1 

• x2 and y2 is the track position of color #2 

• x3 and y3 is the track position of color #3 

3.5.3 Reflective Colors Mode

For Reflective Colors mode, the format of each line is:
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row,time,x1,y1,x2,y2,x3,y3,x4,y4,x5,y5

where:

• row is the row number

• time is the time of the frame in seconds

• x1 and y1 is the track position of color #1 

• x2 and y2 is the track position of color #2 

• x3 and y3 is the track position of color #3 

• x4 and y4 is the track position of color #4 

• x5 and y5 is the track position of color #5

3.5.4 Conversion of DVT Coordinates to Pixels

To convert DVT coordinates to pixels, multiply each coordinate by 639/1023.:

:

xpixels xcoordinate 639
1023

-----------------------------------------------=

ypixels ycoordinate 639
1023

-----------------------------------------------=
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3.6 Using Studio in File Mode

3.6.1 Default Mode

When CinePlex Studio starts it will default to camera mode, file mode, or it will 
give the user a choice depending on the conditions that Studio detects. The table 
below lists the various conditions and the default mode for Studio.

Note: When the clock is not detected, camera(s) is (are)) detected, and a RASPUTIN 
key is detected, Studio will display a dialog box to allow the user to decide on 
the mode.

If Studio defaults to Camera mode, the user still has the option of switching to 
File mode manually if desired.

3.6.2 Manual Selection of File Mode

From the Video Source dropdown on the toolbar, select One File or Two Files to 
enter offline mode.

Table 1: CinePlex Studio Default Mode

Camera(s) Detected
RASPUTIN Key 

Detected
Clock Detected Default Mode

No No No File

No No Yes File

No Yes No File

No Yes Yes File

Yes No No File

Yes No Yes File

Yes Yes No User Choice (see 
note)

Yes Yes Yes Camera
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3.6.3 Source Settings

The Source settings are different depending on whether Studio is in offline mode 
or not.

Note: The image on the left (Camera mode) has a Camera section (AVT Stingray) 
and the image on the right (File mode) has a File section.

3.6.4 Dynamic and Static Data

Dynamic and static data may be extracted from an AVI file and used. To do this a 
file must be loaded using the Browse Folder icon in the File Name setting of the 
File section of a Source tab. Then use the Extractor to extract the desired data. 
See “Using the Extractor” on page 115 for more details.

3.6.5 Arenas, Zones, Sequences, Combination Events, and Re-recording

After a CinePlex version 3 file has been loaded, the arenas, zones, sequences, and 
combination events in the file may be edited using the procedures given in Chap-
ter 2, and then the file may be re-recorded.

WARNING
The color of an object is changed when it moves into the area cov-
ered by the background of an inserted file name and/or time stamp. 
This will result in tracking problems in that area when doing file mode 
tracking.
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4.1 Understanding CinePlex Editor Files

Although it can be used to work with single files, CinePlex Editor is typically 
used with a pair of data files recorded in the lab—a video file and a neural data 
file. To use CinePlex Editor successfully, it is important to understand how 
CinePlex Editor works with files. This section describes what happens to the 
various files when creating a CinePlex project, importing data, editing informa-
tion, saving a project, re-opening a project file, and exporting data.

Note: When using an AVI file and a DVT file, the system uses the timestamps from 
the DVT file.

Note: When using an AVI file and a PLX file, the system uses the timestamps from 
the AVI file.

When starting CinePlex Editor for the first time, it prompts for a separate file to 
store project information. This CinePlex project (CPJ) file can include the follow-
ing items:

• File references: locations and names of the neural data file and the video file

• Marker definitions, which includes the marker type, name, and any zone or 
level definitions as appropriate

Note: Markers are a type of indicator or identifier. Marker occurrences are place-
ments of particular markers in a file. For more information on markers, see 
“Digital VideoTracker (DVT) Files” on page 156.

• Information for each marker occurrence

4.1.1 Creating a Project File

Normally the first step is to create a CinePlex Project file. To create a project file 
the user must specify the neural data file, which is usually either a PLX or a NEX 
file (although it can be a DVT file), and the associated AVI video file. The New 
Project Wizard can step through this process; see “Setting Up a New Project” on 
page 165. After these files are specified, their file names are stored in the CPJ 
file, and the initial import of data into the project begins. 

Note: A CinePlex Project file can accommodate only one pair of data files—usually a 
neural data file and a video file.

4.1.2 Importing Data Files

During the initial import of the neural and video data into a project, CinePlex 
Editor creates markers and marker occurrences based on the contents of the neu-
ral data and video files. From the neural data file, CinePlex Editor translates any 
events (for example, Type 4 data from PLX files) or appropriate NEX variables 
(event, marker, or interval) into markers and marker occurrences. From the video 
file, CinePlex Editor creates a Frame marker and creates occurrences for the 
timestamps of each video frame. However, CinePlex Editor does not store neu-
ral data, continuous data, or the video frame images in the CPJ file.
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4.1.3 Changing and Saving Project Files

After importing the marker information from the data files into CinePlex Editor 
and it is in the form of marker occurrences, the user may edit, extend, or even 
delete the information; then the user may save the changes to a CPJ file. When 
saving the CPJ file, CinePlex Editor also saves any new marker information that 
it creates into the CPJ file. Thus, when re-loading a CPJ file, CinePlex Editor 
completely restores the markers and marker occurrences that were present when 
the CPJ file was saved.

4.1.4 Reopening Project Files

When subsequently re-opening a CPJ file, CinePlex Editor gets the marker data 
exclusively from the CPJ file; CinePlex Editor does not re-import the markers 
from the neural data or video files. However, CinePlex Editor does open the 
original neural data and video files and reads them to get the neural spike data, 
continuous data, and video images. 

Note: If the user moves the original neural data or video files to another location on 
the hard drive, CinePlex Editor prompts to locate the files when re-opening the 
project file.

4.1.5 Exporting Files

Although CPJ files cannot currently be used by any software other than CinePlex 
Editor, the user may export all of the data stored in CPJ files into other formats, 
such as PLX or NEX data files, text files, MATLAB files, or Excel spreadsheets.
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4.2 Getting Started

This section describes a quick-start example to provide familiarization with 
CinePlex Editor. The screens, views, and operations mentioned in the quick-start 
procedure appear in much greater detail in the reference chapter; see Chapter 5, 
CinePlex Editor Reference.

4.2.1 Using the Quick Start Files

This quick-start example uses two sample data files that do not install with Cine-
Plex Editor: CM_Quickstart.plx and CM_Quickstart.avi. Because these two files 
are very large, they are located in the Quickstart folder on the CinePlex installa-
tion CD. As an alternative, instead of using CM_Quickstart.plx and 
CM_Quickstart.avi, the user may use any video data file (AVI) collected with 
CinePlex Studio together with a neural data file (PLX, NEX, DVT) collected by 
a tool such as Recorder or MAP. Before using the quick-start sample files, 
Plexon recommends copying them to the local disk on the computer to improve 
performance.

The quick-start example consists of the following series of procedures:

• 4.2.2 Setting Up a New Project 

• 4.2.3 Understanding the CinePlex Editor Main View

• 4.2.4 Defining a New Marker

• 4.2.5 Creating Marker Occurrences

• 4.2.6 Saving and Exporting the Data

• 4.2.7 Re-opening a Project File
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4.2.2 Setting Up a New Project

This procedure covers the steps required to set up a new project. 

1 Click the CinePlex Editor desktop icon or click CinePlex Editor on the 
Windows Start menu. The Welcome To CinePlex Editor dialog box opens.

Note: The Welcome to CinePlex Editor dialog box provides a quick way to 
start a new project, load an existing project file, or load a recently-
used project file. The first time CinePlex Editor runs, CPJ files do not 
appear in the list box and Open the Selected Recent CinePlex 
Project is unavailable. 

2 Click Start a New CinePlex Project, which starts the New Project Wizard, 
which is a series of dialog boxes that guide the user through the process of 
setting up a new project. The New Project Wizard opens.
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3 In the Video Data Input File (AVI) area, click Browse, go to the directory 
where the quick-start files are stored and locate CM_Quickstart.avi. Open the 
file. The New Project Wizard changes all the file names to match.

Note: When the user enters a name in the Video Data Input File (AVI) box, 
the Neural Data Input File (PLX, NEX, DVT) and CinePlex Project 
File (CPJ) boxes change to reflect the name entered. This is a typical 
example of the helpful behavior of CinePlex Editor, which suggests 
file names. 

Note: For use with CinePlex, AVI files must be saved in Motion JPEG 
(MJPG) video compression format. If the user attempts to open an 
AVI file that is not in MJPG format, a notification dialog box appears:

4 For this quick-start procedure, accept the suggested names and click 
Continue. The Verify Project Files dialog box opens, which contains some 
basic information to allow verification of the selected files.

5 If the file information is correct, click Continue.

The initial import operations begin; CinePlex Editor creates the CPJ file and 
opens the CinePlex Editor main view.
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4.2.3 Understanding the CinePlex Editor Main View

This procedure covers the steps required to set up and control the CinePlex Edi-
tor main view. 

1 When the CinePlex Editor main view appears, click the maximize button in the 
Windows title bar to maximize the CinePlex Editor window. 

Note: CinePlex Editor is easier to set up and use when its screen area is 
maximized.

2 Rearrange the windows within the CinePlex Editor main window to look 
something like the following illustration:

The first frame of the video file appears in the Video window at the upper-
right. Because the CM_QuickStart neural and video data files were recorded 
using CinePlex Studio with the Tracking option enabled, CinePlex Editor 
imports the tracking coordinates from the neural data file, and they appear as 
crosshairs superimposed over the video.

The neural data appears in the Activity window at the bottom, which shows 
the neural activity at the beginning of the file. Each row in the Activity window 
represents either a marker or a channel of data. The marker occurrence times 
and neural firing times for each channel appear as tick marks in the view. The 
user may color code the ticks as appropriate for the marker type and unit des-
ignation; for more information, see “Markers Window” on page 220 and 

“Colors Tab” on page 270.

3 On the toolbar, click the Play button 

The video plays, and the neural data scrolls from right to left in the Activity 
window. This keeps the current video frame at the position marked by the cur-
rent-time indicator in the Activity window. The current-time indicator is the 
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downward-pointing triangle near the center of the view, which is surrounded 
by the current frame time and frame number.

4 Click the Pause button to pause the display. 

Note: The user may also pause the display by pressing the SPACEBAR 
key. To restart the display click the Pause button or press the space-
bar key.

5 Click the Previous Frame and Next Frame buttons to move backwards or 
forwards to sequentially view each frame in the display.

Note: The user may also step through the display by pressing the LEFT 
ARROW key or the RIGHT ARROW key.

6 Click Play. Click the rate buttons to decrease or increase the speed of the 
display. Continued decreasing the speed will eventually cause a reversal to 
occur, and continued increasing the speed will eventually reach a maximum 
speed.

Note: The user may also change the speed by using the UP ARROW key 

and the DOWN ARROW key on the computer keyboard. The user 
may also select a speed from the drop list on the toolbar.

7 Click the Reverse Animation button to switch the direction of play. The speed 
of the new direction will be the same as in the old direction. 

8 Click the Normal Speed button to reset the playback speed to normal, which 
is one times the recorded speed of the video in the forward direction.

9 Click the Rewind button to return to the beginning of the file.
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4.2.4 Defining a New Marker

This procedure covers the steps required to define a new marker. The Markers 
window in the upper left corner of the main view shows the set of markers 
imported from the data files.

The >> indicator denotes the current marker. The Markers window shows the 
following basic information about each marker:

• Name shows the name assigned to the marker. Marker names must be unique.

• Type indicates the abbreviation that denotes the type of the marker; for a 
complete list of marker types, see “Table 5-1” on page 278.

• Count shows the number of occurrences or each marker type.

• Key indicates the keystroke that is associated with this marker, which can be 
used to find and insert markers.

• Show indicates if the occurrences of this marker display in the Activity win-
dow.

• Display Color shows the color of the occurrences of this marker in the dis-
play views.

For the purpose of this quick-start example, suppose the user wants to use Cine-
Plex Editor to invalidate intervals in the neural data that were corrupted by arti-
facts, in this case from the animal chewing. This is done by defining a marker to 
bracket the chewing interval as in the procedure below.

1 Click Pause. 

Note: Although pausing is not required, the video can be distracting when 
performing other operations in CinePlex Editor. 

2 Define a new marker to denote the time intervals that are dominated by 
artifacts. This can be done in three ways:

• Click the New Marker button, 

• or, from the Edit menu, click Define New Marker,

• or, from the right-click menu in the Markers window, select Define New 
Marker.
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The Define New Marker dialog box appears.

3 In the Type area, click I to define an interval marker. 

4 In the Name box, in the place of the default name Interval type Chewing 
Artifact. Retain the default settings for the other items.

Note: For explanations for the other items in the Define New Marker win-
dow, see “Define New Marker” on page 245. 

5 Click OK. 

The Chewing Artifact entry appears in the Markers window, and the >> sym-
bol appears in the left-most column to indicate that this marker is currently 
selected. However, there are no occurrences of this marker, so the value in 
the Count column is 0.

4.2.5 Creating Marker Occurrences

This procedure covers the steps required to create new marker occurrences. It is 
possible to have more than one occurrence for any given marker. The user may 
manually enter marker occurrences in three different ways:

• keystroke

• button click in the Input window

• mouse click in an appropriate view

Each method has advantages and disadvantages; we suggest trying each method 
to find the appropriate one. For more information on each one of these methods, 
see “Inserting Marker Occurrences” on page 176.

This quick-start example covers only the keystroke method. In the previous pro-
cedure the user defined the Chewing Artifact marker, which appears in the 
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Markers window in the Name column and its associated key appears in the Key 
column as 5. If the 5 key is pressed, CinePlex Editor expects an operation with 
the Chewing Artifact marker.

The available marker operations appear in the Input window, which normally 
opens directly beneath the Markers window. The Keystroke radio buttons 
define the operations associated with pressing keys. The default selection is Find. 
If the 5 key is pressed, CinePlex Editor finds the next occurrence of the Chew-
ing Artifact marker. However, because no occurrences of the Chewing Artifact 
marker have been created, the 5 key currently has no effect. To create marker 
occurrences follow the procedure below.

1 In the Markers window, select the Chewing Artifact marker.

2 To arm CinePlex Editor to insert new marker occurrences when pressing the 
5 key, in the Input window at Keystroke, click Insert. 

3 Click Play, or press the SPACEBAR key.

4 Although interval markers are easier to insert while CinePlex Editor is 
playing, the default 1X playback speed can be too fast to insert markers 
precisely. Adjust the playback speed by selecting a slower setting from the 
speed droplist on the toolbar, for example, 1/8X.

5 To insert an occurrence of the Chewing Artifact marker, press the 5 key once 
to define the beginning of the interval and press the 5 key again to define the 
end of the interval. 

Note: The user may use other CinePlex Editor capabilities to change 
marker occurrence intervals, so a convenient work method is to 
quickly insert placeholder marker occurrences, which can later be 
edited to set precise start and end times. This is discussed under 
“Operating with Marker Occurrences” on page 190.

6 Insert several more occurrences using the 5 key. As occurrences are entered, 
they appear in the ‘Chewing Artifact’ Marker Occurrences window. Each 
marker occurrence appears with the start and end times for each interval. 

Note: The Marker Occurrences default window is tall and narrow and it 
can obscure the complete window title. Move the mouse cursor over 
the title bar to see the complete title. Also, the title of this window 
changes to include the currently selected marker in single quotation 
marks. The information that appears in the window also changes for 
each marker type. For example, a Coordinate marker shows Time, X, 
and Y coordinates instead of Start Time and End Time. 

7 Click Pause. In the Edit Markers window next to Keystroke, click Find. 

8 Press the 5 key to advance to an occurrence of the Chewing Artifact marker. 
Press the 5 key several times to cycle through the intervals entered.

4.2.6 Saving and Exporting the Data

This procedure covers the steps required to save the marked up files from the 
quick-start example and to export the data to other applications. When saving a 
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project, CinePlex Editor saves all the marker information in the CPJ file. The 
user may also export the marker data to:

• a PLX file: The markers become Type 4 Events in the PLX file, along with 
the spike and continuous data from the original neural data file.

• a NEX file: The markers become Nex variables, along with the spike times 
and continuous data from the original neural data file.

• a text file: Each marker occurrence becomes a line in the text file.

• a MATLAB file: Each marker occurrence becomes a row in a 2D matrix.

• an Excel spreadsheet: Each marker occurrence becomes a row in the spread-
sheet.

Note: Matlab or Excel must be installed on the computer to export these file types. 
Otherwise, all Matlab or Excel functions, or both, appear dimmed.

To save the project and export the data, follow the procedure below.

1 To save the quick-start example work, click Save. The Save As dialog box 
opens with the file name CM_Quickstart-01. Click Save to save 
CM_Quickstart-01.

Note: If the user reloads the same CPJ file just saved, it puts CinePlex Edi-
tor back into the same state it was in prior to the save operation. 
CinePlex Editor reloads with the same markers, marker occur-
rences, current marker selection, etc.

2 For this quick-start example, export the data as a text file. From the File 
menu, select Export Markers. 

The Export Marker Data dialog box opens.
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3 In the Format area, accept the default value Text file. The Export Marker 
Data dialog box includes various options for how, where, and what data to 
export. However, for this quick-start example, accept the defaults values and 
click Export! 

The Export Complete dialog box appears.

4 Locate CM_Quickstart.txt. Open the file with Windows Notepad or another 
text reader to see how the data is exported.

4.2.7 Re-opening a Project File

This procedure covers the steps required to re-open a project file.

1 Exit and re-start CinePlex Editor. 

The Welcome To CinePlex dialog box opens.

Note: The Welcome To CinePlex dialog box now contains an entry for the 
CM_Quickstart.cpj file in the recent projects list box. 

2 Double-click CM_Quickstart.cpj to open the quick-start example project.

CinePlex Editor opens in the same state that it was in when the project file 
was saved.

3 This completes the last procedure in the Quick-Start Example.
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4.3 Using the Activity Window

In the Activity window, CinePlex Editor provides two frequently-used items to 
display neural data—the time pointer and the time range. The time pointer repre-
sents the concept of a current instant. The frame in the Video window is the 
frame whose occurrence time is no later than the current time pointer and is the 
nearest frame on the left side of the current time pointer. The range of neural data 
in the Activity window is based on the time pointer. 

The inverted white triangle symbol in the Activity window depicts the current 
time:

The Activity window displays the current time in seconds (t), and the current 
frame number (F). The Activity window default setting positions the current time 
symbol at the center of the window, so that an equal span of time before and after 
the current time appears in the window. However, the user may reposition the 
current time symbol by clicking and dragging it with the left mouse button. In this 
way, the user may configure the Activity window to show an asymmetric span of 
time about the current time; for example, from 1 second before to 5 seconds after 
the current time.

In general, the time pointer may or may not point to the time of a video frame. 
The video frame that appears for a given current time is the frame at the latest 
time, which can be less than or equal to the current time. However, the user may 
configure CinePlex Editor to lock the current time to the times of Frame Mark-
ers; see Lock to Video Frames on page 251.

The user may expand or contract the range of time that appears in the Activity 
window by clicking Zoom In or Zoom Out. The user may also shift the current 
time by dragging the scroll bar at the bottom of the window.

The user may also override the current time in a more persistent way by using the 
Find  functions to change the current time to be that of a marker. For example, by 
clicking the Find Occurrences button, or from the Find menu, select Find 
Marker Occurrences..., which opens the Find Marker Occurrences dialog 
box; see “Find Marker Occurrences” on page 253.

4.3.1 Understanding Looping

By default, CinePlex Editor starts in looping mode, where animation and 
searches that run past the end of the file restart from the beginning. To turn off 
looping mode, from the Looping menu, click Toggle Looping; for more informa-
tion, see “Looping Menu” on page 251.
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4.4 Customizing the User Interface

Although the default user interface setup in CinePlex Editor may be adequate 
for the needs, the user may also customize the user interface. For details on cus-
tomizing the user interface, see D  Plexon User Interface.

Some general principles and conventions repeat throughout the CinePlex Editor 
user interface as well as the Plexon User Interface.

• Right-click Menus – See “Right-click Menus” on page 18.

• Current Selections – See “Current Selections” on page 18. The currently 
selected marker and channel also appear in their selected color (bright violet 
by default) in the Activity window. 

• Keystroke Shortcuts – See “Keyboard Customization” on page 20.

• Views – The user may quickly close and re-open windows by using the View 
options or the corresponding toolbar buttons.

• Undo – See “. Undo” on page 18.

• Quick Reference – See  “Help Menu” on page 13.

4.5 Using Markers and Marker Occurrences

This section explains how to use markers and marker occurrences. Markers are 
designators that are used to identify or describe timepoints in a file. There can be 
several types of markers. Each marker type contains specifically-defined infor-
mation. CinePlex Editor uses seven different marker types; for detailed descrip-
tions of the content of each marker type, see Table 5-1, “Marker Types,” on 
page 278. A marker occurrence is a specific circumstance, or instance, where a 
marker appears. A marker can have multiple occurrences. Each marker occur-
rence contains unique information, which consists of a minimum of a timestamp 
and the other values defined by its marker type. For a more extensive discussion 
of markers and their occurrences, see “Digital VideoTracker (DVT) Files” on 
page 156.

4.5.1 Defining Markers

To define a CinePlex Marker, designate it as one of the seven available CinePlex 
types defined in “Table 5-1” on page 278 and name it uniquely. The user may add 
optional information to the definition such as comments, associated keystroke, 
display color, and associated event IDs. Follow the procedure below to define 
markers.
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1 On the Edit menu, click Define New Marker.

The Define New Marker dialog box appears.

2 In the Type area, click a marker type. 

3 In the Name box, type a unique name for the marker.

4 Add any additional items. For more information, see “Define New Marker” 
on page 245.

5 Click OK.

The new marker appears as the selected marker in the list in the Markers 
window.

4.5.2 Inserting Marker Occurrences

There are three primary methods to insert new marker occurrences:

• Keystroke

• Button 

• Left-Click (of the mouse button)
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In the Input window, select an input method. For more information on the Input 
window, see “Input Window” on page 223.

Note: The user may also use items from the Edit menu to choose one these input 
methods to insert new marker occurrences. For more information, see “Edit 
Menu” on page 245.

Keystroke

To use the keystroke method to insert marker occurrences, associate a key with 
each marker for which occurrences are created. When defining a marker, the user 
typically associate a keystroke with it. The associated keystroke appears in the 
Key column of the Markers window. 

Note: If there is no associated key with the marker or to change the key association, 
from the right-click menu in the Markers window, click Edit Selected Marker to 
open the Edit Marker dialog box. For more information, see “Edit Selected 
Marker” on page 246.

To insert marker occurrences using the keystroke method, follow the procedure 
below.

1 In the Input window, next to Keystroke click Insert.

Note: This arms CinePlex Editor to insert an occurrence of a marker at the 
current time when pressing the key associated with that marker. 

2 Use keystroke insertion when CinePlex Editor is paused or playing. Enter 
marker occurrences with keystrokes for each marker type as follows:

• For Time Only (T) markers – Press the associated key once to insert a 
single marker occurrence at the current time.

• For Interval (I) markers – Press the associated key once to start the inter-
val. Press the key a second time to end the interval. 

• For Scalar (S) markers – The keystroke behavior for Scalar markers 
changes with the animation status as follows: 
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• If paused – Open a Scalar window for the marker. Press the 
associated key and drag the mouse pointer in the Scalar window 
to set the value for the new occurrence. 

• If playing – Open a Scalar window for the marker. Press the 
associated key to pause the animation. Drag the mouse pointer in 
the Scalar window to set the value for the new occurrence.

• For Coordinate (C) markers - Press the associated key and move the 
mouse pointer in the Video window and click to enter the coordinate val-
ues. If it was playing before pressing the key, after clicking, CinePlex Edi-
tor enters the new marker occurrence, and resumes animation.

Note: Although the user typically insert Level Interval (L) and Zone Interval (Z) 
markers automatically by using the Levels Editor and Zones Editor dialog 
boxes, the user may also enter them with a keystroke.

Note: For Scalar and Coordinate markers, to use the keystroke or button method 
the user must have the value of the Scalar or Coordinate marker occurrence 
set by clicking the mouse in either the Scalar window or the Video window. 
For this reason, the left-click input method is better for entering Scalar or 
Coordinate marker occurrences. Also, it does not make sense to use the key-
stroke or button input methods unless the Scalar or Video windows are 
open.

Button Insertion

The Input window includes an associated button for each marker. Each button 
displays the marker name. CinePlex Editor automatically creates a button for 
each new marker defined. As the user defines new markers or repositions the 
Input window, the button palette rearranges itself. Follow the procedure below

1 In the Input window, next to Button click Insert.

2 To insert a marker occurrence, in the Input window click the appropriate 
marker button. 

CinePlex Editor inserts the occurrence at the current time.

Note: With button insertion, each marker type behaves exactly the same as 
described in the preceding section for keystrokes.

Left-Click Insertion

The Left-Click insertion method is fundamentally different from the other inser-
tion methods. Use the Left-Click method only to insert occurrences for the cur-
rently selected marker. 

Understanding Click-To-Add Mode

Click-To-Add mode is a semi-automatic subset of the Left-Click insertion 
method. In Click-To-Add mode, each time a marker is chosen and the left mouse 
button is clicked, CinePlex Editor inserts an occurrence of the marker and auto-
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matically advances the video by a preset number of frames. Two examples fol-
low:

• Example 1: The user watches each frame in the Video window and assign a 
Scalar value to some on-screen behavior, say a number between 1 and 10 for 
a rat's activity level. To assign a range to the Scalar window, see “Scalar 
Right-click Menu” on page 232. With each frame, left-click in the Scalar 
window to enter a Scalar marker occurrence with a value that corresponds to 
the location clicked in the Scalar window, at the time of the current video 
frame. After each left-click, CinePlex Editor automatically advances to the 
next frame or to the number of frames set. To set the number of frames, see 
Number of Frames to Advance During Click-To-Add on page 266. 

• Example 2: The user watches each frame in the Video window and mark 
some position of interest, for example, the end of the rat's tail. With each 
frame, left-click in the Video window to enter a Coordinate marker occur-
rence with a value that corresponds to the location clicked in the Video win-
dow, at the time of the current video frame. After each left-click, CinePlex 
Editor automatically advances to the next frame or to the number of frames 
set. 

To insert marker occurrences with a mouse click, follow the procedure below.

1 In the Input window, next to Left-Click click Insert.

Note: This arms CinePlex Editor to insert an occurrence of a marker at the 
current time when clicking (left-click) the mouse. 

2 In the Markers window, click the marker for which to insert occurrences.

A >> appears in the left most column to designate the marker as the currently 
selected marker.

3 Use mouse click insertion when CinePlex Editor is paused or playing. Enter 
marker occurrences for each marker type as follows:

• For Time Only (T) markers – Click in the Activity window only, as follows, 
otherwise CinePlex Editor ignores the click. 

• If paused – Click anywhere in the window and the occurrence 
appears at the time corresponding to the pointer location. 

• If playing – Because the display typically moves too fast for 
precise insertion, click anywhere in the window and the 
occurrence appears at the current time. Keep the pointer over the 
Activity window while watching the video and click to insert each 
occurrence.

• For Interval (I) markers – Click in the Activity window only, as follows, 
otherwise CinePlex Editor ignores the click.

• If paused – Click once to mark the start of the interval. Click a 
second time to mark the end of the interval. The user may enter 
the ends of the interval in either order, but CinePlex Editor always 



4  

180      CinePlex

makes the earlier time the start time for the Interval marker 
occurrence. 

• If playing – Click once to mark the start of the interval. The start 
time appears at the current time and the interval expands. Click a 
second time to mark the end of the interval. The end also appears 
at the current time. The user may keep the pointer over the 
Activity window while watching the video, then click to mark the 
start time and click again to mark the end time of each occurrence.

• For Scalar (S) markers – Click in the Scalar window only, as follows, oth-
erwise CinePlex Editor ignores the click. 

• If paused – Click-To-Add mode activates; see “Understanding 
Click-To-Add Mode” on page 178. Click to insert a Scalar 
marker occurrence with a value (see Note that follows) that 
corresponds to the location clicked in the Scalar window, at the 
time of the current video frame. With this feature, the user may 
enter a new Scalar occurrence on every nth frame and then use 
the Interpolate Missing Occurrences feature to fill in the skipped 
values; see “Interpolate Missing Occurrences” on page 262.

Note: The user must have the Scalar window configured cor-
rectly for the desired range of the Scalar value; see “Sca-
lar Right-click Menu” on page 232.

• If playing – Click to insert an occurrence at the current time with a 
value that corresponds to the location clicked in the Scalar 
window. The animation does not pause.

• For Coordinate (C) markers – Click in the Video window only, as follows, 
otherwise CinePlex Editor ignores the click. 

• If paused – Click-To-Add mode activates; see “Understanding 
Click-To-Add Mode” on page 178. Click in the Video window 
to enter a Coordinate marker occurrence with a value that 
corresponds to the location clicked in the Video window, at the 
time of the current video frame. With this feature, the user may 
enter a new Coordinate occurrence on every nth frame and then 
use the interpolate missing occurrences feature to fill in the 
skipped values; see “Interpolate Missing Occurrences” on 
page 262.

• If playing – Click to insert an occurrence at the current time with a 
value that corresponds to the location clicked in the Video window. 
The animation does not pause.

Note: The left-click method works for Level Interval and Zone Interval mark-
ers. However, in general the user should automatically generate 
these marker types by using the Levels Editor and Zones Editor 
dialog boxes. See “Using the Levels Editor” on page 185 and 

“Using the Zones Editor” on page 188.
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4.5.3 Editing Markers and Marker Occurrences

This section includes a series of short procedures dealing with markers and 
marker occurrences. Each procedure uses the most-efficient primary method, but 
additional methods that can be used to accomplish the same task appear in paren-
theses after the primary one. Follow the procedure below to delete a selected 
marker.

1 In the Markers window, select the marker to delete.

2 From the Markers window right-click menu, choose Delete Selected Marker 
(or from the Edit menu, choose Delete Selected Marker, or click the Delete 
Selected Marker button):

CinePlex Editor immediately deletes the selected marker and its marker 
occurrences. 

Note: CinePlex Editor provides no confirmation before it deletes the 
marker. However, to undo the deletion, from the Edit menu, click 
Undo.

Deleting all occurrences of a selected marker

1 In the Markers window, select the marker with the marker occurrences to 
delete.

2 From the Markers window right-click menu, choose Delete all Occurrences 
of Selected Marker (or from the Edit menu, choose Delete all Occurrences 
of Selected Marker, or click the Delete all Occurrences of Selected Marker 
button):

CinePlex Editor immediately deletes all marker occurrences for the selected 
marker. 

Note: CinePlex Editor does not delete the marker itself, but it removes all 
occurrences of the marker. CinePlex Editor provides no confirmation 
before it deletes the marker occurrences. However, to undo the dele-
tion, from the Edit menu, click Undo.

Copying a selected marker

1 In the Markers window, select the marker to copy.

2 From the Markers window right-click menu, choose Make Copy of Selected 
Marker (or from the Edit menu, choose Make Copy of Selected Marker). An 
exact copy of the selected marker named Copy of <OldMarker> appears in 
the Markers window.

Note: The new marker has the same marker occurrences. However, the 
new marker gets new values for the associated key and for the Event 
ID(s), since those values need to be unique among the markers.

Adding new marker occurrences

1 In the Marker Occurrences window, select the marker for the new 
occurrence.

2 From the Marker Occurrences window right-click menu, choose Add New 
Marker Occurrence (or from the Edit menu, choose Add New Marker 



4  

182      CinePlex

Occurrence, or click the Add New Marker Occurrence button). The New 
Marker Occurrence dialog box for the selected marker opens.

Note: For more information on the New Marker Occurrence dialog box, 
see “Add New Marker Occurrence” on page 248.

3 In the Time box, type a time in seconds for the marker occurrence. If the 
marker is a Coordinate marker, type the X and Y coordinates. Click OK.

Editing marker occurrences

1 In the Marker Occurrences window, select the marker occurrence to edit.

2 From the Marker Occurrences window right-click menu, choose Edit 
Selected Marker Occurrence (or from the Edit menu, choose Edit Selected 
Marker Occurrence, or click the Edit Marker Occurrence button):

The Edit Marker Occurrence dialog box opens.

Note: For more information on the Edit Marker Occurrence dialog box, 
see “Edit Selected Marker Occurrence” on page 248.

3 In the Time and End Time boxes, type new times in seconds. If the marker 
type includes coordinates, change these as needed. Click OK.

Deleting selected marker occurrences

1 In the Marker Occurrences window, select a marker occurrence to delete.

Note: To delete more than one occurrence, see Step 3.

2 From the Marker Occurrences window right-click menu, choose Delete 
Selected Marker Occurrence (or from the Edit menu, choose Delete 
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Selected Marker Occurrence, or click the Delete Marker Occurrence 
button):

CinePlex Editor deletes the currently selected marker occurrence.

3 The user may also select multiple occurrences to delete. To delete a currently 
selected marker occurrence plus all of the marker occurrences that are 
highlighted with a black background in the Marker Occurrences window, 
from the right-click menu choose Delete Highlighted Marker Occurrences.

CinePlex Editor immediately deletes all of the marker occurrences that are 
highlighted in the Marker Occurrences window.

Note: CinePlex Editor includes other right-click menu entries for selecting and copy-
ing text with marker occurrence information onto the Windows clipboard, which 
can be pasted into other applications.

4.5.4 Automatically Generating Marker Occurrences

CinePlex Editor can automatically generate marker occurrences. When the user 
defines a new marker using the Define New Marker dialog box (see “Define 
New Marker” on page 245), the user may choose to have CinePlex Editor popu-
late the new marker with algorithmically-generated marker occurrences. The 
available algorithms for generating marker occurrences depend on the marker 
type, which the following sections describe. 

Automatically generating Time-Only or Frame Marker occurrences

1 To automatically generate Time-Only or Frame Marker occurrences, in the 
Define New Marker dialog box, click T then click Generate Occurrences to 
open the Generate Marker Occurrences dialog box. 

2 To generate occurrences for this marker from the occurrences of another 
marker, click Generate from occurrences of another Marker. Otherwise, go 
to Step 4.

3 Select a marker from the drop-down list. Click OK. 

CinePlex Editor generates marker occurrences at the times of the occur-
rences of the marker selected in the drop list.
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4 To generate occurrences for this marker based on other criteria, click 
Generate based on. 

5 To generate regularly-spaced marker occurrences, in the Time of First 
Occurrence box type an offset from the beginning of the file.

6 To space the occurrences at intervals such that they occur at a specified rate, 
in the Occurrence Rate box, type the rate in occurrences per second. 

7 To specify the total number of marker occurrences to generate, in the 
Number to Generate box, type the total.

Note: Under some conditions, the New Project Wizard also displays the 
Generate Marker Occurrences dialog box so that the required frame 
marker occurrences can generate. The suggested values that appear 
in the Occurrence Rate and Number to Generate edit boxes when 
the dialog box first appears correspond to the frame rate and number 
of frames detected in the currently-loaded video data file. In most 
cases, simply click OK to generate appropriate frame marker occur-
rences.

Automatically generating Interval marker occurrences 

1 To automatically generate Interval marker occurrences, in the Define New 
Marker dialog box, click I, then click Generate Occurrences to open the 
Generate Interval Marker Occurrences dialog box. 

2 From the Generate Intervals that cover time spans drop-down list box, 
select one of the following algorithms to generate the intervals:

• Between Marker 1 and Marker 2 – If this algorithm is selected, go to 
Step 3.

• Around Marker 1 – If this algorithm is selected, go to Step 4.

• Between a time offset from Marker 1 and a time offset from 
Marker – If this algorithm is selected, go to Step 5.

• Defined by time ranges read in from a file – If this algorithm is 

selected, go to Step 6.
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3 Select entries in the Marker 1 and Marker 2 lists. Click OK. 

Intervals generate with a start time that corresponds to the occurrence times 
of the Marker 1 selection. The end time correspond to the first subsequent 
occurrence time of the Marker 2 selection. CinePlex Editor ignores addi-
tional occurrences of Marker 1 that occur before an ending Marker 2.

4 Select entries in the Marker 1 list. In the two Time Offset... boxes, enter time 
offsets TS and TE in seconds. Click OK.

Note: For every occurrence of Marker 1 at time t, an interval generates from 
time t + TS to time t + TE, where TS and TE are the time offsets 
entered in the first and second marker boxes respectively. TS and TE 
can be positive or negative.

5 Select entries in the Marker 1 and Marker 2 lists, and enter time offsets in the 
Time Offset... boxes. Offsets can be positive or negative. Click OK.

Note: This is a generalization of the first algorithm where the interval is off-
set in a fashion similar to the second algorithm from the exact times of 
the start and end marker occurrences.

6 In the Ranges File box, type or select a text file that contains the ranges. 
Click OK.

Note: The format of the text file is one range per line of text, with each line 
containing the start time and end time in seconds. The delimiter 
between the times can be a comma, a space, or a tab.

Automatically generating Scalar and Coordinate marker occurrences

• In the Define New Marker dialog box, if the user selects S (Scalar) or C 
(Coordinate) and clicks Generate Occurrences, CinePlex Editor just gener-
ates some fake, random data for testing and demonstration purposes. It has 
no usefulness in general.

Automatically generating Level Interval and Zone Interval marker 
occurrences

• In the Define New Marker dialog box, if the user selects L (Level Interval) or 
R (Zone Interval) and clicks Generate Occurrences, CinePlex Editor 
defines the new marker and then opens either the Levels Editor or Zones 
Editor dialog boxes. Use the editors to generate occurrences based on level 
crossings for Scalar markers, or Zone containment for Coordinate markers. 
For basic information, see “Using the Levels Editor” on page 185 and 

“Using the Zones Editor” on page 188. For detailed information on each 

editor, see “Levels Editor” on page 254 and “Zones Editor” on 
page 256.

4.5.5 Using the Levels Editor

The user may use the Levels Editor to define Level Interval markers and insert 
marker occurrences for them. To open the Levels Editor dialog box, from the 
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Tools menu, click Levels Editor (or click the Levels Editor button on the tool-
bar).

Level Interval Markers

Level Interval marker occurrences indicate the time intervals during which the 
values of another Scalar marker satisfied some condition. The user may use the 
Levels Editor to set up the conditions, apply the conditions to a specific Scalar 
marker, and generate occurrences of the selected Level Interval marker or mark-
ers.

Level Interval markers are like Interval markers, but they are extended to store 
additional information that defines a condition. This additional information 
appears with the Level Interval marker definition in the CPJ file. The occurrence 
of a Level Interval marker is always tied to the values of the occurrence of a Sca-
lar marker.

The condition for a Level Interval marker can be either one or two level settings, 
which can include an above or below flag for each level, and when two levels are 
used, a logical operator between them (AND or OR). For example, the user may 
define a simple thresholding operation that generates the time intervals for which 
the value of the Motion Scalar marker went below the value of 175. This defini-
tion might be useful as a freezing behavior detector. For more information on 
freezing behavior, see “Motion Measure Option” on page 81. The generated 
Level Interval then represents the episodes during which the animal froze. The 
preceding illustration shows the Levels Editor when such a Frozen Level Interval 
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is defined and selected. A more sophisticated condition involving two levels 
appears in the following illustration:

In the preceding illustration, Running marker is populated with occurrences that 
represent the time intervals for which the Motion Scalar marker is Above the 
value of 764 and is also Below the value of 893. The user can add, edit, and delete 
these Level Interval markers using the buttons in the bottom portion of the Levels 
Editor window.

To use the Levels Editor

1 On the Tools menu, click Levels Editor.

The Levels Editor window opens.

2 To define a new Level Interval marker, click Add. 

The Define New Marker dialog box (see “Define New Marker” on 
page 245) opens to enable the user to customize the general properties of 
the new Level Interval marker. 

3 Define the new marker and click OK to close the Define New Marker dialog 
box.

 A new row appears in the Level Intervals box.
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4.5.6 Using the Zones Editor

The user may use the Zones Editor to define Zone Interval markers and generate 
marker occurrences for them. To open the Zones Editor dialog box, on the Tools 
menu, click Zones Editor (or click the Zones Editor button on the toolbar):

Zone Interval Markers

Zone Interval marker occurrences indicate the time intervals during which a 
Coordinate marker occurrence remains inside a Zone that is defined. The user 
may use the Zones Editor dialog box to define the Zones, to search for the times 
when the specified Coordinate marker entered and left the defined Zones, and 
generate Zone Interval marker occurrences.

Zone Interval markers are Interval markers, but they are extended to store addi-
tional information that defines a Zone. This additional information appears with 
the Zone Interval marker definition in the CPJ file. A Zone is an ordered list of 
coordinates that are connected with line segments, to form a closed Zone. Zone 
Interval marker occurrences are always tied to the values of the occurrence of a 
Coordinates marker.

The coordinate system for all Coordinate markers, and therefore also for all Zone 
definitions, range from (0,0) to (1023,767), with (0,0) representing the lower left 
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corner of the image. If the video resolution is other than 1024x768, which is usu-
ally the case, the coordinates are linearly mapped onto the video.

To use the Zones Editor

1 On the Tools menu, click Zones Editor.

The Zones Editor window opens.

2 To define a new Zone Interval marker, under the Zone Intervals area click 
Add. 

The Define New Marker dialog box (see “Define New Marker” on 
page 245) opens to enable the user to customize the general properties of 
the new Zone Interval marker. 

3 Define the new marker and click OK to close the Define New Marker dialog 
box.

 A new row appears in the Zone Intervals box.

Note: Immediately after the user creates a new Zone Interval marker, 
Zones Editor enables the user to click in the video window to set the 
X and Y Coordinates of the Selected Zone. The box directly above 
the video then contains this text:

Left-Click on the view to add a new coordinate; Right-Click to end
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4 Move the mouse pointer into the Zones Editor video area. 

The mouse pointer changes to crosshairs and the current pointer location 
coordinates appear under X and Y in the Coordinates of the Selected Zone 
area. 

5 Move the pointer to the desired location for the first coordinates of the 
selected Zone. Click to add the first coordinates. 

The first set of coordinates appear as line 1 in the Coordinates of the 
Selected Zone box and line 2 indicates the current pointer position. 

Note: As the user moves the mouse pointer, a line follows it from the first 
coordinates to its current location. The current location always 
appears as a small circle with a white interior. 

6 Move the pointer to the desired location and click again to add the second set 
of coordinates, and so on. Stop entering coordinates when the next set would 
be the starting point. 

7 Click the right mouse button.

The Zones Editor automatically closes the Zone by making the last coordi-
nate the same as the first coordinate.

The user may select a point at a vertex of a selected Zone Interval by clicking on 
a line in the Coordinates of the Selected Zone box. The point the user selects 
appears with a >> in the leftmost column box and as a small circle with a white 
interior in the video area.

After the user has defined the Zones, the user may generate Marker occurrences 
just for the selected Zone Interval marker, or for all Zone Interval markers by 
clicking Generate Selected or Generate All.

4.5.7 Operating with Marker Occurrences

With CinePlex Editor, the user may perform certain simple operations on marker 
occurrences. The user can find, move, and delete occurrences. The user may also 
shift, align and interpolate marker occurrences, and invalidate waveforms that 
occur either inside or outside of Interval marker occurrences.

Finding Marker Occurrences

CinePlex Editor includes the following three ways to find marker occurrences:

• Keystroke

• Button

• Using the Find menu items or toolbar buttons

Finding marker occurrences with a keystroke

• In the Input window next to Keystroke, click Find. Press the key associated 
with the marker, which appears in the Key column of the Markers window.

CinePlex Editor advances the file in the Activity window to align the first 
occurrence of the marker with the current time triangle.



Version 3.0 191

Finding marker occurrences with a button click

• In the Input window next to Button, click Find. In the Input window, click the 
button associated with the marker.

CinePlex Editor advances the file in the Activity window to align the first 
occurrence of the marker with the current time triangle.

Interval Operations

For Interval, Level Interval, or Zone Interval markers, the user may invalidate 
spike waveforms inside or outside of the Intervals, or remove the occurrences of 
other markers that fall inside or outside of the intervals.

To use an Interval marker (see “Defining a New Marker” on page 169) for opera-
tions, from the Tools menu, click Interval Operations to open the Interval 
Operations dialog box:

From the Interval Marker to Use list, choose one of the currently-defined Inter-
val, Level Interval, or Zone Interval markers. 

To mark as invalid each waveform (spike time) in every channel that falls inside 
the start and end times of all occurrences of the Interval marker, click Invalidate 
Waveforms that occur within the Intervals. This operation can be inverted; 
before doing so, see the cautionary note in this section.

If a marker occurrence falls inside a defined interval, the user may remove that 
marker occurrence. To do so, click Remove Occurrences within the Intervals, 
for Marker, and choose a non-Interval marker from the second list. This opera-
tion may be inverted; before doing so, see the following cautionary note.

CAUTION
Negate inverts the selection for the entire file
If the user clicks Negate the selected operation, the selection is log-
ically inverted. This means the user invalidates or removes all the 
items he/she did not select, which is the entire portion of the file out-
side the limits of the Interval occurrences.
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If the user clicks Negate the selected operation, in the Interval Operations dia-
log box, the text in the Operation to Perform Using Interval Marker area 
changes as follows:

 

If the user chooses an operation and clicks Negate the selected operation, the 
user either invalidates all waveforms that do not fall between the start and end 
times of any Interval occurrences or removes all occurrences of the selected 
marker that do not occur inside the time span any Interval marker occurrence. For 
more information on the Interval Operations dialog box, see “Interval Opera-
tions” on page 258.

Shifting Marker Occurrences

The user may add a constant offset, which can be negative, to all the timestamps 
of a marker. The user may use this capability to align neural data files and video 
files. 

Shifting marker occurrences

1 From the Tools menu, click Shift Marker Occurrences to open the Shift 
Marker Occurrences dialog box:
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2 Choose a marker from the Marker list. 

Note: The first, last, and range of times covered by the occurrences of the 
chosen marker appear below the Marker list.

3 Choose one of the following methods for specifying the time shift:

• To shift marker occurrences by a fixed amount, in the Shift by box, enter 
the amount of the shift in seconds.

• To shift marker occurrences so that the first occurrence is at a specified 
time, enter the specified time in seconds in the Shift so that first Occur-
rence is at time box. CinePlex Editor applies this shift amount to all 
occurrences.

• To shift marker occurrences so that the first occurrence of a marker to 
shift is at the time of another marker occurrence, select the marker repre-
senting the time to shift to from the Shift so that first Occurrence is at 
time of Marker list, and enter the occurrence of the marker to use by typ-
ing its 1-based index in the Occurrence box.

4 Click OK to shift the marker occurrences and close the dialog box.

Snap-To Marker Occurrences

The Snap-To Marker Occurrences tool shifts all the occurrences of a marker to 
match up in time with the occurrences of another marker. 

Repositioning marker occurrences to align with others

1 From the Tools menu, choose Snap-To Marker Occurrences 

The Snap-To Marker Occurrences dialog box opens.

2 From the Marker To Adjust list, choose the marker to match up in time. From 
the Snap-To Occurrences of Marker list, choose the marker representing 
the occurrences to match in time. 

Note: Typically, the entry in Marker To Adjust is the one to align with the 
times of the video frames and the entry in Snap-To Occurrences of 
Marker is a Frame marker. CinePlex Editor uses the following algo-
rithm: For every occurrence of the entry in Marker To Adjust, Cine-
Plex Editor finds the best match occurrence of the entry in Snap-To 
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Occurrences of Marker, and makes the occurrence time of the entry 
in Marker To Adjust equal to the time of the best match occurrence.

3 To determine the best match occurrence of the entry in Snap-To 
Occurrences Marker, click one of the following items:

• Snap-to Previous Occurrence: Click this item to use the occurrences 
that are positioned immediately before the times of the entry in Marker To 
Adjust. This adjustment always reduces the time of the occurrences 
being adjusted.

• Snap-to Next Occurrence: Click this item to use the occurrences that 
are positioned immediately after the times of the entry in Marker To 
Adjust. This adjustment always increases the time of the occurrences 
being adjusted.

• Snap-to Closest Occurrence: Click this item to use the occurrences that 
are closest in time the entry in Marker To Adjust. This adjustment can 
shift the occurrence being adjusted either direction in time.

4 If the entry in Marker to Adjust is an Interval-type marker, it consists of two 
times—a start time and an end time. To adjust the span, which can change 
the duration of the interval by making both the start and the end times snap to 
their respective best match occurrences, click Snap interval start and end 
times independently. To retain the span, which retains the duration of the 
interval by only making the start times snap to their best match occurrences 
and shifting the end times to match, click to clear the checkbox.

5 Click OK to adjust the occurrences and close the dialog box. A confirmation 
dialog box appears to display how many marker occurrences were moved. 
The result may be two or more markers with the same timestamp.

Interpolating Missing Marker Occurrences

This tool is useful for adding entries in any gaps in marker occurrences. For 
example, when tracking some feature on the video by hand, the user may enter 
tracking coordinates only for every nth frame, and then interpolate them to com-
plete the remaining frames; this is a form of key-frame animation. Also, Cine-
Plex Studio is occasionally unable to provide valid coordinates for some video 
frames, for example, when the headset cable for a rat occludes the LED being 
tracked. The user may use this tool to complete tracking coordinates for every 
frame.
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Interpolating missing occurrences

1 From the Tools menu, choose Interpolate Missing Occurrences.

The Interpolate Missing Occurrences dialog box opens.

Note: For detailed information on how the interpolation algorithm runs, see 
“How the Interpolation Algorithm Works” on page 263.

2 In the Timestamp Determination area, choose one of the following items:

• Assume Periodicity: If the results in the Perodicity area indicate that 
the data is truly periodic enough so that filling in gaps by assuming a peri-
odicity is valid, click this item. 

• Use Frame Marker Times: If there should be marker occurrences for the 
selected marker for every frame, click this item; this lets the frame 
markers—not the periodicity analysis—determine where missing marker 
occurrences appear.

3 In the Value Interpolation area, if the marker being interpolated is a Scalar 
marker or a Coordinates marker, choose one of the following methods to 
calculate reasonable values to give the added marker occurrences:

• Sample-and-hold the previous value – Click this item to assign the 
value or coordinates of the last pre-gap marker occurrence to the new 
marker occurrences that fill the gap. 

• Linear Interpolation – Click this item to assign values to the new marker 
occurrences that fall on a line connecting the last pre-gap value or coordi-
nates with the first post-gap value or coordinates.

4 To have CinePlex Editor define and populate a new marker to identify the 
marker occurrences that it generates through interpolation, click Generate 
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new Time-only Marker at times for added Occurrences. Otherwise, click to 
clear the checkbox.

Note: If the user chooses this item, CinePlex Editor defines a new marker 
name “Interpolated X”, where X represents the name of the interpo-
lated marker; this tags the occurrences that are not part of the original 
data.

5 Click OK to close the dialog box.

CinePlex Editor adds the new occurrences to the file and, if the user chose 
the item in Step 4, adds an new row entitled “Interpolated __” to the list in the 
Activity window.

4.5.8 Selecting and Editing Marker Occurrences

To select a marker, in the Activity window, double-click on any marker time-line, 
or on the label for a marker. The label of the marker selected appears in the high-
light color, which is violet by default.

In the Input window (see “Input Window” on page 223), if the user chooses 
Select for the Left-Click input, a left click in the Activity window selects the 
nearest on-screen marker occurrence for the selected marker. The selected marker 
occurrence appears with a white box around it:

If the user selects the end time interval, the white box appears around the end 
time tick mark and the interval line:

In the Marker Occurrences window, the newly selected marker occurrence 
appears with a > next it, and the window can scroll to position the newly selected 
marker occurrence near the top of the view. If the Activity window is in the mode 
where it is selecting the nearest marker occurrence, the mouse pointer becomes 
white crosshairs. 

In the Activity window, the status bar shows useful information about the 
selected marker and marker occurrence. The name of the selected marker appears 
and the 1-based index of the selected marker occurrence; for example, in the fol-
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lowing illustration idx indicates the 4th occurrence of this marker and t indicates 
its time in seconds:

In the Activity window, the user may also drag selected marker occurrences to 
different times; this enables the user to make minor adjustments to the positioning 
of marker occurrences. To drag a marker occurrence to a new time, hold down the 
SHIFT key, click the marker occurrence, and drag it to a new time. For Interval-
type markers, the user may independently adjust the start and end times; for 
selection techniques, see the preceding paragraphs.

4.5.9 Entering or Editing Coordinate Markers 

In the Input window (see “Input Window” on page 223), if the user chooses 
Insert for the Left-Click input and the selected marker is a Coordinate marker, 
the user may enter or change coordinates by clicking in the Video window. If the 
Video window is in the mode where a left-click can change or add new Coordi-
nate marker occurrences, the mouse pointer in the Video window changes to 
crosshairs and a line of text at the bottom of the window shows the current coor-
dinates.

Because CinePlex Editor can enable only one marker occurrence for any given 
time, if the user enters a new coordinate at the time of an existing marker occur-
rence, the user effectively replace the existing coordinates. Thus, if the Coordi-
nate marker occurrences occur at the same time as the Frame marker occurrences, 
the user may touch up existing coordinates with a simple click on the new loca-
tion. 

By default, the Click-To-Add feature (see “Left-Click Insertion” on page 178) 
automatically advances a number of frames, so if the user continually clicks in 
the Video window he/she can quickly enter a sequence of coordinates on subse-
quent video frames.

Importing Markers

CinePlex Editor can import additional markers and marker occurrences from 
additional neural data files into an existing project. The user may add neural data 
files to the project and process them as during the initial import of neural data 
when the project  was first created (see “Setting Up a New Project” on page 165). 
The user may turn their events (from PLX files) or variables (from NEX files) 
into the appropriate markers and marker occurrences. 

To import markers, from the File menu, click Import Markers to open a Win-
dows file selection dialog box for the neural data file. After selecting the file, 
click OK to import the data from that file as new markers. CinePlex Editor must 
have unique marker names, so if a marker name from the imported neural data 
files conflicts with an existing marker, CinePlex Editor renames the file by add-
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ing “_n” to the name, and increasing the number n until it establishes a unique 
name.

Exporting Markers to text files, Matlab, or Excel

CinePlex Editor can export marker occurrences data in a tabular format to either 
a text file, a Matlab file, or an Excel spreadsheet. 

Exporting makers as text, Matlab, or Excel files

1 From the File menu, click Export Markers to open the Export Marker Data 
dialog box.

The Export Marker Data dialog box opens.

2 In the Format area, select the type of file to export. 

Note: To use the corresponding Matlab or Excel export functionality, those 
programs must be installed on the same computer with CinePlex 
Editor. Otherwise, the corresponding radio buttons appear dimmed.

3 For all formats, CinePlex Editor exports one marker occurrence per row—or 
per line for text files, and all rows have the same number of columns. From 
the Delimiter to use between values list, select one of the following 
delimiters: Comma; Comma, Space; Space; Semicolon; or Tab. 

4 If want the file to have a header row, click Export a Row of Column 
Headers. 

5 In the Which Markers area, click Selected Marker to export only the 
occurrences for the selected marker. To export the occurrences for all 
markers, click All Markers.

Note: If the user selects All Markers, the selection generally results in a 
confusing output file.
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6 The user may set the columns for each row in the What to Export for Each 
Marker Occurrence area. For more information on exporting marker data, 
see “Export Markers” on page 239.

7 In the Output File area, in the File box, type or select the output file name. 

Note: Under Format, if the user selects Text file or Excel, click the Append 
if existing checkbox to append the marker data onto the end of a file 
that already exists on disk. Otherwise, CinePlex Editor overwrites 
the existing file.

8 Click Export! to create the file and close the dialog box. The Export 
Complete dialog box appears.

Exporting as a PLX File

CinePlex Editor can export marker occurrences data along with spike and con-
tinuous data read in from the original neural data file to a new PLX file.

Mapping Markers to Event IDs

When exporting to a PLX file, the marker occurrences in the project are repre-
sented as external events (type 4 data) in the output PLX file. There are two kinds 
of external events in the PLX file format:

1 Individual External Events – These events appear only by their Event ID, and 
each occurrence includes a timestamp only. There can be many different Indi-
vidual External Events (with different Event IDs) present in a PLX file. 

2 Strobed Events – These events appear only by a special Event ID, so only one 
strobed event can be in a PLX file. Each occurrence of a strobed event stores 
a timestamp plus a single 16-bit value, called the strobe code.

The user must define a mapping between markers and Event IDs before CinePlex 
Editor can represent marker occurrences as external events.

Each marker for which the marker occurrences are to be exported to a PLX file 
must have its own unique Event ID. The user may define or edit the Event IDs in 
the Define New Marker or New Marker Occurrence dialog boxes (see “Define 
New Marker” on page 245 and “Add New Marker Occurrence” on page 248), or 
the user may change them in the Export To PLX dialog box (see “Export to 
PLX” on page 242. 

The fact that individual external events do not have any data values associated 
with them means that only Time-Only, Frame, and Interval-type (Interval, Level 
Interval, or Zone Interval) markers can be represented by using individual exter-
nal events. For Interval-type markers, specify two Event IDs, one to represent the 
start time of the interval and one to represent the end time.

Furthermore, the fact that a PLX file can only contain one kind of strobed events 
means that only a limited number of Scalar or Coordinates markers can simulta-
neously appear in a single PLX file. For example, if the strobed events in a PLX 
file are to represent all the occurrences of a certain Scalar marker, then there is no 
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way to represent another scalar marker or any coordinates markers in the same 
PLX file. 

Because of the existence of the VideoTracker protocol, coordinates markers can 
be represented in a PLX file. Up to three coordinates markers can be represented 
using the VideoTracker protocol in a single PLX file, along with an additional 
scalar marker.

Exporting as a NEX file

CinePlex Editor can export marker occurrences data along with spike and con-
tinuous data read in from the original neural data file to a new NEX file. For 
information on mapping from markers to Nex variables, see “Export to NEX” on 
page 244.
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4.6 CinePlex Editor How-Tos

This section contains suggested procedures for several common operations in 
CinePlex Editor. These procedures are by no means meant to be an exhaustive 
list of what can be done with CinePlex Editor, nor are they intended to be a pre-
sentation of the only possible way to achieve any desired end result.

Note: The following procedures assume a project has already been created and that 
it is currently open. For details on how to create CinePlex projects, see “Set-
ting Up a New Project” on page 165.

4.6.1 Printing

Several windows in CinePlex Editor support rudimentary printing. To print a 
specific window, click in the window so the title bar is highlighted. If the window 
supports printing, the Print and Print Preview items on the File menu are avail-
able. The Input and Scalar windows do not support printing.

4.6.2 Denoting Interesting Behavior In the Video

A basic use for CinePlex Editor is to introduce a new marker occurrence into the 
data each time an animal or other subject in the video performs an action that is of 
interest in an experiment. For example, perhaps a neuron is suspected to be asso-
ciated with a rat deciding to get a drink of water. The user might test this hypoth-
esis by introducing a time marker into the data whenever the rat drinks his first 
sip of water, as shown by the video. Then it would be desirable to perform a peri-
event analysis against this new event in Neuroexplorer (NEX) to see if any neu-
rons are associated with the first sip.

The procedural approach here is to define a new Time-only marker in CinePlex 
Editor, then enter marker occurrences whenever the rat starts to sip water. Ini-
tially, we rough in all the marker occurrences during one continuous pass through 
the video, then we go back and adjust each marker occurrence to be as accurate as 
possible. Then this information is saved to a NEX file, from which we can easily 
load it into NEX for analysis.

Denoting interesting behavior in the video

1 Define a new Time-only marker as described in “Defining a New Marker” 
on page 169. Label it “First Sip.” Assign a keystroke to it that is easy to press 
quickly.

2 Click Play. Adjust the Faster and Slower settings to a comfortable speed to 
view the video, which balances the desire to get through the video quickly 
against the risk of missing the behavior should it occur too quickly to spot. 

3 Use the Zoom In and Zoom Out buttons at the bottom of the Activity window 
to adjust the time range such that, should the sip behavior be spotted in the 
video view, a key on the keyboard can be hit before the time of the first sip 
scrolls out of the Activity window.

4 In the Input window, at Keystroke, click Insert (The user could just as easily 
use the Left-click or Button input methods here.). CinePlex Editor is now 
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armed to enter new occurrences of the new marker when pressing that 
marker's associated key.

5 Click Rewind. Click Play. Position a finger over the associated keystroke for 
the “First Sip” event.

6 When the sip behavior is observed, quickly press the key associated with the 
“First Sip” marker. Accuracy is not important at this point; fine-tuning will come 
later. Go through the entire video.

7 Now, lets go back through and adjust the time of the “First Sip” marker 
occurrences to be more accurate. We will use the Find function to quickly 
locate our marker occurrences. In the Input window, after Keystroke, click 
Find.

8 Rewind the video file, then press the assigned key for the “First Sip” marker. 
This causes the system to jump to the first marker occurrence. Use the left 
and right arrow keys on the keyboard to look at each frame of the video to 
decide where the sip actually occurs. 

9 In the Activity window, drag the marker occurrences to the correct time. To do 
so, press and hold the SHIFT key, then click near the tick mark for the 
marker occurrence. Drag the tick mark to the desired time and release the 
mouse button.

10 To save the data, on the File menu, click Export to NEX, and if desired, 
select the appropriate What to Export checkboxes. Click Export! to write the 
file.

4.6.3 Invalidating Artifact Waveforms

Artifact waveforms can occur, for example, because a rat rapidly shakes its head. 
This behavior can easily be spotted in the video view, and it generally produces a 
cluster of spikes and large voltage deviations in a continuous data channel. It is 
desirable to invalidate all spike waveforms that occur during each head-shaking 
episode, and save the data to a new PLX file that does not contain those invali-
dated waveforms. This file can then be loaded into Offline Sorter and sorted.

The procedural approach here is to define a new Interval marker, whose occur-
rences start and end when the head-shaking episodes start and end. We then use 
this Interval marker to invalidate the spike waveforms that occur within the head-
shaking episodes. We then save the data to a new PLX file minus the invalidated 
spike waveforms.

Invalidating artifact waveforms

1 Define a new Interval marker (see “Defining a New Marker” on 
page 169). Label it “Head Shake”. Make sure that the new marker is the 
currently-selected marker.

2 In the Channels window (see “Channels Window” on page 224), click 
Show for the spike and continuous channels that are the best indicators of 
when this artifact occurs, which makes them appear in the Activity window. 

3 Use the Zoom Out button at the bottom of the Activity window to expand the 
time range as much as possible, which helps to examine the file quickly. 
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However, do not expand the range so far that the artifact cannot be spotted 
should it occur. 

4 In the Input window, at Left-Click, click Insert (Or use the Left-click or 
Button input methods here.). CinePlex Editor is now armed to enter new 
occurrences of the new marker when pressing that marker's associated key.

5 Starting at the beginning of the file, click Play. If it doesn't make the behavior 
too difficult to spot as it scrolls by, increase the speed of the playback so that 
the file can be reviewed quickly.

6 When the head shake behavior is observed, quickly press SPACEBAR to 
pause the playback. Use the left and right arrows to single-step the frames to 
verify the head shake and decide when the head shake behavior begins and 
ends.

7 In the Activity window, left-click at the starting and ending times of the head 
shake episode. This inserts new marker occurrences of the “Head Shake” 
marker.

8 Press SPACEBAR to resume playing. Repeat Steps 6, 7, and 8 for each 
head shaking episode until the end of the file is reached.

9 From the the Tools menu, click Interval Operations. Select the “Head 
Shake” marker from the Interval Marker to Use list. Click Invalidate 
Waveforms that occur within the Intervals. Click OK. 

10 Now all of the spikes that occur within the head shake episodes have been 
invalidated. To hide invalidated spikes in the Activity window, open the right-
click menu and click Hide Invalidated Spikes.

11 To save the data, from the File menu, click Export to PLX. Verify that the 
Export invalidated spikes checkbox is clear (the default). If desired, check 
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or clear the Write? checkboxes for any markers that should be exported or 
not exported into the new PLX file. Click Export! to write the file.

4.6.4 Freeze Detection

CinePlex Studio can detect freeze behavior using recorded data with the Motion 
Measure option. The user may define a new interval that occurs whenever a rat 
freezes. The user may set a threshold level for the motion measure and define a 
freeze to be whenever the motion measure falls below that level. The user may 
then export the freezing episodes to a text file.

The procedural approach here is to use the Levels Editor to define the freezing 
threshold and apply it to the Motion Measure data generated by CinePlex Studio, 
and then import it into CinePlex Editor as the “Centroid Motion” Scalar marker. 
This generates occurrences of a newly labelled “Rat Froze” marker. The user may 
then export this marker to a text file.

Detecting freezing behavior

1 Define a new Interval marker (see “Defining a New Marker” on 
page 169). Label it “Rat Froze”. From the Define New Marker dialog box, 
click Generate Occurrences. This opens the Levels Editor dialog box, 
which is described in detail in “Using the Levels Editor” on page 185.

2 In the Levels Editor dialog box, make sure to select the “Centroid Motion” 
variable in the Scalar Marker To Use list. The display window opens showing 
the Centroid Motion values over the duration of the file.

3 Click Center Lev 1 to get the line to the middle of the display window. Adjust it 
to a reasonable freeze threshold.

4 Since we want to generate intervals when the “Centroid Motion” value falls 
below the threshold, click Below from the list in the first Abv/Blw column for 
the “Rat Froze” line in the grid.

5 Click Generated Selected because we only have one Level Interval marker 
and it is selected. Click Done.

The Marker Occurrences window and the Activity window now show the 
new “Rat Froze” intervals.

6 To write the intervals to a text file, from the File menu, select Export Markers. 
In the Export Marker Data dialog box, accept the default settings, which 
produce a reasonable output file. The user may change the Delimiter to use 
between values, select Export a Row of Column Headers, and clear some 
of the checkboxes under What to Export for Each Marker Occurrences. 
For a more information, see “Export Markers” on page 239. Type a file 
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name and click Export! The Export Complete! dialog box confirms the 
action.

7 Use a text editor such as Windows Notepad to inspect the text file. Most other 
analyses programs can import the text format.

4.6.5 Entering Tracker Coordinates

Suppose that it is desirable to track the movement of some subtle feature on the 
video image. Something that CinePlex Studio cannot track automatically, like 
the position of the tip of a rat's tail.

The procedural approach here is to define a new Coordinates marker, and use the 
Video window to enter—by mouse click—the coordinates that populate the new 
marker. Then, we can use the Interpolate Missing Occurrences tool to fill in the 
in-between frames.

Entering tracking coordinates

1 Define a new Coordinates marker (see “Defining a New Marker” on 
page 169). Label it “Tail Position”.

2 In the Input window, after Left-Click, click Insert. CinePlex Editor is now 
“armed” to create a new occurrence of the “Tail Position” marker whenever 
clicking in the Video window.

3 Decide how often coordinates need to be entered. The default case is to enter 
a Coordinates maker occurrence for each and every video frame. However, 
this means that the video must be advanced frame-by-frame, which can take 
a long time to do the tracking for an entire experimental run. If less accuracy is 
acceptable, it is possible to configure CinePlex Editor automatically to 
advance N video frames each time a coordinated is entered by clicking. This 
means that a “Tail Position” coordinate is entered only every Nth frame, but 
transversing the file occurs N times faster. From the Tools menu, select 
Options, and click the General tab in the Options dialog box. Type the value 
of N into the Number of Frames to Advance During Click-To-Add edit box. 
The default is N = 1, which enters a coordinate for every video frame.

4 Click Play, then Pause, then Rewind to return to the beginning of the file. 
This ensures that CinePlex Editor is ready to take new coordinates.

5 In the Video window, click at the position of the tip of the rat's tail. CinePlex 
Editor enters a new marker occurrence, and advances N video frames.

6 Repeat Step 5 until all the data needed has been gathered.

7 When finished, in the Input window, at Left-Click, click Select to “disarm” 
CinePlex Editor.

8 It is possible to generate automatically new “Tail Position” marker occurrences 
for the skipped frames by interpolating the coordinates between the ones 
entered. This is similar to “key-frame” animation techniques. CinePlex Editor 
interpolates the coordinates mathematically with no regard for the video 
images—the interpolated positions may or may not match the actual 
positions of the rat's tail on the skipped video frames. To perform this 
operation, from the Tools menu, select Interpolate Missing Occurrences; 
for more information, see “Interpolate Missing Occurrences” on 
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page 262. From the Marker list, select Tail Position. Because we want 
coordinates for every frame, in the Timestamp Determination area, click 
Use Frame Marker Times. Click OK to close the dialog box and enter the 
tracking coordinates.

4.6.6 Repairing Tracking Coordinates

Suppose that CinePlex Studio is used to track an LED mounted to the headstage 
on a rat. Occasionally, the cable from the headstage can get between the LED and 
the camera, so the position data for the LED is missing in some frames. Or, sup-
pose something caused the tracker to produce bad coordinates for a few frames, 
possibly caused by some light leaking into the experimental setup that confused 
the tracking algorithms.

In either case, the procedural approach is to put CinePlex Editor into a state 
where the video is advanced frame-by-frame and enter new or replacement 
tracker coordinates by clicking in the Video window at the desired location. 

Repairing tracking coordinates

1 In the Markers window, select the Coordinates marker to repair. Click Show. 
To minimize confusion during the procedure, clear Show for other Coordinate 
markers (if present).

2 For the following procedure to work, the Coordinates markers must be aligned 
to the Frame marker times by using the Snap-to Marker Occurrences dialog 
box, for more information, see “Snap-To Marker Occurrences” on 
page 193. Follow the procedure outlined in that section to align the 
Coordinate markers to the Frame markers.

3 Locate a section of time that has bad or missing values for the selected 
Coordinate marker that needs to be repaired. Pause the playback at the first 
frame with bad or missing coordinates.

4 From the Tools menu, click Options, and in the Options dialog box click the 
General tab. Make sure that the the selection in the Number of Frames to 
Advance During Click-To-Add box is 1 (the default). Also, from the Animate 
menu, select Lock To Video Frames.

5 In the Input window, at Left-Click, click Insert. This “arms” CinePlex Editor 
to enter new (or replace existing) marker occurrences when clicking the left 
mouse button in the Video window.

6 Position the mouse cursor where the new (or replacement) coordinate needs 
to be and click.

The position is entered (or updated) and the video automatically advances by 
one frame.
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7 Repeat Step 6 until all the coordinates are entered or repaired. Move the file 
forward to the next episode of bad tracking coordinates and repeat.

8 When finished, from the File menu, click Save. The user may save and export 
the new or updated positions like any other marker data.

4.6.7 Simple Place Cell Analysis

Suppose it is suspected that a certain neuron seems to fire only when the rat is in 
his nest. As a procedural approach to test this hypothesis, a new Zone Interval 
marker could be defined that defines the boundaries of the rat's nest. The gener-
ated occurrences of this marker represent the intervals during which the rat was in 
its nest. NeuroExplorer could then be used to search for correlations between 
neural firing rates and this interval.

1 Advance the video until a frame shows where the outline of the desired Zone 
(the nest) is clearly visible.

2 Define a new Zone Interval marker (see “Defining Markers” on page 175). 
Label it “Rat In Nest”. In the Define New Marker dialog box, click Generate 
Occurrences to open the Zones Editor dialog box (see “Zones Editor” on 
page 256).

3 In the Coordinates of the Selected Zone area, click Add and then click the 
left mouse button repeatedly in the video window in order to define the outline 
of the nest. Before completely closing the contour, click the right mouse 
button, which closes the contour.

4 In the Coordinates Marker to use list, select the appropriate Coordinates 
marker, and click Generate Selected. This generates occurrences of the new 
“Rat In Nest” marker. Click Done to close the Zones Editor dialog box.

5 To inspect the “Rat In Nest” intervals, use the Find Marker Occurrences 
dialog box (see “Find Marker Occurrences” on page 253) to quickly 
advance through all the occurrences of the “Rat In Nest” marker. It is also 
possible to use the Marker Occurrences window (see “Marker 
Occurrences Window” on page 229) to remove any undesirable “Rat In 
Nest” occurrences.

6 From the File menu, click Export to NEX (see “Export to NEX” on 
page 244) to write the data to a NEX file for subsequent analysis. The “Rat In 
Nest” marker shows up as an interval variable in NeuroExplorer.



4  

208      CinePlex



Plexon Inc

CinePlex 209

Chapter 5 
CinePlex Editor Reference

5.1 Overview........................................................................210

5.2 Main Window ................................................................211

5.3 Menus.............................................................................235

5.4 Toolbars..........................................................................273

5.5 How CinePlex Editor Creates Initial Project Files ........275

5.6 Understanding Markers and Marker Occurrences .........278

5.7 Correcting for Video Latency ........................................282

5.8 Aligning Tracker Coordinates to Frames.......................284

5.9 Interpreting Frame and Event Timestamps....................286

5.10 Analyzing CinePlex Studio data with NeuroExplorer .287



5  

210        CinePlex

5.1 Overview

This chapter contains detailed reference information about menus, toolbars, dia-
log boxes, and windows for CinePlex Editor. By default, the Welcome To Cine-
Plex Editor dialog box appears when CinePlex Editor starts. This dialog box 
provides streamlined access to operations that are also available under the File 
menu. 

• Start a New CinePlex Project - This button starts the New Project Wiz-
ard, which assists in setting up a new CinePlex project. See “New Project” on 
page 235.

• Open an Existing CinePlex Project - This button opens a file browser 
that allows selection of an existing CPJ file.

• Open the Selected Recent CinePlex Project - This button operates on 
the list box of the most recently used CPJ files. Select one and click Open the 
Selected Recent CinePlex Project to load that project. Alternately, double-
click the project CPJ file in the list box to open it.

The user can choose whether or not the welcomes dialog box appears after Cine-
Plex Editor is started; to prevent the dialog box from appearing, click Do not 
show this dialog box on startup. To have the dialog box reappear, from the 
Tools menu, click Options, click the Display tab, and select Initially show 'Wel-
come To CinePlex' Dialog Box.
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5.2 Main Window

This section describes the CinePlex Editor Main window as shown below.

5.2.1 Video Window

The Video window by default is in the upper-right corner of the main window.

5.2.1.1 Function

The Video window displays the current frame of the video file. If the timecode 
and/or filename were inserted into the video, they are also displayed.

Video WindowMenu and Toolbar

Markers 
Window

Input 
Window

Channels 
Window

Activity 
Window

‘__’ Marker Occurrences Window
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5.2.1.2 Features

Features of the Video window include:

• Customizable Window - The user may customize the user interface. Cine-
Plex Editor features a docking window architecture (see “Windows” on 
page 6) that enables the user to

— float individual windows to any location

— dock windows to various positions

— close windows as needed 

— resize windows by clicking and dragging the splitter bars that divide 
them.

• Resizable Video - By default, the Video window stretches or shrinks the 
native video resolution (typically 640 X 480) to match the size of the Video 
window. The user may also configure it to always show the video at its native 
resolution regardless of the size of the Video window by unchecking the 
Resize Video to Fit Window item on the right-click menu.

• Coordinate Marker Crosshairs - If coordinate markers are present with 
their Show checkboxes selected, the coordinates in effect for the current 
video frame appear as crosshairs superimposed over the video image. The 
crosshairs appear in the display color set for the coordinate marker. The range 
for coordinates is always (0,0) to (1023,767) with (0,0) being in the lower-left 
corner, regardless of the video resolution. Before plotting the crosshairs, 
CinePlex Editor scales the marker coordinates to the video resolution.  Also, 
the coordinates that appear in the Video window are always those that are rel-
evant for the frame in the display—not necessarily the selected marker occur-
rences. That is, if different coordinate marker occurrences are selected in the 
Marker Occurrences window, in general it does not change the coordinate 
crosshairs shown in the Video window. Note that if coordinates have not been 
computed or supplied for a frame, the values for the prior frame are used.

• Grid Lines - The user has the option of showing grid lines overlaid on the 
video and also determining the spacing and color of the grid lines.

• Tails - While the video plays, it is possible to show the crosshairs with a tail 
line that shows the coordinate positions of previous frames. The length and 
width of this tail may be configured. By default, the tail changes color accord-
ing to the age of the points. The tail color results from a blending of the 
marker color with another specified color; the blending amount increases for 
older points. If a Fade-to Color similar to the background color of the video 
is chosen, a fading effect is created that makes the tail appear to fade away. If 
the current time frame is rapidly advanced by using either the find functions 
or the Activity window scroll bar, CinePlex Editor can produce a confusing 
display for the rendered tails. In this case, from the right-click menu, select 
Clear Tails to erase the tail. Also, the user may draw a complete version of 
the tail by selecting Show Complete Tail from the right-click menu. The 
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Show Complete Tail feature is useful, for example, for determining the loca-
tions visited by the tracked animal. If the mouse pointer is moved outside of 
the Video window, the complete tail is erased. This menu item shows a line 
connecting the coordinates for all marker occurrences for the Coordinates 
marker, as shown in the following illustration:

5.2.1.3 Video Right-click Menu

The right-click menu allows changing of the behavior of the window, which 
includes controlling the tail rendering and stretching the video. Click the right 
mouse button to open the right-click menu for the Video window: 

• Resize Video To Fit Window - When checked, this item resizes the video 
to fit the Video window. When unchecked, the video appears at its native res-
olution regardless of the size of the Video window.

• Clear Tails - Clicking this item clears the tails from the video window if the 
Render Tails checkbox has been set on the Video View Properties dialog 
box.

• Show Complete Tail - Clicking this item shows the complete tail from the 
whole video file if the Render Tails checkbox has been set on the Video 
View Properties dialog box.

• Properties - Clicking this item opens the Video View Properties dialog 
box. The properties are discussed below.
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— Resize Video to Fit Window - This item stretches or shrinks the video 
to fit the size of the Video window. If not checked, the video is shown 
at its native resolution of 640x480 pixels.

— Rendering - This area contains items that controls how the video is 
presented in the Video window:

– Coordinate Marker Crosshairs Size – This item controls the size 
of the crosshairs drawn at the current Coordinates marker position.

– Draw Grid Lines – This item draws a grid of lines over the Video 
window. 

– Spacing – This item controls the spacing of the grid lines, which 
appear in Coordinates marker units of (0,0) to (1023,767).

– Color – This item controls the color of the grid lines. Select a color 
from the drop-down list.

— Tails - This area contains items that control the appearance of the track-
ing tell tails:

– Render Tails – This item toggles on or off the rendering of the tails 
that show previous Coordinates marker positions. 

– Length – This item controls the length of the tails, which is mea-
sured by the number of previous positions that appear in the win-
dow. 

– Line Width – This item controls the width of the line used to draw 
tails, which is measured in marker occurrences.

– Fade – This item controls whether or not the tail fades away.

– Fade-to Color – This item controls the color to which the tails 
fade. Fading occurs as follows:
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The color drawn at point p in the tail, where p = 0 for the current position and 
p = L (Length) for the oldest position is:
the rendered color at p = (p/L) x FC + (1-(p/L)) x DC
where
DC = display color for the current Coordinates marker
FC = Fade-to Color

— Previous Position Dots Along Tails – This area contains the items that 
control the rendering of the small dots that indicate the previous posi-
tions:

– Color – This item controls the color of the small dots at the coordi-
nates of previous marker occurrences. 

– Size – This item controls the size in marker occurrences of the 
small dots at the coordinates of previous Coordinates marker occur-
rences. 

– Draw Every – This item controls a factor that only draws a dot at 
every Nth previous position.

– The illustration below shows a segment of the Video window with 
larger previous-position dots and Draw Grid Lines enabled.
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5.2.2 Activity Window

In many ways, the Activity window is the heart of CinePlex Editor. The default 
docking position is at the bottom of the main window. This truncated view shows 
each important item or area in the Activity window. 

5.2.2.1 Function

The Activity window displays markers and marker occurrences against their 
associated timelines.

5.2.2.2 Features

This section describes the various elements in the Activity window as shown in 
the illustration above.

• Channel Zoom Controls - The vertical zoom buttons appear at the left 
side under the top banner of the Activity window, as the illustration below 
shows. Click + to vertically zoom in on the display so that fewer time-lines 
appear, but each time-line is taller. This is the equivalent of selecting Zoom 

In to Show Fewer Time-lines from the right-click menu. Click – to zoom 
out, which is the equivalent of selecting Zoom Out to show More Time-
lines from the right-click menu. The user may also vertically scroll the time-
lines in any of the following ways:

— If the mouse has a wheel, by rotating it. This works when the mouse 
pointer is positioned anywhere inside the Activity window.

Channel Zoom Controls

Time Range Zoom Controls
Marker and Unit Labels

Time Range Scroll Bar

Times of Unit Firings

Marker Times

Current File Position
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— By pressing the PAGE UP or PAGE DOWN keys

— By dragging in the vertical direction in the label area 

• Marker and Unit Labels - A label for each time-line appears on the left 
side of the Activity window. The user may resize the label area by dragging 
the dividing line between it and the rest of the window. By default, CinePlex 
Editor selects the Automatically Adjust Label Area Width item in the 
right-click menu, which means that the dividing line continually adjusts so 
that the labels fit into the label area. To keep the size of the label area con-
stant, click to clear the Automatically Adjust Label Area Width item in the 
right-click menu; this means the beginning of larger marker names can get 
truncated. If the divider line is dragged, CinePlex Editor automatically clears 
the Automatically Adjust Label Area Width item.

• Time Range Zoom Controls - The bottom of the Activity window con-
tains the Zoom Out button, the Zoom In button, and the scrollbar for 
expanding, contracting, and moving the time range displayed by the Activity 
window. Each end contains boxes showing the current minimum and maxi-
mum extents of the displayed time range in seconds. 

• Time Range Scroll Bar - Use the scroll bar at the bottom of the display to 
move the time span of the display. When the scroll bar is moved, the video 
frame that appears in the Video window is always updated to remain synchro-
nized with the Activity window.

• Times of Unit Firings, Marker Times - The central area of the Activity 
window shows the times of marker occurrences and unit firings as colored 
tick marks that are arranged along horizontal time-lines. By default, Cine-
Plex Editor provides a horizontal time-line on the display for each marker or 
spike channel whose Show column is checked in the Markers window or the 
Channels window. The color of the marker ticks results from the display-
color setting in the Markers window. The colors of the tick marks on the time-
lines for spike channels correspond to the unit classification of each spike. 
The user may set the colors to associate with each unit; to do so, from the 
Tools menu, select Options and click the Colors tab. Also, if their respective 
Show column in Channels window is checked, CinePlex Editor provides 
line traces on the display for continuous data channels. To improve clarity, the 
Activity window devotes twice as much vertical space to the continuous data 
channels than it does to the marker or spike channels. The user may drag the 
dividing line that separates the central area from the top banner. The user may 
also drag a selected marker occurrence to a different time. To drag a marker 
occurrence to a new time, hold down the SHIFT key, click the marker occur-
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rence, and drag it to a new time. For Interval-type markers, the start and end 
times may be independently adjusted. For more information on the Activity 
window, see “Selecting and Editing Marker Occurrences” on page 196. When 
CinePlex Editor is appropriately configured, click the mouse in the Activity 
window to perform the following actions:

— Select the marker occurrence for the currently selected marker nearest 
in time (default). Double click to select a new current marker.

— Add a new marker occurrence

— Change the timestamp of an existing marker occurrence

• Current File Position - The top banner contains the now triangle, which 
denotes and displays the current time (or current file position). The current 
time indicator (now triangle) is the white triangle in the following illustration. 
The current time (t) in seconds appears to the left of the triangle, and the cur-
rent video frame (F) number appears to the right of it. By default, CinePlex 
Editor positions the triangle in the center of the Activity window, but it can be 
dragged to a new location in the top banner. This causes the Activity window 
to display an asymmetric range for the activity surrounding the triangle. For 
example, from 1 second before to 3 seconds after the triangle position. The 
user may control the time range shown. The range surrounds the current time, 
which is denoted by the small triangle at the top of the display. The text next 
to the triangle shows the current time (in seconds) and the current frame num-
ber. The user may click and drag the current time triangle to a different posi-
tion within the window of time shown.

5.2.2.3 Activity Right-click Menu

The Activity window has many options that can be controlled by using the right-
click menu.
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• Automatically Adjust Label Area Width - This item causes the dividing 
line between the labels on the left and the central portion of the view to auto-
matically adjust to accommodate the longest marker name.

• Show Unsorted Spikes - Selected by default, this item shows tick marks 
for unsorted spikes in the color chosen to represent unsorted spikes, or else 
the spikes do not appear.

• Hide Invalidated Spikes - Selected by default, this item hides tick marks 
for invalidated spikes; clearing this item causes tick marks to appear in a dark 
grey color.

• Show All Units for a Channel on One Time-line - Selected by default, 
this item plots each spike channel with a single time-line, and plots spikes 
with different units from that channel on the same time-line, but with differ-
ent colors according to their unit classification. Clearing this item causes each 
unit to appear on a separate time-line. The channel name plus a letter of the 
alphabet denoting the unit appear as a label for the per-unit timelines. That is, 
if the channel sig001 has two defined units and some unsorted spikes and if 
Show Unsorted Spikes is checked, there are 3 time-lines for that channel, 
which appear as sig001U (unsorted), sig001a, and sig001b.

• Show Markers Across All Time-lines - Normally, each marker appears 
as its own time-line in the display. Select this item to make each marker 
appear as a vertical line drawn across all of the other channels. This arrange-
ment makes it somewhat easier to tell when marker occurrences happened 
with respect to spikes. The following illustration shows the Activity window 
with the Show All Units for a Channel on One Time-line item cleared and 
the Show Markers Across All Time-lines item selected:

• Show Markers On Top Time-lines - Selected by default, this item shows 
the time-lines for the markers at the top of the view, before the spike or con-
tinuous channel time-lines. Clearing this item causes the marker channels to 
appear at the bottom. This item is only relevant if the Show Markers Across 
All Time-lines item is cleared.

• Show Line for Each Time-line - This item draws a horizontal line in the 
middle of each time-line.

• Zoom Out ..., Zoom In to Show Fewer Time-lines - As previously dis-
cussed, this item shows more or fewer time-lines.
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5.2.3 Markers Window

The Markers window is the central location for information about markers. The 
illustration below shows the Markers window.

5.2.3.1 Function

The Markers window shows a quick overview of the important properties of the 
markers defined in the current project, and it provides easy access to all marker-
related operations.

5.2.3.2 Features

A >> in the leftmost column indicates the currently selected marker. The columns 
in the Markers window show the following information about each marker:

• Name – Shows the name given to each marker.

• Type – Indicates the marker type, as listed in “Table 5-1” on page 5-278.

• Count – Shows the number of occurrences of this marker.

• Key – Indicates the keyboard key associated with the marker.

• Show – When selected, this item displays the occurrences of this marker in 
the Activity window, and also in the Video or Scalar windows as appropriate 
for the marker type.

• Display Color – Shows the color used to display occurrences of this marker 
in the Activity, Video, or Scalar windows. Click a marker in the Display 
Color column to open a color selection dialog box, which allows changing 
the display color for a marker. 

5.2.3.3 Markers Right-click Menu

Right-clicking the mouse in the Markers window opens a right-click menu.

• Define New Marker - This item opens the Define New Marker dialog box.
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— Type - In the Type area, select a marker type for the new marker. For a 
description of all marker types, see “Table 5-1” on page 5-278. Under 
most circumstances, a new Frame marker cannot be created.

— Name - Enter a unique name for the new marker. Marker names must 
be unique. 

— Comment - This is an optional box in which a free-form comment that 
describes the new marker may be typed.

— Associated Keystroke - This area identifies the keystroke that is asso-
ciated with this marker, which can be used for finding or inserting new 
marker occurrences. CinePlex Editor suggests an unused key; click 
Change to open the Assign Key dialog box and select a different key. 
When the dialog box appears, press the key to associate and click OK.

Note: Only single-keystrokes (not CTRL- or ALT- key combinations) can be associ-
ated with Markers.

— Display - This area identifies the display color and the show setting for 
the marker.

– Color – This box shows the display color for this marker in various 
windows. The user may also set the color directly in the Marker 
window.

– Show – This item toggles the appearance of the Marker in various 
windows. The user may also set this item directly in the Marker 
window.

— Event IDs - This area shows the Event IDs associated with the marker. 
Use these IDs only when this marker is exported to a PLX file. These 
event IDs are the Plexon external event IDs that represent this marker 
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in the PLX file. For interval-type markers, a second event ID must be 
specified to represent the end time for the interval. 

Note: These IDs must be unique across all markers. CinePlex Editor suggests an 
unused and unique value for these IDs, so they do not usually require immedi-
ate attention when the marker is first created. If the data is exported to a PLX 
file, there will be an opportunity to change these event IDs.

Note: The user may also click Generate Occurrences to have CinePlex Editor cre-
ate the marker and also automatically populate the new marker with algorithmi-
cally-generated marker occurrences. The available methods for automatically 
populating the marker with marker occurrences varies by marker type; for a 
description, see “Automatically Generating Marker Occurrences” on 
page 183.

— OK - Click OK to close the dialog box and create the new marker. 

• Edit Selected Marker - This item opens the Edit Marker dialog box.

Note: The user may also open the Edit Marker dialog box from the right-click menus 
in the Markers and _Marker Occurrences windows.

The marker type cannot be changed for an existing marker. However, it is possi-
ble to change the following marker items:

— Name - Enter a unique marker name. Marker names must be unique. 
Duplicates are not accepted during the Add Marker process.

— Comment - Add, add to, or edit a free-form comment that describes the 
marker.

— Associated Keystroke - This area identifies the keystroke that is asso-
ciated with this marker; click Change to open the Assign Key dialog 
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box and select a different key. When the Assign Key dialog box 
appears, press the key to associate and click OK.

Note: Only single-keystrokes can be associated with markers. CTRL- or ALT- key 
combinations are not valid.

— Display - This area identifies the display color and the show setting for 
the marker.

– Color – This box shows the display color of this marker in various 
windows. Select a new color from the drop-down list.

– Show – This item toggles the appearance of the marker in various 
windows. Change as needed.

— Event IDs - This area shows the Event IDs associated with the marker. 
These event IDs are used when this marker is exported to a PLX file; 
for more information, see Event IDs on page 5-246. Change the event 
IDs as needed.

• Delete Selected Marker - This item deletes the selected marker and all of 
its occurrences.

• Delete All Highlighted Markers - This item deletes all selected markers 
and all of their occurrences.

• Delete All Occurrences of Selected Marker - This item deletes all of 
the occurrences of the selected marker, but does not delete the selected 
marker.

• Make Copy of Selected Marker - This item copies the selected marker to 
the clipboard.

• Set As Top Row - Sets the highlighted items in the Show or Display Color 
columns to the same value or color as the topmost value. 

• Randomize Display Colors - Sets random colors for all of the Display 
Color items.

5.2.4 Input Window

5.2.4.1 Function

The Input window consists of an area of option buttons (left side of window) and 
an array of marker buttons (right side of window). The option buttons control the 
operation occurring with keystrokes, the marker buttons, or the left mouse button.
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5.2.4.2 Features

The Input window includes selections for the following three actions:

• Keystroke – The user may bind a keystroke to the current marker, which 
can be used to Find the next occurrence of the marker or Insert a new occur-
rence of the marker.

Note: If CinePlex Editor is in looping mode (see “Understanding Loop-
ing” on page 174), the search for the next marker occurrence wraps 
around the end of the file and continues the search at the beginning.

• Button – Specific marker buttons appear in the array on the right side of the 
Input window. Click a marker button to Find the next occurrence of the 
marker or Insert a new occurrence of the marker.

• Left-Click – This item refers to a click of the left mouse button in the Activ-
ity window. Select finds the nearest occurrence of the selected marker. Insert 
inserts a new occurrence of the selected marker at the time corresponding to 
the mouse pointer position when the left mouse button is clicked.

5.2.5 Channels Window

5.2.5.1 Function

The Channels window displays all of the channels in the neural data file and 
their associated properties.

5.2.5.2 Features

The columns in the Channels window list the following information for each 
channel:

• Name – Shows the name of the channel

• Type – Indicates the type of channel, either spike or continuous

• Count – Shows the number of spikes for spike channels, or the number of 
samples for continuous channels

• Show – When selected, shows the spikes or continuous data from that chan-
nel in the Activity window

• Unsorted, Unit a, b, c, ... – Indicates the number of spikes in the channels 
that are unsorted, or that belong to Unit a, Unit b, etc.
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Note: By default, if the Show checkbox is clear, any continuous data channels in the 
neural data file do not appear in the Activity window.

5.2.5.3 Channels Right-click Menu

Clicking the right mouse button will open a right-click menu with the following 
items:

• Show All Channels With Spikes - Clicking this item resets the window 
to show all channels with spikes.

• Un-Show All Channels - Clicking this item resets the window to hide all 
channels.

• Show Only Selected Channel - Clicking this item resets the window to 
only show the selected channel.

• Set As Top Row - Clicking this item sets selected columns to the same 
value as the same columns in the top row.

5.2.6 File Info Window

The File Info window does not appear by default. To open the File Info window, 
from the View menu, select File Info View. 
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5.2.6.1 Function

The File Info window shows various items of information about the neural data 
files and video files that are currently loaded into CinePlex Editor.

5.2.6.2 Features

The File Info window contains the following items:

• CinePlex Project File - This area contains information about the currently 
opened CinePlex project file.

— File Name: - This item contains the name of the project file.

— Comment: - This editable item contains comments about the project 
file.

• Video Data File - This area contains information about the currently opened 
video data file.

— File Name: - This item contains the name of the video data file.

— Time & Date (from file): - This item contains the time and date that 
the video data file was last modified.

— Video Size: - This item contains the resolution of the video data file. 
Default is 640 X 480.

— Frame Rate: - This item contains the frame rate of the video data file. 
Default is 30 frames per second.

— Number of Frames: - This item contains the total number of frames in 
the video data file.

— Has Timestamps: - This item indicates if the frames are timestamped 
or not.

• Neural Data File - This area contains information about the currently 
opened neural data file.

— File Name: - This item contains the name of the neural data file.

— Time & Date (from header): - This item contains the time and date 
that the neural data file was last modified.

— Comment: - This item contains comments about the neural data file. 
This field is not editable in the File Info window.

— File Size (bytes): - This item contains the size of the neural data file in 
bytes.

— Experiment Length (sec): - This item contains the duration of the 
experiment in seconds.

— Format Version: - this item contains the format version of the file.

— Channels: - This item contains the total number of channels.
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— Data Type: - This item contains the data type. Values are Single or 
Trodal.

— Timestamp Frequency (Hz): - This item contains the frequency at 
which the timestamps are created. Default is 40,000 Hz.

— A/D Frequency (Hz): - This item contains the analog-to-digital fre-
quency. Default is 40,000 Hz.

— Total Number of Waveforms: - This item contains the total number of 
waveforms in the neural data file.

— Cont. Channels: - This item contains the number of continuous chan-
nels.

— Peak Voltage (mV): - This item contains the peak voltage of the sig-
nals in millivolts.

— A/D Resolution (bits): - This item contains the analog-to-digital reso-
lution in bits. Default is 12.

— Total Number of Units: - This item contains the total number of 
occurrences for all channels.

— Number of Channels with Units: - This item contains the number of 
channels that have units.

— Avg Units per Active Chan: - This item contains the ratio of Total 
Number of Units to Number of Channels with Units.

5.2.7 Audio Output Window

The Audio Output window is hidden by default. To open the Audio Output win-
dow, hover the mouse over the Audio tab of the sidebar tabs at the right side of 
the screen, select Audio Output from the View menu, or click the Audio Output 
View button on the toolbar. The illustration below shows the Audio Output win-
dow.

5.2.7.1 Function

The Audio Output window controls CinePlex Editor’s ability to play a sound 
through the computer’s audio system when Markers or neural spikes occur during 
data playback.
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5.2.7.2 Features

The columns of the Audio Output window include:

• Name - This column contains the name of each marker.

• Type - This column contains the type of each marker.

• Count - This column contains the number of occurrences of each marker.

• Play - This column contains a checkbox that controls whether any sound will 
be played when the Markers or neural spikes of that type pass by the ‘current 
time’ marker during animated playback.

• Sound - This column contains a droplist that lists all the available sounds 
that CinePlex Editor can play. If the Play checkbox is checked, the sound 
selected in the Droplist will play when an occurrence of the corresponding 
Marker or neural spike is encountered during playback. The contents of this 
list can be controlled from the Audio tab of the Tools | Options... dialog, see 
“Options” on page 264.

5.2.7.3 Audio Output Right-click Menu

The Audio Output Window has a right-click context menu that contains the fol-
lowing menu entries:

• Show Units - The Audio Output view can show just one line per neural 
spike channel (the default). In this mode, CinePlex Editor will play the same 
selected sound when any spike occurs on that channel, regardless of the unit 
designation of that spike. When Show Units is checked, each unit on each 
channel gets a separate line, as shown in the above screenshot. In this mode, 
every unit can have a different sound mapped to it and can be independently 
enabled or disabled for playing. This selection is equivalent to checking or 
unchecking the ‘Show Units in the Audio Output Window’ checkbox on the 
Tools | Options | Audio tab.

• Select Sounds - Clicking this item will show the Audio tab on the Tools | 
Options dialog box, which allows loading new sounds from WAV files so that 
they are available for mapping to Markers or Units.

5.2.8 Messages Window

To open the Messages window (hidden by default), hover the mouse over the 
Messages tab of the sidebar tabs at the right side of the screen, select Messages 
from the View menu, or click the Messages View button on the toolbar.
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5.2.8.1 Function

The Messages window displays timestamps and application events and is used 
for troubleshooting purposes by Plexon Support.

5.2.8.2 Features

• Time - This column contains timestamps of the events.

• Message - This column contains descriptions of the events.

5.2.8.3 Messages Right-click Menu

Right-clicking the mouse in the Messages window displays the right-click menu.

• Erase - Clicking this item erases all messages from the Messages window.

• Pause - If this item is checked, message logging is paused.

• Show Debug Messages - If this item is checked, then debug messages 
will appear in the Messages window. This can be useful for troubleshooting.

• Select and Copy All - Clicking this item selects all the messages and cop-
ies them to the clipboard.

• Save Log to File - Clicking this item displays a standard file save dialog 
box and allows the message log to be saved to a file.

• Mail Log to Plexon - Clicking this item will sent the messages log to 
Plexon for troubleshooting. Note that a mail client and associated account 
information must be present on the computer for E-mail to work.

5.2.9 Marker Occurrences Window

The Marker Occurrences window includes an entry for each occurrence of the 
currently-selected marker. The currently-selected marker occurrence appears 
with a > in the first column. Click any marker to make it the currently-selected 
marker. More than one Marker Occurrences window may be opened. The win-
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dow also changes title and columns depending on the marker type of the cur-
rently-selected marker. 

5.2.9.1 Function

The function of the Marker Occurrences window is to display information 
about all occurrences of the currently selected marker.

5.2.9.2 Features

The features of the Marker Occurrences window will vary according to the type 
of selected marker. A coordinate marker will have the timestamp, an x-coordi-
nate, and a y-coordinate while an interval marker will have the beginning times-
tamp and the ending timestamp as shown in the illustrations below.

Scrolling the Activity window or animate time causes the Marker Occurrences 
window to update continually to show the marker occurrences closest to the cur-
rent time.

5.2.9.3 Marker Occurrences Right-click Menu

Right-clicking the mouse in the Marker Occurrences window opens a right-
click menu.

• Go to Selected Marker Occurrence Time - Clicking this item makes the 
time of the currently-selected marker occurrence the current time. This will 
advance the current frame and reposition the Activity window.
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• Add, Edit, and Delete Marker Occurrence Menu Items - The items in 
the section below ‘Go to Selected Marker Occurrence Time’ except for 
“Delete Highlighted Marker Occurrences” are the same as the items on the 
Edit menu. For complete information, see “Edit Menu” on page 245.

There are three different ways to display marker occurrence data:

• Show Values in Decimal - Clicking this item displays the marker occur-
rence data in normal decimal format.

• Show Values in Hex - Clicking this item displays the marker occurrence 
data in hexadecimal format.

• Show Values as VT Bit Fields - Clicking this item displays the marker 
occurrence data as VideoTracker (VT) bit fields. For more information on VT 
bit fields, see “Digital VideoTracker (DVT) Files” on page 156.

• Copy and Select All - These items function as standard Windows copy and 
select functions.

• Properties - Clicking this item displays the Marker Occurrences View 
Properties dialog box.Clicking this item enables the configuration of marker 
occurrence windows to show the marker occurrences of a specific marker 
instead of the currently selected marker. This capability may be used to dis-
play marker occurrences simultaneously for different markers on screen.

— Marker To Display - This area contains a drop-down list of markers. 
The currently selected marker appears in the dimmed list box.

— Display Format for Scalar Marker Values - This area contains items 
that control the display format for Scalar markers:

– Decimal – This item displays the Scalar markers in decimal format.

– Hex – This item displays the Scalar markers in hexadecimal format.

– VideoTracker – This item displays the Scalar markers in Plexon 
VideoTracker format.
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5.2.10 Scalar Window

Scalar windows do not appear by default in CinePlex Editor. To open a Scalar 
window, from the View menu, select New Scalar View.

5.2.10.1 Function

The Scalar window provides an at-a-glance graphical representation of a scalar 
value as a pointer arrow on a scale.

5.2.10.2 Features

The Scalar window re-orients itself depending on the size of the view. If the Sca-
lar window is tall and narrow, the pointer points horizontally. If the Scalar win-
dow is short and wide, the pointer points vertically. Like the coordinate crosshairs 
in the Video window, the position of the pointer always reflects the value for the 
selected marker occurrence. The numerical value also appears next to the pointer. 
Like the Marker Occurrences window, there can be multiple Scalar windows 
on the screen at once, with each one showing a different scalar marker. 

5.2.10.3 Scalar Right-click Menu

Right-clicking in the Scalar window displays the following menu:

• Reverse Arrow Direction - By default, the Scalar window re-orients itself 
depending on its size. If the Scalar window is tall and narrow, the arrow is 
horizontal. If the Scalar window is short and wide, the arrow is vertical. By 
default, the arrow points either left or up, but the direction may be reversed by 
selecting Reverse Arrow Direction from the right-click menu. The position 
of the arrow always reflects the value for the selected marker occurrence. As 
shown in the following illustration, the numerical value of the selected scalar 
marker occurrence also appears at the base of the arrow.

Like the Marker Occurrences window, there can be multiple Scalar windows on 
screen at once, with each one showing a different Scalar marker. 
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• Reset Automatic Range Adjustment - By default, CinePlex Editor 
automatically adjusts the range of scalar values to accommodate the range of 
scalar values that appear in the data as new Scalar values become current. The 
user may reset the range by selecting Reset Automatic Range Adjustment 
from the right-click menu, which sets the range to dynamically expand based 
on the subsequent values that appear. Alternately, a fixed range may be set in 
the Scalar View Properties dialog box.

• Properties - Clicking the Properties item displays the Scalar View Prop-
erties dialog box.

— Marker To Display - This area contains the items that control which 
marker appears in the Scalar window:

– Use Selected Marker – This item displays the current value for a 
new marker in the Scalar window, if the marker is a Scalar type. 

– List box – Clearing Use Selected Marker causes the Scalar win-
dow to display the values of the Scalar marker that appears in the 
drop-down list, regardless of which marker is selected.

— Layout - The area contains the items that control the appearance of the 
Scalar window:

– Automatic – This item sets the Scalar window to automatically 
switch its layout from horizontal to vertical based on the current 
size of the Scalar window. For example, if the window is taller than 
it is wide, a vertical layout appears, otherwise a horizontal layout 
appears. 

– Horizontal – This item sets the Scalar window to a horizontal lay-
out, regardless of the dimensions of the Scalar window.

– Vertical – This item sets the Scalar window to a vertical layout, 
regardless of the dimensions of the Scalar window.
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– Reverse Arrow Direction – This item toggles the direction that the 
indicator arrow points between up/down for horizontal layouts and 
left/right for vertical layouts.

— Range to Plot - This area contains the minimum and maximum values 
to show on the scale:

– Automatically Set Range from the Data – This item automati-
cally and dynamically adjusts the range as new values are encoun-
tered in the Scalar marker occurrences. The current range being 
plotted always appear dimmed in the Minimum and Maximum 
boxes. 

– Fixed Range – This item allows entering specific values for the 
range in the Minimum and Maximum boxes.
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5.3 Menus

Menus provide access to CinePlex Editor features, commands, controls, and set-
tings. The following sections describe each CinePlex Editor menu in detail. The 
user may also use the toolbar buttons to execute many of the commands that 
appear on the CinePlex Editor menus.

5.3.1 File Menu

The following illustration shows the File menu. 

5.3.1.1 New Project

This item opens the New Project Wizard dialog box which proceeds through the 
necessary steps to set up a new project. In the Welcome To CinePlex dialog box, 
click Start a New CinePlex Project to open the New Project Wizard dialog 
box. Otherwise, from the File menu, click New Project.
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The first box in the New Project Wizard dialog box helps to select filenames. 

Note: Specify a video file or a neural data file, or both.

• Video Data Input File (AVI) - This box allows the user to specify a file-
name for the video file. The video file must be an Audio Video Interleave 
(AVI) file. 

• Neural Data Input File (PLX, NEX, DVT) - This box allows the user to 
specify a file name for the neural data file. The neural data file can be a 
Plexon data (PLX) file, a NeuroExplorer (NEX) file, or a digital video tracker 
(DVT) file.

• CinePlex Project File (CPJ) - This box requires the user to specify a file-
name for the CinePlex Project (CPJ) file.

• Browse - This button allows the user to open a file selection dialog box. 
When one filename is selected, CinePlex Editor suggests names for the 
remaining unspecified filenames, which are based on the selected filename. 

• Select From Directories - This button opens the Select Video and Neural 
Data Files dialog box, which provides a convenient alternative to Browse, 
where it is possible to display and match pairs of files from two directories. 
The Select Video and Neural Data Files dialog box provides list boxes for 
two different directories. The user may use the various features of this dialog 
box to create project files.
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— Video Data Input File (AVI) - This area displays AVI files, file system 
dates, and times. Click the … button to select a different directory for 
the video data files.

— Neural Data Input File (PLX, NEX, DVT) - This area displays PLX, 
NEX, and DVT files, file system dates, and times. Click the … button 
to select a different directory for the neural data files.

— Sort Files by Date - This checkbox is checked by default and causes 
the files to be sorted by date. Click to clear this checkbox to sort by file 
name. 

— Sync Directories - If this checkbox is checked, it forces the two direc-
tories to be identical, which can save the effort of having to reselect the 
same directory again if the video and neural data files happen to reside 
in the same directory. 

— Neural Data Extensions - These checkboxes allow the user to select 
the extensions for the neural data files to appear in the list box.

Whenever a file is selected from one of the list boxes, the dialog box attempts to 
select the file from the other list box that best matches the file selected. This fea-
ture is very convenient for matching up the files collected using CinePlex Studio 
with their corresponding PLX files, because the file dates and times should be 
nearly the same.

When the correct files have been highlighted in the two directory listings, click 
OK to enter the selected files into the appropriate text boxes in the New Project 
Wizard dialog box. After entering the correct filenames, click Continue >> to 
open the Verify Project Files dialog box.
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The Verify Project Files dialog box provides complete information on the files 
being entered into the project. It lists relevant information for each file type.

• CinePlex Project File - This box lists the project file location and name.

• Video Data File - This box lists the video file location and name.

• Date/Time - This box shows the date and time (hh:mm:ss) when the video 
file was saved.

• Duration - This box indicates the duration of the video file in seconds.

• Frames - This box lists the total number of frames in the video file.

• Frame Rate - This box indicates the frame rate at which the video was 
recorded.

• Resolution - This box shows the resolution of the video in pixels.

• Timestamps Present? - This box indicates Yes if timestamps are con-
tained in the video file and No if otherwise.

• Neural Data File - This box lists the neural file location and name.

• Date/Time - This box shows the date and time (hh:mm:ss) when the neural 
file was saved.

• Duration - This box indicates the duration of the neural file in seconds.

• Channels - This box lists the number of data channels in the neural file.

• Event Types - This box lists the number of different event types contained 
in the neural file.
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After verifying that the correct files have been selected, click Continue >> to exit 
the Wizard. CinePlex Editor creates the initial project file. 

Note: To have the directories containing the files selected appear as the defaults the 
next time CinePlex Editor starts, from the Tools menu, choose Options, click 
the General tab, and select Use the last directory of the previous session 
as Initial Directory.

5.3.1.2 Open Project

This item opens a standard Windows Open dialog box to allow choosing an 
existing project file (CPJ) to open.

5.3.1.3 Save Project, Save Project As, and Close Project

These items apply to a CPJ file and it’s related video file and neural data file. 
These commands use standard Windows dialog boxes.

5.3.1.4 Import Markers

This item opens a standard Windows Open file-selection dialog box. When a file 
is selected, CinePlex Editor imports the file to create new markers in the project; 
for more information, see “Importing Markers” on page 197.

5.3.1.5 Export Markers

This item opens the Export Marker Data dialog box. The Export Marker Data 
dialog box includes all the items to set prior to exporting the file. The following 
illustration shows the default view of the dialog box.

CAUTION
File Relocation
The project file stores the full paths to the video and neural data files. 
If the neural or video data files are moved to another location, Cine-
Plex Editor cannot locate the files when reopening the project file. 
In this case, select the neural or video files, or both, from their new 
locations. Make sure to select the same files that were used in the 
original creation of the project file. Otherwise, the results can be 
very confusing.
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• Format - This area provides a choice of three file types: text, Matlab, or 
Microsoft Excel. 

Note: Matlab or Excel must be installed on the computer where CinePlex Editor is 
running to allow these to be used. If the Matlab file selection or the Excel 
selection, or both, appear dimmed, these format options are unavailable; install 
Matlab or Excel, or both, to enable them.

• Delimiter to use between values - This dropdown allows the user to 
select one of the following delimiters to use between the columns of text (if 
Text File is selected for the format):

— Comma

— Comma, space

— Space

— Semicolon

— Tab 

• Export a Row of Column Headers - If the user selected Text File or 
Excel for the format, this checkbox allows exporting the first row as a row of 
textual labels for each column, which can be helpful when a human is reading 
the exported data file.

Note: CinePlex Editor exports marker occurrences for all formats as one occurrence 
per row, or one occurrence per line for text files, and all rows have the same 
number of columns. The columns in each row depend on the selections made 
in the What to Export for Each Marker Occurrence area. 
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• Which Markers - The default value is Selected Marker only. Selecting All 
Markers causes the occurrences for all markers to be exported, which usually 
results in a confusing output file; in general, Plexon does not recommend this 
option.

• What to Export for Each Marker Occurrence - The selections in this 
area determine which columns appear for each marker occurrence (row). The 
available columns always appear in a fixed order; clearing a checkbox 
removes the column. The available items for export are:

— Marker Name (N/A for Matlab) – This item includes the textual 
name of the marker in the exported file. The marker name is generally 
useful only when selecting All Markers to export, otherwise the 
marker name is the same for all marker occurrences when selecting 
Selected Marker only to export. Because the data is output to MATLAB 
as a two-dimensional array of doubles, this option is unavailable for the 
MATLAB format.

— Marker Type (Number 1-7) – This item exports a number that indi-
cates the type of the marker, as indicated in the following table:

Note: For a complete explanation of the marker types, see “Table 5-1” on 
page 5-278.

— Marker Event ID – This item exports the Event ID associated with 
this marker; for more information, see Event IDs on page 5-246.

— Marker Event ID 2 - This item exports the second Event ID associated 
with this marker. This item applies only if the marker is an Interval, 
Level Interval, or Zone Interval type.

— TimeStamp - This item exports the time of the marker occurrence. For 
Interval-type events, this is the start time. 

Note: The user may export timestamps in units of seconds or in raw clock ticks; see 
“Export TimeStamps in units of”, which follows in this list.

1 Time-only

2 Frame

3 Interval

4 Scalar

5 Coordinates

6 Level Interval

7 Zone Interval
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— TimeStamp2 (End Time for Intervals) - This item is only relevant for 
Interval-type marker occurrences and it exports the end time. 

— Value 1 (Scalar value, or X Coordinate) - This item exports different 
things, which depend on the marker type. For Scalar markers, it exports 
the scalar value. For Coordinate markers, it exports the X coordinate 
value. For all other markers, it exports -1.

— Value 2 (Y Coordinate) - This item exports different things, which 
depend on the marker type. For Coordinate markers, it exports the T 
coordinate value. For all other markers, it exports -1.

— Export TimeStamps in units of – The user may export time stamps in 
one of the following units:

– Seconds – This item exports the values for TimeStamp and 
TimeStamp 2 in seconds.

– Clock Ticks – This item exports the values for TimeStamp and 
TimeStamp 2 in raw ticks of the system clock.

• Output File - Type or select the output file name in the File box. Under For-
mat, if Text file or Excel is selected, click the Append if existing checkbox 
to append the marker data onto the end of a file that already exists on disk. 
Otherwise, the existing file is overwritten.

5.3.1.6 Export to PLX

This item opens the Export To PLX dialog box.
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• File - Type an export file name and path, or click Browse and select an exist-
ing file. 

• Export invalidated spikes - Click this checkbox to export invalidated 
spikes to the PLX file. Invalidated spikes appear with a unit number of 0 
(unsorted).

• Marker Mapping to Event IDs - This list box controls which markers 
appear in the output file and which event IDs represent them. Only Time-
only, Frame, and Interval-type markers appear in this list box; Scalar and 
Coordinates markers must be represented by strobed events. To remove indi-
vidual markers from the output PLX file, click to clear the Write? checkbox. 
The user may also change the event IDs by typing a new value in the Event 
ID column. There are two entries in the list box for each Interval-type marker, 
one for the start time and another for the end time.

• What to Export as Strobed Events - Select one of these items to export:

— Original Strobed Events (Passthrough Mode) – Select this item to 
pass unchanged the strobed event data blocks from the original neural 
data file through to the output PLX file. Use this mode when if not 
interested in representing any changes to any Scalar or Coordinates 
marker occurrences in the output file, or if there are not any Scalar or 
Coordinates data to output.

— Scalar Marker – Select this item to represent the values from a single 
Scalar marker in the strobed events. Select the Scalar marker from the 
list.

— Coordinate Markers – Select one of the following combinations:

– Click LED 1, LED 2, or LED 3 or any combination of these LEDs. 
For each LED, select a corresponding Coordinates marker from the 
drop-down list.

– To export coordinates for the centroid position, click Centroid Pos 
and select a corresponding Coordinates marker from the drop-down 
list.

– To include Motion Measure data, click Centroid Pos and click a 
corresponding Coordinates marker from the drop-down list; then 
click Motion and select a corresponding Scalar marker from the 
drop-down list. For more information on the Motion Measure 
option, see “Motion Measure Option” on page 81.

Note: Select only one of the preceding combinations. If an LED is clicked, 
do not click Centroid Pos. Likewise, do not click Motion without 
clicking Centroid Pos. 

• Export! - Click Export! to close the dialog box and write the new PLX file.
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5.3.1.7 Export to NEX

This item opens the Export To NEX dialog box.

• File - Type an export file name and path, or click Browse and select an exist-
ing file. 

• What to Export - This area includes the following items:

— Frame Markers – CinePlex Editor exports frame markers to the NEX 
file as just another marker variable. To inhibit this, click to clear the 
Frame Markers checkbox.

— Unsorted spike timestamps – CinePlex Editor exports both sorted 
and unsorted spike timestamps to the NEX file by default. To export 
only the sorted spike timestamps, click to clear the Unsorted spike 
timestamps checkbox.

— Continuous data channels – By default, CinePlex Editor exports any 
continuous channels present in the original neural data file as continu-
ous variables to the NEX file. To prevent continuous data being written 
to the NEX file, click to clear the Continuous data channels check-
box.

• Export! - Click Export! to close the dialog box and create a new NEX file.

5.3.1.8 Print, Print Preview, and Print Setup

These items are standard Windows print commands. The Print command will 
output the CPJ file to an installed printing device.

5.3.1.9 File list

This section includes up to 10 of the most recently opened files.

5.3.1.10 Exit

This item closes all windows and exits CinePlex Editor.
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5.3.2 Edit Menu

The following illustration shows the Edit menu. 

5.3.2.1 Undo

This item provides multiple undo levels. Operations that change the contents of 
the project file may be undone, but operations that change the user interface 
options or colors cannot be undone.

5.3.2.2 Copy

This item is the standard Windows copy command.

5.3.2.3 Define New Marker

This item opens the Define New Marker dialog box.
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• Type - In the Type area, select a marker type for the new marker. For a 
description of all marker types, see “Table 5-1” on page 5-278. Under most 
circumstances, a new Frame marker cannot be created.

• Name - Enter a unique name for the new marker. Marker names must be 
unique. 

• Comment - This is an optional box in which to insert a free-form comment 
that describes the new marker.

• Associated Keystroke - This area identifies the keystroke that is associ-
ated with this marker, which can be used for finding or inserting new marker 
occurrences. CinePlex Editor automatically suggests an unused key; click 
Change to open the Assign Key dialog box and select a different key. When 
the dialog box appears, press the key to associate and click OK.

Note: Only single-keystrokes (not CTRL- or ALT- key combinations) can be associ-
ated with Markers.

• Display - This area identifies the display color and the show setting for the 
marker.

— Color – This box shows the display color this marker in various win-
dows. The color can also be set directly in the Marker window.

— Show – This item toggles the appearance of the Marker in various win-
dows. This item can also be set directly in the Marker window.

• Event IDs - This area shows the Event IDs associated with the marker. Use 
these IDs only when exporting this marker to a PLX file. These event IDs are 
the Plexon external event IDs that represent this marker in the PLX file. For 
interval-type markers, a second event ID must be specified to represent the 
end time for the interval. 

Note: These IDs must be unique across all markers. CinePlex Editor suggests an 
unused and unique value for these IDs, so they do not usually require immedi-
ate attention when first creating the marker. If exporting the data to a PLX file, 
there will be an opportunity to change these event IDs.

Clicking Generate Occurrences causes CinePlex Editor to create the marker 
and also automatically populate the new marker with algorithmically-generated 
marker occurrences. The available methods for automatically populating the 
marker with marker occurrences varies by marker type; for a description, see 
“Automatically Generating Marker Occurrences” on page 183.

• OK - Click OK to close the dialog box and create the new marker. 

5.3.2.4 Edit Selected Marker

This item opens the Edit Marker dialog box.  An illustration of the dialog box 
follows:



Version 3.0 247

Note: The Edit Marker dialog box may also be opened from the right-click menus in 
the Markers and _Marker Occurrences windows.

The marker type for an existing marker cannot be changed. However, it is possi-
ble to change the following marker items:

• Name - Enter a unique marker name. Marker names must be unique. Dupli-
cates are not accepted during the Add Marker process.

• Comment - Add, add to, or edit a free-form comment that describes the 
marker.

• Associated Keystroke - This area identifies the keystroke that is associ-
ated with this marker; click Change to open the Assign Key dialog box and 
select a different key. When the Assign Key dialog box appears, press the key 
to associate and click OK.

Note: Only single-keystrokes can be associated with markers. CTRL- or ALT- key 
combinations are not valid.

• Display - This area identifies the display color and the show setting for the 
marker.

— Color – This box shows the display color of this marker in various win-
dows. Select a new color from the drop-down list.

— Show – This item toggles the appearance of the marker in various win-
dows. Change as needed.

• Event IDs - This area shows the Event IDs associated with the marker. 
These event IDs are used when exporting this marker to a PLX file; for more 
information, see Event IDs on page 5-246. Change the event IDs as needed.
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5.3.2.5 Delete Selected Marker

This item deletes the selected marker and all occurrences of that marker.

5.3.2.6 Copy Selected Marker

This item copies the selected marker to the clipboard.

5.3.2.7 Add New Marker Occurrence

This item opens the New Marker Occurrence window.

Note: CinePlex Editor identifies marker occurrences by their time, thus no two 
marker occurrences can have the same time. Adding a new marker occurrence 
with the same timestamp as an existing marker occurrence replaces the exist-
ing marker occurrence with the new one; that is, it is overwritten and the old 
data values are erased. Editing an existing marker occurrence by changing its 
timestamp to be the same as another existing marker occurrence replaces the 
existing marker occurrence.

• Marker - This box shows the marker for which a new occurrence is being 
added. 

• Time - This is time of the new marker occurrence and its related data values. 
The data values depend on the marker type. For example, for Coordinates 
markers, the X and Y data values appear as shown in the illustration, but for 
Interval markers, start and end times appear.

5.3.2.8 Edit Selected Marker Occurrence

This item opens the Edit Marker Occurrence dialog box.
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• Marker - This box shows the marker whose occurrence is being edited. 

• Time - This is time of the marker occurrence and its related data values. The 
data values depend on the marker type. For example, for Interval markers, the 
start Time and End Time appear as shown in the illustration, but for Coordi-
nates markers, X and Y data values appear.

5.3.2.9 Delete Selected Marker Occurrence

This item deletes only the selected occurrence for the marker.

5.3.2.10 Delete All Marker Occurrences

This item deletes all occurrences for the selected marker, but leaves the marker 
itself intact.

5.3.2.11 Keystroke ..., Button Press ..., and Left-Click Inserts Marker

These items determine which user action inserts markers. For information on 
marker insertion, see “Understanding Markers and Marker Occurrences” on 
page 278.

5.3.3 View Menu

The following illustration shows the View menu. 

All the items in this menu open or close a window in CinePlex Editor.
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5.3.4 Animate Menu

The following illustration shows the Animate menu. 

5.3.4.1 Play

This button automatically advances time at a rate determined by the time multi-
plier. Selecting Play when already playing causes a Pause condition.

5.3.4.2 Pause

This button halts the automatic advance of time. Play and Pause are mutually 
exclusive. Press SPACEBAR to toggle between Play and Pause. Selecting Pause 
when already paused resumes play.

5.3.4.3 Slower

If pressed while playing at any speed, this button slows down the rate of time pro-
gression by half until the speed is 1/256 of normal. Continued pressing reverses 
the direction and increases the speed.

5.3.4.4 Faster

This button speeds up the rate of time progression by a factor of 2. The UP ARROW 
key and the DOWN ARROW key are equivalent to the Slower and Faster buttons. 
Continued clicking will eventually cause the speed to reach a maximum of 256 
times normal.

5.3.4.5 Reset to 1X Speed

This button sets the rate of time progression to 1X normal speed.

5.3.4.6 Step Backwards

This button advances time to the previous video frame. The LEFT ARROW key is 
equivalent to this button.
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5.3.4.7 Step Forward

This button advances time to the next video frame. The RIGHT-ARROW key is 
equivalent to this button.

5.3.4.8 Rewind

This button sets the current time to the time of the first video frame.

5.3.4.9 Reverse

This button reverses the flow of time at the current time rate. If already in reverse, 
it goes forward.

5.3.4.10 Lock to Video Frames

This button advances time by increments of whole frames only. CinePlex Editor 
does not change the current time at all until enough time has elapsed to make a 
new video frame the current frame. Then it sets the current time to be the exact 
time of the frame marker corresponding to that frame. This is the default mode.

Note: A potentially confusing effect occurs when CinePlex Editor is in Frame Lock-
ing mode. If the video capture was paused during acquisition so that there is a 
gap of time that contains no frame marker occurrences, animation appears to 
freeze at the point where the gap starts until enough time passes such that the 
next video frame is current, which can be much later. Conversely, when Cine-
Plex Editor is not in Frame Locking mode, the animation continues smoothly 
through the gap and time advances without regard to video frame boundaries. 
The video frame remains unchanged until the next one is encountered.

5.3.5 Looping Menu

The following illustration shows the Looping menu.

5.3.5.1 Toggle Looping

This item turns looping on or off for the interval selected in the list. Select this 
option to turn looping on during play back when a specific interval appears that 
should be reviewed. Playback loops from the beginning to the end of the interval. 
Click again to resume normal playback.

5.3.5.2 Select Looping Interval

This item opens the Looping Interval dialog box to allow a looping interval to 
be defined. An illustration of the dialog box follows:
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• Loop over entire file - This is the default selection. CinePlex Editor plays 
the file to the end and restarts from the beginning. 

• Loop over an Interval Marker Occurrence - This selection makes 
CinePlex Editor loop over the time span defined by a specified occurrence of 
an interval marker. When selecting this option, choose the interval marker 
from the drop-down list and then choose the specific occurrence of the inter-
val marker to loop over.

— Nearest Occurrence – uses the occurrence nearest to the current time

— Use Selected Occurrence – uses the specific occurrence selected from 
the drop-down list

• Loop over an arbitrary time interval - This selection makes CinePlex 
Editor loop over an arbitrary interval of time specified in the Start and End 
boxes. Use the Looping toolbar controls to control looping parameters; see 
“Looping Toolbar” on page 274.
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5.3.6 Find Menu

The following illustration shows the Find menu.

5.3.6.1 Find Marker Occurrences

This item opens the Find Marker Occurrences dialog box to choose which 
marker to find. Either find the selected marker or choose from a dropdown list. 
An illustration of the dialog box follows:

• Use Selected Marker as Marker To Find - By default, CinePlex Editor 
loads the current marker into the Marker To Find list box. To select another 
marker from the drop list, click to clear the checkbox and select another 
marker in the Marker To Find box.

• Marker To Find - Click to clear the Use Selected Marker as Marker To 
Find checkbox and select a marker from the drop-down list.

5.3.6.2 Find Forward

This item searches forward for the next selected marker. 

5.3.6.3 Find Back

This item searches backward for the next selected marker. 
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5.3.7 Tools Menu

The following illustration shows the Tools menu. 

5.3.7.1 Levels Editor

This item opens the Levels Editor window. Use the Levels Editor dialog box to 
define level interval markers and generate marker occurrences for them. An illus-
tration of the dialog box follows:

• Scalar Marker To Use - This box contains the scalar marker to use for gen-
erating levels.

• Generate All - This button generates marker occurrences for all the Level 
Interval markers that appear in the Level Intervals box.
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• Generate Selected - This button generates marker occurrences for the 
selected level interval, which appears with a >> in the left-most column in the 
Level Intervals box.

Note: Clicking either Generate All or Generate Selected deletes all existing marker 
occurrences for the affected Level Interval markers, and generates a new set of 
occurrences according to the current Scalar marker and conditions.

The graph in the middle of the Levels Editor window shows the values of the 
selected Scalar marker as a function of time. The horizontal range of time that 
appears is always the entire file. The vertical scaling of the plot always adjusts to 
show the full range of the scalar data values. The levels appear as horizontal lines 
on the display, with the above or below setting for each level shown as either 
upward- or downward-pointing arrows on the lines. The number on the left indi-
cates whether the line represents Level 1 or Level 2. 

Note: Positioning the mouse pointer inside this portion of the editor causes the scalar 
value corresponding to the pointer position to appear in the edit box at the bot-
tom right of the display.

• Level Intervals - This area contains a grid that has a line for each defined 
level interval. Select level intervals by clicking in the grid. Set the condition 
by editing the grid fields. When defining multiple Level Interval markers, 
only the one selected in the Level Intervals box displays. Click any level 
interval to select it. The selected level interval appears with a >> in the left-
most column of the grid. The columns shown in the grid are:

— Level Interval Marker – This column contains the name of the Level 
Interval marker. The name can be changed by changing the text in this 
field.

— Color – This column contains the color associated with the Level Inter-
val marker. To change the color, click in this field to bring up a color 
selection dialog box.

— The next five columns together define the condition for the Level Inter-
val marker. The column arrangement forms a condition statement, for 
example “Above 175 AND Below 200.”

– Abv/Blw – This column contains the above or below indicator for 
the first level. To change the condition, click in this field to open a 
drop-down list and select Above or Below.

– Level 1 – This column contains the numerical value for the first 
level. Type a numerical value in this field or click and drag horizon-
tal line 1 on the graph.

– Oper – This column contains the logical operator between the two 
halves of the condition. The available selections in the drop-down 
list are AND, OR, or N/A. Selecting N/A means that there is only 
one level in the condition; CinePlex Editor ignores the last two col-
umns and a second line on the graph does not appear. 
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– Abv/Blw – This column contains the Above or Below indicator for 
the second level, which only applies if N/A is not selected.

– Level 2 – This column contains the numerical value for the second 
level, which only applies if N/A is not selected. Type a numerical 
value in this field or click and drag horizontal line 2 on the graph. 

• Add - This button opens the Define New Marker dialog box to add a new 
Level Interval marker.

• Delete - This button deletes the selected interval level.

• Center Lev1 and Center Lev2 - By default, CinePlex Editor sets the level 
intervals to the middle of the display range shown in the graph, which it deter-
mines from the range of scalar values encountered for the selected Scalar 
marker. Click these buttons to re-position the corresponding level line to the 
center of the view again.

• Done - Click Done to close the editor. CinePlex Editor stores the conditions 
with the Level Interval marker and displays them when the Levels Editor re-
opens.

5.3.7.2 Zones Editor

This item opens the Zones Editor window. An illustration of the dialog box fol-
lows:

• Coordinates Marker To Use - This box lists the Coordinates marker used 
to define the zone.
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• Generate All - This button generates marker occurrences for all the level 
intervals that appear in the Zone Intervals box.

• Generate Selected - This button generates marker occurrences for the 
selected Level Interval marker, which is indicated by the >> in the left-most 
column in the Level Intervals box.

Note: Clicking either Generate All or Generate Selected deletes all existing marker 
occurrences for the affected Zone Interval markers, and generates a new set of 
occurrences according to the current Coordinates marker and conditions.

• Zone Intervals - This area lists all the defined Zone Interval markers. 

— The leftmost column lists the interval number; the selected Zone Inter-
val marker appears with a >> in the leftmost column. 

— Zone Interval Marker – This column lists the names of the Zone 
Interval markers. Add or change names by typing in this field.

— Color – This column shows the colors of the zone boundaries. To 
change a color, click the color to open a color selection dialog box.

— Add – This button adds a coordinate to the selected zone. 

— Delete – This button deletes the selected Zone Interval marker.

• Coordinates of the Selected Zone - This area lists the coordinates of the 
currently selected Zone Interval marker. The zone of a Zone Interval marker 
consists of a list of 2D coordinates (X and Y) that define the closed contour. 
Define these contours by clicking on the screen image (see Add that follows), 
or by individually adding and typing in the coordinate values in the columns. 

— The leftmost column lists the coordinate number; the selected coordi-
nate appears with a >> in the leftmost column.

— X – This column contains the X coordinate distance from the lower left 
corner (zero distance).

— Y – This column contains the Y coordinate distance from the lower left 
corner (zero distance).

— Clear - This button completely clears all points from the current zone. 
Click Add to re-enter the zone.

— Add - This button puts the Zones Editor into the click-to-add mode. 
The first left-click in the main window defines the first point in the con-
tour, subsequent left-clicks continue to define the contour. A right-click 
ends the drawing and closes the contour.

— Edit - This button enables the currently selected point to be re-posi-
tioned. After clicking Edit, move the mouse pointer to the desired loca-
tion on the main window. The contour continually re-adjusts as the 
mouse pointer moves. Left-click to select the new position, or right-
click to cancel the operation and revert to the previous position.
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— Delete - This button deletes the currently selected point from the zone 
contour. The contour re-adjusts automatically for the remaining points.

When the Zones Editor dialog box is opened, the main view shows the same 
video frame that CinePlex Editor displays. By default, the zone for the currently 
selected Zone Interval marker appears superimposed on the video frame.

• Show Selected Zone - This is the default setting. It shows the zone for the 
currently selected Zone Interval marker superimposed on the video frame

• Show All Zones - Click this button to see all defined Zone Interval marker 
zones simultaneously.

• Show Complete Tail - Click this button to display a line connecting all the 
positions visited by the selected Coordinates marker. This can help to show 
what effect various placements of the zone boundaries can have when a zone 
is defined.

• Show Grid every - Click this button to superimpose a grid over the video 
image. Enter the grid spacing in the box. 

• Coordinates: X Y - When the mouse pointer moves over the main window, 
the corresponding coordinates of the mouse pointer appear in the X and Y 
edit boxes.

• Done - Click Done when finished defining zone intervals.

5.3.7.3 Interval Operations

This item opens the Interval Operations dialog box.

• Interval Marker to Use - From the drop-down list, select a marker of the 
following type:

— Interval

— Level Interval
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— Zone Interval

• Operation to Perform Using Interval Marker - In this area, choose one 
of the following operations:

— Invalidate Waveforms that occur within the Intervals – This selec-
tion invalidates all waveforms that occur within (inclusive) the interval 
marker. CinePlex Editor compares each waveform (spike time) in every 
channel against all occurrences of the interval marker to see if it falls 
within the start and end times. If it does, CinePlex Editor marks the 
waveform as invalid.

— Remove Occurrences within the Intervals, for Marker – This selec-
tion removes the occurrences of the marker selected from the drop-list, 
from within the intervals. CinePlex Editor compares the times of the 
occurrences of this marker to the selected interval occurrences, and 
removes any occurrences that fall within (inclusive) of any interval.

Note: In both cases, CinePlex Editor considers exact matches of the spike timestamp 
to the interval occurrence start or end times to be within the interval. For exam-
ple, if spike time Tspike is inside the interval defined by Tstart and Tend, it 
means that the condition (Tspike >= Tstart) and (Tspike <= Tend) is true.

— Negate the selected operation – This selection changes either of the 
previous selections to an exclusive function. Selecting Invalidate 
Waveforms that occur within the Intervals invalidates all waveforms 
that do not fall between the start and end times (exclusive) of any inter-
val marker occurrences. Selecting Remove Occurrences within the 
Intervals, for Marker removes all occurrences of the selected marker 
that do not occur within the times spanned (exclusive) by any interval 
marker occurrence. The text in the Interval Operations dialog changes 
as follows:
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5.3.7.4 Shift Marker Occurrences

This item opens the Shift Marker Occurrences dialog box. An illustration of the 
dialog box follows:

Use this dialog box to add a constant offset, which can be negative, to all 
timestamps of a marker. It is useful for aligning neural data with the video data.

• Marker - Select a marker to shift from the drop-down list.

• First Occurrence Time - This is the time that the first occurrence of the 
marker appears.

• Last Occurrence Time - This is the time that the last occurrence of the 
marker appears.

• Range - This is the time span between the first and last occurrences.

• Shift by _ secs - This selection shifts the occurrences by a constant amount. 
Enter the amount of shift directly in the edit box.

• Shift so that first Occurrence is at time _ secs - This selection calcu-
lates the shift amount by determining how much the first occurrence of the 
selected marker must be shifted to make it equal to the specified time. Cine-
Plex then applies this shift amount to all occurrences.

• Shift so that the first Occurrence is at time of Marker - This selection 
shifts the time to that of another marker occurrence. Select the shift-determin-
ing marker from the drop list. 

• Occurrence - Enter which occurrence of the shift-determining marker to 
use by typing its 1-based index into the edit box. 
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5.3.7.5 Snap-To Marker Occurrences

This item opens the Snap-To Marker Occurrences dialog box.  An illustration 
of the dialog box follows:

The purpose of the “Snap-To” functionality is to shift the occurrences of one 
marker to match up in time with the occurrences of another marker. However, 
unlike the Shift Marker Occurrences functionality described on page 5-260, the 
“Snap-To” functionality can shift each occurrence by a different amount.

• Marker To Adjust - From the drop-down list, select the marker occurrences 
to match up in time.

• Snap-To Occurrences of Marker - From the drop-down list, select the 
marker occurrence to match up to in time. 

Note: Typically, the Snap-To Occurrences of Marker are Frame marker types, 
which means the Marker To Adjust aligns with the times of the video frames.

The CinePlex Editor algorithm find the best match occurrence of the Snap-To 
Occurrences of Maker entry for every occurrence of the Marker To Adjust 
entry, and makes the Marker To Adjust occurrence time equal to the time of the 
best match occurrence. There are two ways that CinePlex Editor determines the 
best match occurrence of the “Snap-To” marker:

— Snap-to Previous Occurrence – This selection uses the occurrence 
that is just before the time of the occurrence being adjusted. The adjust-
ment always reduces the time of the occurrence being adjusted.

— Snap-to Closest Occurrence – This selection uses the occurrence that 
is closest in time to the occurrence being adjusted. The adjustment can 
shift the occurrence being adjusted ahead or behind in time.

• Snap interval start and end times independently - Because interval-
type markers consist of two times (a start time and an end time), they are 
treated differently and they are controlled by this checkbox. When this box is 
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checked, CinePlex Editor snaps both the start and the end times to their 
respective best match occurrences. This can change the length of the interval. 
When the checkbox is cleared, CinePlex Editor uses the best match to the 
start time to shift the entire interval. In this case, the end time shifts by the 
same amount as is the start time, so the length of the interval remains con-
stant.

5.3.7.6 Interpolate Missing Occurrences

This item opens the Interpolate Missing Occurrences dialog box. An illustra-
tion of the dialog box follows:

• Marker - From the drop-down list, select the marker to interpolate.

• Periodicity - This box displays the periodicity results for the selected 
marker as follows:

— Tolerances for Gaps – For the gap analysis, the average separation 
between markers is determined. If the time gap between any two adja-
cent marker occurrences is not within the Tolerance for Gaps value (i.e. 
between (1-TFG) and (1 + TFG) times the average separation, it is 
marked as a gap.

— pairs – the number of pairs of adjacent times

— avg – the average time difference between pairs in seconds

— stddev – the standard deviation around the average time difference

— min – the smallest time difference encountered in seconds
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— max – the largest time difference encountered in seconds

— non-gap avg – the average time difference in seconds when the discov-
ered gaps are excluded from the calculation

• Gap Sizes - This box lists of the distribution of skipped occurrences (gaps); 
for example, 0 : nnn indicates the number of number of pairs without a miss-
ing timestamp between them, 1 : nnn indicates the number with one times-
tamp missing, 2 : nnn indicates the number with two missing timestamps, 
and so on.

• Timestamp Determination - The area contains the following two selec-
tions:

— Assume Periodicity – This selection assumes that the data is periodic 
and adds marker occurrences accordingly.

— Use Frame Marker Times – This selection adds missing marker 
occurrences at the frame markers.

• Value Interpolation - The area contains the following two selections:

— Sample-and-hold the previous value – This selection assigns a value 
(or coordinates) to the new marker occurrences added to fill a gap, 
which is the same as the value (or coordinates) of the last pre-gap 
marker occurrence.

— Linear Interpolation – This selection assigns values to the new 
marker occurrences added to fill a gap that are calculated to fall on a 
line connecting the last pre-gap value (or coordinates) with the first 
post-gap value (or coordinates).

If the marker being interpolated is a scalar marker or a coordinates marker, the 
tool can calculate reasonable values to apply to the added marker occurrences by 
using one of two methods:

Generate new Time-only Marker at times for added Occurrences

• Generate new Time-only Marker at times for added Occurrences - 
This selection enables the tool to define and populate a new marker named 
Interpolated X, where X is the name of the marker being interpolated, and 
which has occurrences at the times where interpolated marker occurrences are 
added. In effect, this differentiates the occurrences of the selected marker that 
are generated via interpolation from those that are part of the original data.

How the Interpolation Algorithm Works

The interpolation tool is capable of calculating both the times at which new 
marker occurrences need to be added (that is, where the gaps appear), and for 
Scalar markers and Coordinates markers, what values need to be given to the 
added marker occurrences. Obviously, when finding the times where there are 
gaps, there is an implicit assumption of periodicity in the marker occurrences. 
This may or may not be the case with the marker occurrences for the selected 
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marker, but the tool displays information that helps to determine the extent to 
which the periodicity assumption is valid.

When a marker is selected, the algorithm analyses the times of the occurrences 
for that marker, and displays the results in the two list boxes. The algorithm can 
use or ignore the results of this analysis, depending on the following Timestamp 
Determination selections. The analysis proceeds as follows:

1 Consider each pair of adjacent times for the marker occurrences, and calcu-
late the time difference between each pair. The number of pairs appears in the 
left list box.

2 Find the min, max, average, and standard deviation on the set of calculated 
time differences. Display this information in the Periodicity list box as avg = 
for the average time difference, stddev = for the standard deviation around 
the average time difference, min = and max = for the smallest and largest 
time differences encountered. 

3 Assume that any difference between adjacent occurrences that is larger than 
1.1 times the average time difference constitutes a gap, or a skipped occur-
rence. Using this definition of a gap, compute and display a histogram of the 
sizes of the gaps in the Gap Sizes list box. The 0: line in this list box is to be 
interpreted as the number of timestamp pairs for which there were no gaps or 
missing timestamps between them. The next 1: line is the number of times-
tamp pairs for which there was a gap of 1 missing timestamp between the 
pair, and so on.

4 By ignoring the gaps, compute a new average time difference between adja-
cent, gap = 0 timestamp pairs. Display this as non-gap avg = in the Periodic-
ity list box. Whereas the avg = value has factored in the gaps and thus 
produced a larger average time difference, the non-gap avg = has taken out 
the gaps, and so produces a smaller and in many cases more accurate estimate 
of the true periodicity. In effect, this is the periodicity that would be seen if it 
weren't for missing samples (gaps) in the occurrences.

5.3.7.7 Mark All Waveforms As Valid

This item re-validates any waveforms that were invalidated with the Interval 
Operations tool; see “Interval Operations” on page 258.

5.3.7.8 Options

This item opens the Options dialog box with several tabs as described in the fol-
lowing sections.



Version 3.0 265

5.3.7.8.1 General Tab. 

• Initial Directories for Data Files - This area contains list boxes and con-
trols for the initial project directories as follows:

— Initial Directory for Project (CPJ) Files – Type a directory location 
and name or click Browse and select and existing directory.

— Initial Directory for Video Files – Type a directory location and name 
or click Browse and select and existing directory.

— Initial Directory for Neural Data Files – Type a directory location 
and name or click Browse and select and existing directory.

— Always use the same Initial Directories – This selection sets the 
default initial directories to the directories entered.

— Use the last directory of the previous session as Initial Directory – 
This item sets the default initial directories to the directories used for 
the last project.

• Project File-Save Behavior - When a project file is saved, from the drop-
down menu one may set one of the following default file-save behaviors:

Note: On this menu, filename-0n means CinePlex Editor defaults to the first unused 
filename and adds a numeric increment 0 (zero) n (digit). For example, Test-01, 
Test-02, Test-03, etc.
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• Number of Frames to Advance During Click-To-Add - Type the num-
ber of frames to advance when adding or editing coordinates in the Video or 
Scalar windows. For more information on Click-To-Add, see “Understanding 
Click-To-Add Mode” on page 178.

• Select Marker Occurrence For Current Time - Select this item to have 
CinePlex Editor automatically select, in the Marker Occurrences window, the 
most appropriate marker occurrence for the current time.

5.3.7.8.2 File Import Tab. 

• Reading Buffer Size - This area contains an input box for the reading 
buffer size setting and an advisory estimate of the amount of space wave-
forms take.

— Reading Buffer Size for data files (MB) – Type a size value for the 
reading buffer in megabytes (MB).

• Continuous Data - This area contains an input box for the size of the con-
tinuous-data channel buffer and a checkbox that disables the loading of con-
tinuous-data channels to PLX files.

— Channel Buffer size for continuous data (MB) – Type a size value 
for the channel buffer in megabytes (MB).

— Disable loading continuous data channels for PLX files – This selec-
tion inhibits the loading of continuous data channels to PLX files.

— Default Timestamp Frequency (if not specified in loaded file) – If 
the initial neural data file does not specify a timestamp frequency (for 
example, a DVT file), enter a default timestamp frequency in Hz. 
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5.3.7.8.3 Latency Correction Tab. For more details on latency correction, see 
“Correcting for Video Latency” on page 282.

• Automatically compensate for video latency by adjusting Frame 
and Position Markers - this setting is checked by default. This setting 
compensates for the amount of time elapsed between the camera’s capture of 
the image to the computer’s timestamp of the video frame (the video latency). 
If there is data that was analyzed with previous versions of CinePlex Editor, 
there may be timestamp shifts and this setting could be unchecked for that 
data.

— Amount of time to shift Markers - Type the amount of time to shift 
the markers in seconds. The number should always be positive because 
the number is subtracted from the timestamps.

• Automatically snap Position Markers imported from PLX files to 
the previous Frame Marker - this setting is checked by default. This set-
ting is applied automatically only when data is initially imported from a PLX 
file.

Note: When CinePlex is being used with Plexon’s MAP system, leaving the MAP on 
overnight could result in excessive latency - much greater than 30 milliseconds. 
If the MAP has been left on overnight, it is better to reset the MAP system.
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5.3.7.8.4 Display Tab. 

• Update Animation Every __ Milliseconds - Type an animation update 
frequency in milliseconds. This is the screen update rate while the video and 
data files play are playing. 

• Initially show ‘Welcome To CinePlex’ dialog box - This selection 
makes the Welcome to CinePlex dialog box appear at startup.

• Initially disable empty Spike Channels - This selection suppresses 
empty spike channels in the Activity window at startup.

• Initially disable Continuous Channels - This selection suppresses con-
tinuous channels in the Activity window at startup.
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5.3.7.8.5 Audio Tab. 

• Available Sounds - CinePlex Editor ships with a selection of four WAV 
files, and these sounds are available for playback in CinePlex Editor by 
default. However, any WAV file can be used, provided that CinePlex Editor 
knows where to find it on the hard drive. Before WAV file sounds can be 
mapped to Marker or spike occurrences in the Audio Output Window, they 
must be loaded into CinePlex Editor. The Available Sounds section lists the 
Sounds that are currently available for playback. Each sound has a Label that 
shows up in the droplist in the Sounds column of the Audio Output Window, 
and the full path to the WAV file that contains the sound.

• Add - Pressing Add... will show a file selection dialog followed by the Sound 
Selection dialog box which allows entering a Label used to represent that 
sound. Pressing the Play Sound button will play the sound, which is useful 
for previewing.

• Edit - Highlighting an existing sound in the list and pressing Edit... will show 
the Sound Selection dialog box and allow re-selecting the WAV file or chang-
ing the Label for a sound.
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• Remove - Highlighting an existing sound in the list and pressing Remove 
will remove the sound.

• Play Sound - Highlighting an existing sound in the list and pressing Play 
Sound will immediately play the sound, allowing it to be previewed.

• Reset to Defaults - Pressing the Reset to Defaults button will reset the list 
to contain the four sound files that are shipped with CinePlex Editor.

5.3.7.8.6 Colors Tab. 

• Display Elements - This area contains the following color choices for the 
main display:

HINT
Minimizing number of sounds to play
Computer audio hardware can only mix a certain number of sound 
streams together, so CinePlex Editor can only play about 10 sounds 
simultaneously. Sounds that overlap in time because they are played 
quickly one after the other count as simultaneous sounds. Therefore, 
it is quite easy for CinePlex Editor to overwhelm the audio sub-
system by attempting to play too many sounds, as Markers or neural 
firings may occur at rates too fast for the audio system’s capabilities. 
When this happens, CinePlex Editor will play as many sounds as it 
can, but there may be gaps in the audio playback. To minimize this 
issue:
a) do not select many units or markers to be played at once. Even a 
single neural channel with a high firing rate can saturate the audio.
b) use WAV files that are as short as possible. In this regard the ‘neu-
ralclick.wav’ file is ideal, as it can be played very quickly.
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— Background – This is the background color of the Activity window.

— Text – This is the text color in the Activity and Video windows.

— Grid and zero line – This is the color of the grid and zero line in the 
Activity windows.

— Selection – This is the color of selected items in the Video and Activity 
windows.

— Restore Colors to Defaults – Click to restore the display elements to 
their default colors.

• Units - This area contains the color choices for each unit and unsorted wave-
forms.

— Unsorted – This is the color for unsorted waveforms.

— Invalidated - This is the color for invalidated waveforms.

— Unit a: ... Unit p – These are the color selections for up to 16 units.

— Restore Colors to Defaults – Click to restore the unit colors to their 
default colors.

5.3.7.8.7 Printing Options Tab. 

The selections on the Printing Options tab are the same as those on the Colors 
tab. See “Colors Tab” on page 270
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5.3.8 Window Menu

For more details on the Window menu, see “Window Menu” on page 11.

5.3.9 Run Menu

5.3.9.1 PlexUtil

This item launches the PlexUtil application.

5.3.9.2 Offline Sorter

This item launches the Offline Sorter application.

5.3.9.3 NeuroExplorer

This item launches the NeuroExplorer application.

5.3.9.4 Explorer

This item opens Windows Explorer.

See also “Run Menu” on page 13 and “Run Menu Customization” on page 22.

5.3.10 Help Menu

For more details on the Help menu, see “Help Menu” on page 13.
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5.4 Toolbars

CinePlex Editor includes toolbars that provide access to features, commands, 
controls, and settings. Most features and commands are available on the toolbars. 
It is also possible to create toolbars from most of the dropdown menus on the 
menu bar. Briefly rest the mouse pointer over a button to see the button name. 
Descriptions of the toolbars follow:

5.4.1 Standard Toolbar

This toolbar includes typical Windows controls for file New, Open, Save, Cut, 
Copy, Paste, Print, Help, Undo, and Options. Except for Options, these are 
typical Windows controls. For information on Options, see “Options” on 
page 264.

5.4.2 Edit Toolbar

The Edit toolbar includes a series of buttons that manage markers and marker 
occurrences within CinePlex Editor. This toolbar has eight buttons that corre-
spond to the marker and marker occurrences commands on the Edit menu; see 
“Edit Menu” on page 245.

5.4.3 Views Toolbar

The Views toolbar includes a series of buttons that open the various windows 
within CinePlex Editor. Each window opens at its default size. This toolbar’s 
buttons are equivalent to the commands on the View menu; see “View Menu” on 
page 249.

.

5.4.4 Animate Toolbar

The most convenient way to control the flow of time in CinePlex Editor is to use 
the time-control toolbar buttons. The associated Animate menu entries or key-

HINT
Missing Buttons on the ViewsToolbar
If there are missing buttons on the toolbar, select Window | Custom-
ize | Toolbars, and select the line labeled View in the list box in the 
Toolbars tab. Do not uncheck the checkbox -- just select the line. 
Then press the Reset button.
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board shortcuts may also be used; see “Animate Menu” on page 250. The Ani-
mation Speed list box is the only Animate toolbar control that has no equivalent 
command on the Animate menu.

• Animation Speed - This list box provides a choice of time progression rates, 
where 1X is the normal speed. It has no equivalent on the Animate menu.

5.4.5 Looping Toolbar

The Looping toolbar includes a list of looping intervals over which the video file 
may be played, and two looping control buttons. The equivalent Looping menu 
entries or keyboard shortcuts may also be used; see “Looping Menu” on 
page 251.

5.4.6 Find Toolbar

The Find toolbar provides a drop down list that includes all markers. The equiva-
lent Find menu entries or keyboard shortcuts may also be used; see “Find Menu” 
on page 253.

By default, the currently selected marker appears in the list box. However, 
another marker may be selected from the drop down list. 

5.4.7 Tools Toolbar

The Tools toolbar includes two time-interval editors. One editor for a defined 
zone of the video window and one editor for level interval markers. The equiva-
lent commands on the Tools menu may also be used; see “Tools Menu” on 
page 254.

 



Version 3.0 275

5.5 How CinePlex Editor Creates Initial Project Files

When a new CinePlex project is created, CinePlex Editor reads both the neural 
data file and the video data file, and it generates markers and marker occurrences 
based on the contents of the files. After the initial file reading, CinePlex Editor 
stores the generated markers and marker occurrences in the project (CPJ) file. 
When the project file is re-opened, CinePlex Editor reads the markers and marker 
occurrences from the project file, not from the original neural data or video files. 
In this way, one may add, edit, shift, or delete markers without regard for what is 
actually in the original neural or video data files. However, when an existing 
project file is re-opened, CinePlex Editor still reads the neural data file in order to 
obtain the spike timestamps and continuous data, and it still reads the video file to 
obtain video frame images.

5.5.1 Reading Video (AVI) Files

When CinePlex Editor reads the video (AVI) file, it looks for timestamps embed-
ded in the data stored with each frame. CinePlex Studio imbeds these timestamps. 
If the embedded timestamps are present, CinePlex Editor creates a special Frame 
marker, and it generates a marker occurrence for each video frame. See “Non-
Typical Initial File Creation” on page 276 if there are no embedded timestamps.

5.5.2 Reading Plexon (PLX) Files

When CinePlex Editor reads a Plexon (PLX) file during the initial project cre-
ation, depending on the contents of the PLX file, it can create and populate a 
number of different markers as follows:

• Non-strobed external events (type 4 data blocks) become Time-Only markers

• Strobed events become a single Scalar marker, with the scalar values set to 
the strobe values

• If strobed events are present, and CinePlex Editor identifies them to be in 
conformance with the Plexon VideoTracker protocol, then CinePlex Editor 
generates additional markers by interpreting the strobe codes as data pro-
duced by Plexon VideoTracker. Depending on the VideoTracker mode 
detected, CinePlex Editor creates the following markers:

— One, two, or three Coordinates markers with names like Position n to 
denote the tracker positions, when VideoTracker is in LED or Reflec-
tive Color tracking modes.

CAUTION
Upgrade Notice
If the system has been upgraded to CinePlex Studio 2.0, CinePlex 
Editor should also be update. The upgraded CinePlex Editor will 
read AVI files created by CinePlex Studio 1.0, 1.1, 1.2, and 1.4. 
However, earlier versions will not be able to read AVI files produced 
in version 2.0
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— A Coordinates marker named Centroid Position, when VideoTracker is 
in Object Contour tracking mode. 

— A Scalar marker named Centroid Motion, when the VideoTracker 
Motion Measure option is enabled.

Note: In Plexon VideoTracker protocol, if VideoTracker cannot locate the object being 
tracked it reports the positions for those frames as (0,0); for example, if a head-
stage cable occluded the LED for a frame VideoTracker reports that frame as 
“0,0”. When CinePlex Editor translates strobed events into Coordinates marker 
occurrences, it automatically ignores any (0,0) coordinates, which leaves gaps 
where there is no position data. The Interpolate Missing Occurrences tool can 
fill these gaps, see “Interpolate Missing Occurrences” on page 262.

Note: Important: Spike waveforms and timestamps and continuous data from a PLX 
file are not converted into markers. 

5.5.3 Reading NeuroExplorer (NEX) Files

When CinePlex Editor reads a NEX file during the initial project file creation, it 
ignores the spike timestamps and continuous data. CinePlex Editor converts other 
NEX variables into CinePlex markers as follows:

• Event variables become Time-Only markers, unless the event variable has the 
exact name Frame Marker, in which case it becomes a Frame marker.

• NEX interval variables become interval markers.

• NEX marker variables that have one associated value become Scalar markers.

• NEX marker variables that have two associated values become Coordinates 
markers.

• CinePlex Editor ignores NEX marker variables with more than two associ-
ated values, and NEX population vector variables.

5.5.4 Reading Digital VideoTracker (DVT) Files

When CinePlex Editor reads a DVT file produced by CinePlex Studio during the 
initial project file creation, it always creates Frame marker occurrences. CinePlex 
Editor also produces Coordinates and Scalar markers for the coordinate and cen-
troid motion data streams in the file, in a manner analogous to how it translates 
the strobed values into markers in a PLX file.

After creating the initial project, one may import additional markers from addi-
tional data files into the project; see Import Markers on page 5-239. The import 
operation also follows the preceding rules. 

5.5.5 Non-Typical Initial File Creation

The normal operating mode for CinePlex Editor is to use an AVI file captured 
with CinePlex Studio so that frame timestamps are embedded in the AVI file; 
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then load a neural data file that contains neural firing timestamps. However, other 
modes of operation may be used:

• When using the New Project Wizard, leave either the video-file filename or 
the neural-data filename blank, but not both. In effect, this allows CinePlex 
Editor to be used to annotate video data without the presence of neural data, 
and vice versa.

• If the video data file is blank, the CinePlex Editor Activity window may still 
be used. If the neural data file contains VideoTracker coordinates that are 
based the Plexon VideoTracker protocol, CinePlex Editor still interprets them 
as Coordinates marker occurrences and displays them against a blank back-
ground in the video window. However, it requires an extra step in this case to 
generate Frame markers artificially. The New Project Wizard detects when 
this needs to be done, and it automatically prompts.

• If the neural data filename is blank, CinePlex Editor still functions; the video 
can be viewed in the normal way: advance frame by frame, animate, etc.

Note: In both of the previous cases, new markers can still be entered and defined. It 
is still possible to export the markers to any of the supported output-file formats.

• CinePlex Editor supports the use of AVI files recorded without the CinePlex 
Studio system, which therefore does not contain embedded timestamps. To 
use these files, Frame markers must be generated before  using CinePlex Edi-
tor.

• CinePlex Editor can also read certain other AVI files, but those AVI files must 
use the Motion JPEG method for encoding and storing the video frames.
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5.6 Understanding Markers and Marker Occurrences

To use CinePlex Editor effectively, it is important to understand the difference 
between a marker and a marker occurrence. A marker is defined by its type and 
name. A marker occurrence is a specific insertion of a marker at a designated 
time. Each marker can have many marker occurrences associated with it. Before 
any marker occurrences for a given marker can be created, that marker must 
exist. To use concepts from object-oriented software methodologies, a marker 
corresponds to a class, and marker occurrences correspond to instances of that 
class.

Every marker has a marker type definition. Each marker occurrence stores at least 
one timestamp, along with other supplemental data, depending on the marker 
type. The following table describes each marker type and the information it stores 
for each occurrence:

Table 5-1 Marker Types

Marker 
Type

Abbr
Information 

Stored
Description

Time Only T Timestamp Single happenings, where the only 
required information is the time of 
the happening. E.g. “Shock Applied”

Frame F Timestamp Single happenings, where the only 
required information is the time of 
the happening. E.g. “Shock Applied”

Interval I Start 
Timestamp, 
End 
Timestamp

Denotes a time interval over which 
something occurred. E.g. “Stimulus 
Applied” or “Valid Trial”

Scalar S Timestamp, 
Value

Denotes a value (stored in a 16-bit 
number) at a given time. E.g. the 
Motion Measure produced by the 
CinePlex Studio Tracking Option. 

Coordinates C Timestamp, 
X, Y

Denotes a pair of values (stored in 
16-bit numbers) at a given time. E.g. 
Animal coordinates produced by the 
CinePlex Studio Tracking Option. 

Level 
Interval

L Start 
Timestamp, 
End 
Timestamp

A special version of an interval 
marker where the intervals are auto-
matically produced by applying a 
thresholding operation to the values 
of a Scalar marker (using the Level 
Editor). E.g. “Rat Froze”
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It is possible to open a quick reminder of the marker types and their abbrevia-
tions; see Quick Reference in “Help Menu” on page 13. Throughout this man-
ual, the marker types Interval, Level Interval, and Zone Interval are collectively 
referred to as interval-type markers or interval markers, as they share many com-
mon characteristics. 

CinePlex Editor uses the concepts of both a selected marker and a selected 
marker occurrence; that is, one may open a dialog box to edit the characteristics 
of a selected marker, and one may delete or edit the selected marker occurrence. 
CinePlex Editor also uses the concept of current time and a closely related cur-
rent video frame. 

By default, whenever the current time is changed in CinePlex Editor, it automati-
cally selects the most appropriate marker occurrence of the selected marker for 
the current time. However, to turn this behavior off, from the Tools menu select 
Options and on the General tab, click to clear the Select Marker Occurrence 
For Current Time checkbox.

5.6.1 Marker Occurrences and the Marker Occurrences Window

This section includes descriptions of the CinePlex Editor facilities for displaying, 
generating, and editing marker occurrences. 

The Activity window graphically shows where marker occurrences occur in time. 
The Video window and the Scalar window each show the data values associated 
with Coordinates and Scalar markers. But the Marker Occurrences window (see 
“Marker Occurrences Window” on page 229) contains a concentration of func-
tionality for dealing with marker occurrences. The following Marker Occurrences 
window shows the numerical values of the marker occurrences for Position 1.

Zone Inter-
val

R Start 
Timestamp, 
End 
Timestamp

A special version of an interval 
marker where the intervals are auto-
matically produced when the values 
of a 2D vector are inside a certain 
spatial zone (using the Zones Editor). 
E.g. “Rat In Maze Arm 3"

Marker 
Type

Abbr
Information 

Stored
Description
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This illustration show the currently selected marker occurrence with a > in the 
leftmost column. The shortcut menu (see “Marker Occurrences Window” on 
page 229) provides several operations that can be performed on marker occur-
rences. One may use other shortcut menu entries to select and copy text with 
marker occurrence information onto the Windows clipboard, and paste into other 
applications. In the Marker Occurrences window, the columns change according 
to the selected marker type as follows:

Table 5-2 Column Displays for Various Marker Types

Note: Marker Occurrences are identified by time, so no two marker occurrences can 
have the same time. Attempting to add a new marker occurrence with the same 
timestamp as an existing marker occurrence causes CinePlex Editor to replace 
the existing marker occurrence with the new one, which deletes the old data 
values by overwriting them. Likewise, if an existing marker occurrence is edited 
by changing its timestamp to be the same as another existing marker occur-
rence, CinePlex Editor replaces the existing marker occurrence.

Also, when Scalar markers appear in the Marker Occurrences window, one can 
control the display format of the data values associated with each marker occur-
rence. One can use the shortcut menu items to display data values in decimal (the 
default), hexadecimal, or as Plexon VideoTracker bit fields, where the informa-
tion appears as comma separated items as follows:

Bit15, Bit14, Bits 10 through 13, Bits 0 through 9

Marker Type Columns

Time Only, Frame Time

Interval, Level Inter-
val, Zone Interval

Start time, end time

Scalar Time and value

Coordinates Time, X, and Y
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From the Marker Occurrences window shortcut menu, one can select Properties 
to open the Marker Occurrences View Properties dialog box:

By default, the dialog box displays the marker occurrences for the currently 
selected marker. However, one can click to clear the Use Selected Marker 
checkbox and select a different marker from the list to display the marker occur-
rences for that marker. When OK is clicked, the current Marker Occurrences 
window will switch to the one selected in the dropdown list. If there are more 
than one Marker Occurrences window open, this capability can be used to dis-
play marker occurrences for different markers simultaneously.

In the Display Format for Scalar Marker Values area, one can set the display 
format for Scalar marker values, which are described in “Table 5-2” on page 5-
280. In the Marker Occurrences window, the items in the Value column change 
the display format chosen.

By default, whenever the current time is changed in CinePlex Editor, it automati-
cally selects the most appropriate marker occurrence of the selected marker for 
the current time. However, this behavior can be turned off; from the Tools menu, 
click Options and then click the General tab; click to clear the Select Marker 
Occurrence For Current Time checkbox.
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5.7 Correcting for Video Latency

If CinePlex Editor is being used to display data obtained using CinePlex Studio, 
be aware that there is a latency between the times of the video frames / position 
data sent from CinePlex Studio and the Neural Data. In CinePlex Studio, the cam-
era takes some time to acquire and transmit each video frame to the Capture com-
puter over the firewire cable. The CinePlex Studio computer will timestamp the 
frame as soon as it receives notification from the camera that the frame has been 
delivered, but our tests indicate that the camera takes approximately 21 millisec-
onds after the ‘shutter’ closes to deliver the frame. Therefore, the timestamps of 
the video frames and of the position data from CinePlex Studio are about 21 mil-
liseconds after the actual frame. One way to think about this is that if something 
suddenly happens in the experimental arena, say an LED suddenly turns on, the 
video frame that first shows the LED illuminated will have a timestamp that is 
about 21 milliseconds later. Note also that there can be substantial jitter in this 
number, depending on when the LED turned on in relation to when the ‘shutter’ 
opened in the camera.

Also, there is a systematic offset that can add a constant amount to the latency of 
each frame, having to do with the exact time that is taken to be zero in the AVI 
file versus the PLX file recorded on a Plexon NDAQ or the Plexon Recorder sys-
tem. Because of this effect, the video latency for Recorder is measured to be 
closer to 33 milliseconds.

CinePlex Editor contains a feature that will automatically subtract some amount 
of time from each video frame timestamp and each position timestamp when a 
project is first created. To activate this feature, select the Latency Correction tab 
of the Tools – Options dialog box and check the ‘Automatically compensate for 
video latency by adjusting Frame and Position Markers’, and enter a amount of 
time to subtract from each timestamp:

The amount of time specified is always subtracted from the timestamps, so the 
entered number should always be positive. Note that this subtraction will only 
occur when the project is first created, when the Frame and Position Markers are 
initially created from the video and neural data files (see “How CinePlex Editor 
Creates Initial Project Files” on page 275), or when a DVT file is imported. It is 
not performed when a CPJ file is read, or when data from a NEX file is imported. 
Note that the timestamp shift that is performed automatically is equivalent to the 
shift than can be performed manually using the Tools | Shift Marker Occur-
rences. 
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Note that applying this correction can shift Markers to have a negative timestamp 
near the beginning of files. When this happens, the timestamps will be assigned 
the value of 0.

In addition to the correcting for the camera latency, an independent correction for 
the tracking latency can be applied, as discussed in the next section.

Note: As of CinePlex Editor version 1.2.0, these latency corrections are now enabled 
by default, with a default correction of 21 milliseconds. If data have been ana-
lyzed using previous versions of CinePlex Editor, the timestamp shifts after 
upgrading to version 1.2.0. To return to pre-version-1.2.0 behavior, one can dis-
able the corrections by unchecking the checkboxes.

Note: When CinePlex is being used with Plexon’s Recorder system, there was an 
issue with Recorder versions prior to 2.3.2 that could artificially increase this 
latency by up to 80 milliseconds. If using CinePlex with Recorder, please 
upgrade the version of Recorder to version 2.3.2 or later. Also, use a video 
latency correction of 33 milliseconds as discussed above.

Note: When CinePlex is being used with Plexon’s MAP system, leaving the MAP on 
overnight could result in excessive latency - much greater than 30 milliseconds. 
If the MAP has been left on overnight, it is better to reset the MAP system.
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5.8 Aligning Tracker Coordinates to Frames

If neural and video data files are collected using a Plexon NDAQ and CinePlex 
Studio with tracking enabled, then the temporal relationship between Frame 
markers, the arrival of strobe codes to the MAP digital input card, and video 
tracker coordinates are depicted in the following illustration of the Activity win-
dow:

Note: Note: the above screenshot depicts the timing assuming that the automatic cor-
rections for (see previous section) are not enabled.

When the video frame is available, CinePlex Studio immediately timestamps the 
file and stores the time in the AVI file along with the video frame image. When 
CinePlex Editor initially reads the AVI file, the time for each frame becomes a 
Frame Marker time, which appears as the blue tick marks in the previous illus-
tration. 

After CinePlex Studio acquires the video frame, it feeds the video image to the 
tracking algorithm. Some time later, the tracking algorithm determines the track-
ing positions and CinePlex Studio encodes the tracking positions using the 
VideoTracker protocol and outputs a burst of strobed data words. The time 
between the frame timestamp and the sending of the strobe codes depends on 
how quickly the tracking algorithms finish, but the first strobed data word always 
occurs before the start of the next video frame. The words within a burst are 
clocked out at a constant rate every two milliseconds.

When strobed data words arrive at the MAP, the MAP timestamps them as it 
reads them in, and then stores them as events in the PLX file. When CinePlex 
Editor in turn reads these strobed events from the PLX file, they become occur-
rences of a Scalar marker named Strobed; in the preceding illustration, these 
occurrences appear as brown tick marks. Also, if CinePlex Editor recognizes that 
the strobed codes are in VideoTracker protocol, it decodes them into occurrences 
of one or more Coordinates markers (see “Table 5-1” on page 5-278). CinePlex 
Editor then assigns times to the Coordinate marker occurrences. The assigned 
times are derived from the time of the first strobed event in each burst of strobed 
events. As a result, CinePlex Editor assigns times to the tracked positions that are 
later than the timestamps of the corresponding video frames; in the preceding 
illustration, the tracked positions (Position 1) are the red tick marks and the video 
frames are the blue tick marks.

This time offset between the frame time and the tracking coordinates, although 
realistic, is not desirable in some cases. For example, one can simplify subse-
quent analysis when the coordinates corresponding to a video frame are equal to 
the time of the video frame. One can do this with CinePlex Editor, by using the 
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Snap-To Marker Occurrences tool described in “Snap-To Marker Occurrences” 
on page 261.

To align frame times and tracking coordinates

1 To align the tracking coordinate Position n marker occurrences to video 
frames, on the Tools menu, click Snap-To Marker Occurrences.

The Snap-To Marker Occurrences dialog box opens.

2 Select the Position n marker in the Marker To Adjust box. Leave the Snap-
To Occurrences of Marker set to the default value Frame Marker. 

3 Click Snap-to Previous Occurrence.

4 Click OK. A confirmation box will appear that specifies how many marker 
occurrences were moved.

After the Snap-to operation completes, the previous illustration becomes:

The red tick marks are now aligned with the blue tick marks. Thus, the tracker 
coordinate Position 1 occurrences are now aligned with the Frame Marker 
occurrences. 

Note that position data imported from a DVT file is already timestamped with the 
time of the corresponding frame, so this correction is not required.

One can configure CinePlex Editor to automatically perform this snap-to previ-
ous operation for newly-created projects by checking the ‘Automatically snap 
Position Markers imported from PLX files to the previous Frame Marker’ check-
box in the Latency Correction tab of the Options dialog box. This correction is 
only automatically applied when the data is initially imported from a PLX file. 
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5.9 Interpreting Frame and Event Timestamps

An event timestamp indicates that the MAP detected the event within the prior 25 
microseconds. This is illustrated by the diagram below.

A frame timestamp shows when the shutter was opened. The shutter will remain 
open until the exposure time elapses.

Note: If the shutter is opened within the 25 microseconds prior to an event timestamp, 
it is possible that the visual evidence of the event will not be captured as illus-
trated by the diagram below. Referring to the diagram, if the event occurred 
prior to the shutter opening, the visual evidence will not be recorded.
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5.10 Analyzing CinePlex Studio data with NeuroExplorer

As discussed in “Export to NEX” on page 244, data can be exported from Cine-
Plex Editor as a NEX file and read into NeuroExplorer. In this case, CinePlex 
Editor can perform latency corrections as described in the previous sections, and 
the data read into NeuroExplorer will be already corrected for latency.

However, a PLX file containing coordinates from CinePlex Studio can also be 
read directly into NeuroExplorer. NeuroExplorer can decipher the Video Tracker 
protocol strobe codes (See Appendix D) and turn them into continuous variables. 
In this case, the timestamps for the coordinates should be corrected for latency 
within Neuroexplorer. Note that since NeuroExplorer does not have access to the 
frame times (stored in AVI and DVT files), it needs to compensate both for the 
video latency (see “Correcting for Video Latency” on page 282) and for the track-
ing latency (see “Aligning Tracker Coordinates to Frames” on page 284) by sub-
tracting a larger number from the position timestamps. To configure the latency 
correction, from the View menu select Data Import Options. In the Data 
Import Options dialog box, click the Plexon Files tab. In the Strobed Events 
area, enter a latency value in the Position events latency (seconds) field.

The default value for this latency correction in the screenshot is 75 milliseconds 
(appropriate for the Plexon Video Tracker product, but too high for CinePlex Stu-
dio). A more appropriate number is 31 milliseconds (21 milliseconds video 
latency plus about 10 milliseconds of tracking latency).
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Appendix A 
Installation

A.1 Installation - Hardware ...........................................................A-2

A.2 Installation - Software.............................................................A-5

A.3 Licensing..............................................................................A-32

A.4 Plexon Technical Support ....................................................A-34

CAUTION
Never plug or unplug a camera FireWire cable with the PC Power ON. 
Permanent damage to the camera may result.
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A.1 Installation - Hardware

This section is intended to assist customers and Plexon personnel with questions 
and advice regarding installation of CinePlex Version 3 hardware that enables 
recording from one or two video cameras on their MAP/CPX Personal Comput-
ers.

Note: None of this special hardware is required for systems that will operate in offline 
mode; i.e. editing, playing, re-recording, and/or re-tracking existing video files. 
All that is needed for offline operation is CinePlex Version3 software and a 
license key that enables the desired capability.

Before beginning the installation, it is important to determine that the MAP/CPX 
computer on which the installation will be done meets the minimum system 
requirements. In general, this means a computer has a dual core Intel processor 
operating at better than 3 GHz with three GB of memory, and a GeForce 9600 GT 
or better video card. Requirements that are more current are available from 
Plexon support (support@plexon.com).

The first procedure covers MAP/CPX computer hardware changes required for 
CinePlex Version 3. CinePlex Version 3 software can then be installed to allow 
recording video from one or two cameras.

The second procedure covers the MAP hardware changes required for CinePlex 
Version 3.

The result should be that CinePlex Version 3 software with recording capabilities 
may be installed on a target system.

Plexon hopes that this procedure solves these issues for most hardware installa-
tions. Plexon welcomes feedback as to how to improve the experience. Please 
contact Plexon support (support@plexon.com, +1 214 369 4957) with comments.
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Procedure for MAP/CPX Computer Hardware Changes Required for CPX 
V3

This installation procedure will result in a platform that will be able to record 
video files from one or two video cameras on the target computer.

1 Ensure the slots in the MAP/CPX computer are configured (numbering slots 
from top down) as listed below.

• 1) Data Acquisition card -- National Instruments PCI-6071E (MAP system 
option - if present)

• 2) Dual-bus PCI Express FireWire adapter - Allied Vision Technologies 
FA-PCIE-BB

• 3) Blank slot

• 4) GeForce 8600 GT PCI video card - EVGA

• 5) PCI-DIO-32HS connects HLK2 card in MAP (MAP system component 
already present)

• 6) AccesIO Assembly

• a) 24-channel Parallel Digital Input/Output PCI Card - AccesIO 
PCI-DIO-24D S02 S10 with IRQT jumper removed

• b) Access IO Adaptor - Plexon 07-02-A-03-B

CAUTION
Changing card order, video cards, monitor count or video resolution 
may result in occasional dropped neural or video data. Currently 
shipping PC and monitor configurations are tested to handle two 
cameras at 80 fps and 128 channels of neural data. However, configu-
ration changes may compromise this ability.
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Procedure for MAP Hardware Changes Required for CPX V3

1 Make sure the TIM board has its Timing jumper set to 1 MHz instead of the 1 
kHz that is normal for non-CPX V3 uses.

2 Install TIM Cable Adaptor on the TIM board with THIS SIDE UP positioned 
upwards.

See Appendix E:  Cabling Guide  for detailed interconnection instructions.
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A.2 Installation - Software

This section is intended to assist customers and Plexon personnel with questions 
and advice regarding installation of CinePlex Version 3 software on their Person 
Computers, whether online running both MAP and CinePlex or offline running 
components of CinePlex.

Before beginning the installation, it is important to determine that the computer 
on which the installation will be done meets the minimum system requirements. 
In general, for a MAP/CPX system, this means a computer with Windows XP 
SP3 running on an Intel Core 2 Duo processor operating at 3 GHz or better, three 
GB of memory, and a 9600 GT or better video card. If a camera will be used, 
FireWire capability must be installed. If two cameras will be used, a dual bus card 
is needed. Any computer supplied by Plexon for the purpose of running a MAP/
CPX system will be meet the minimum requirements.

The requirements for offline systems are not as stringent, but certain operations 
may proceed more slowly than is desired.

More detailed current requirements are available from Plexon support support 
@plexon.com

The first procedure explains a typical installation that will result in the ability to 
record, play and edit files on the target computer. This installation is the type of 
installation required on a computer that controls both a MAP and CinePlex 
recording together.

The second procedure describes how to install the CinePlex components required 
to process CinePlex AVI files on a computer where no cameras are installed.

The third procedure describes the installation of the codecs needed to play Cine-
Plex AVI files in Windows Media Player.

The last procedure is a high level overview of the installation of other possible 
component combinations.

The result should be that the desired capabilities of CinePlex Version 3 may be 
installed on the target system.

Plexon hopes that these procedures solve installation issues for most of our cus-
tomers. Plexon welcomes feedback as to how to improve the experience. Please 
contact Plexon support support@plexon.com (+1 214 369 4957) with comments.

CAUTION
English must be the primary language on the target PC for CinePlex. 
The installation batch files will not run successfully if a double byte 
language like Chinese is installed as the primary language. If a double 
byte language is installed, it must be secondary.
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Procedure for Typical MAP/CPX Computer Installation

This installation procedure will result in the ability to record, play and edit 
CinePlex files on the target MAP/CPX computer. Installation of the RASPU-
TIN software is covered elsewhere and assumed to have been accomplished 
already.

Note that the installer will not execute correctly unless it runs on the target 
computer under an account with Administrative privileges. The name of the 
current installer package is CPXv3SetupBETA.exe. It is available on the 
Plexon Software USB drive that is distributed to Plexon customers. Plexon 
recommends placing the package on the desktop so it can easily be deleted 
after is has been run.

1 Double-click the CPXv3Setup icon:

2 The Welcome window appears. Press Next.
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3 The End User License Agreement window appears. Click Agree to agree to 
the terms:

4 The Choose Destination Location window appears. Click Next unless a 
different location is desired.
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5 The Backup Replaced Files window appears. Plexon recommend leaving 
Yes selected and clicking Next.

6 The Select Components window appears. For the MAP/CPX installation 
leave the first two boxes checked and click Next.
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7 The Select Program Manager Group window appears. Click Next unless a 
different group is desired.

8 The Start Installation window appears. Select Next.
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9 The following window displays while the installation is in progress.

10 The Driver Installation Utility window appears. Click Install to install the 
selected FireWire buses.
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11 The following window appears twice -- click Continue Anyway both times:
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12 Then the Visual C++ redistributable is automatically installed and the following 
window is shown:

13 Next, the Sentinel Key Drivers are installed. Click Next on the window 
below.
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14 Click Next on the window below.

15 Click Next on the window below.
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16 Click Install on the window below.

17 Click Finish on the window below.
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18 The CinePlex installation has now completed and the window below should 
appear. Click Finish.

19 Then click OK on the install window to force a restart and complete the 
installation.

20 These shortcuts should appear on the desktop after the installation.



A  

A-16  CinePlex

Procedure for Installation of Offline Computer without Camera(s)

This installation procedure will result in the ability to play and edit CinePlex 
files on the target MAP/CPX computer. Installation of the RASPUTIN software 
is covered elsewhere and assumed to have been accomplished already.

Note that the installer will not execute correctly unless it runs on the target 
computer under an account with Administrative privileges. The name of the 
current installer package is CPXv3SetupBETA.exe. It is available on the 
Plexon Software USB drive that is distributed to Plexon customers. Plexon 
recommends placing the package on the desktop so it can easily be deleted 
after is has been run.

1 Double-click the CPXv3Setup icon:

2 The Welcome window appears. Press Next.
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3 The End User License Agreement window appears. Click Agree to agree to 
the terms:

4 The Choose Destination Location window appears. Click Next unless a 
different location is desired.
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5 The Backup Replaced Files window appears. Plexon recommend leaving 
Yes selected and clicking Next.

6 The Select Components window appears. For the offline computer 
installation check only the first box and click Next.
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7 The Select Program Manager Group window appears. Click Next unless a 
different group is desired.

8 The Start Installation window appears. Select Next.
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9 The following window displays while the installation is in progress.

10 Then the Visual C++ redistributable is automatically installed and the following 
window is shown:
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11 Next, the Sentinel Key Drivers are installed. Click Next on the window 
below.

12 Click Next on the window below.
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13 Click Next on the window below.

14 Click Install on the window below.
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15 Click Finish on the window below.

16 The CinePlex installation has now completed and the window below should 
appear. Click Finish.
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17 Then click OK on the install window to force a restart and complete the 
installation.

18 These shortcuts should appear on the desktop after the installation.

Procedure for Installation of Codecs for Media Players

This installation procedure will result in the ability to play CinePlex AVI files on 
the target computer with Windows Media Player.

Note that the installer will not execute correctly unless it runs on the target 
computer under an account with Administrative privileges. The name of the 
current installer package is CPXv3SetupBETA.exe. It is available on the 
Plexon Software USB drive that is distributed to Plexon customers. Plexon 
recommends placing the package on the desktop so it can easily be deleted 
after is has been run.

1 Double-click the CPXv3Setup icon:
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2 The Welcome window appears. Press Next.

3 The End User License Agreement window appears. Click Agree to agree to 
the terms:
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4 The Choose Destination Location window appears. Click Next unless a 
different location is desired.

5 The Backup Replaced Files window appears. Plexon recommend leaving 
Yes selected and clicking Next.
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6 The Select Components window appears. For the codecs installation check 
only the third box and click Next.

7 The Select Program Manager Group window appears. Click Next unless a 
different group is desired.
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8 The Start Installation window appears. Select Next.

9 The following window displays while the installation is in progress.
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10 Nothing else will be installed, but the installation package must completed 
before restarting, so click No on the window below.

11 The CinePlex installation has now completed and the window below should 
appear. Click Finish.

12 Then click OK on the install window to force a restart and complete the 
installation.

13 No new shortcuts should appear on the desktop after the installation.
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Procedure for Installation of Other Component Combinations

1 Use the Procedure for Installation of Codecs for Media Players.

2 At step 6, arrange the checkboxes to correspond to one of the diagrams 
below:
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3 After step 6 continue the procedure as shown in Procedure for Installation 
of Codecs for Media Players.
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A.3 Licensing

After the user has installed the Sentinel hardware key, it requires no additional 
attention. However, CinePlex Editor contains facilities for examining the licens-
ing status of the CinePlex System and other Plexon products, and for performing 
remote upgrades to unlock additional features, or product licenses. Use the fol-
lowing procedure to check Plexon licenses.

Opening the License Management Window

1 From the Help menu, click About CinePlex Editor, and select Licensing to 
bring up the Plexon License Management window.

Note: In the main text area, the window contains a summary of the licensing 
status of the hardware key or keys. If CinePlex Editor cannot read a 
hardware key, an explanation appears in the window. If CinePlex Edi-
tor can read a hardware key, it interrogates it and displays the infor-
mation from it. The Key Serial Number, Customer ID, and Key 
Number identify a particular key. This information must be provided to 
Plexon to unlock additional Plexon products. The Products Licensed 
section tells which Plexon products are currently unlocked by the 
hardware key. 

2 Click Test the Key Again to re-interrogate the key and re-display the 
information. The Unlock Additional Program and Features section applies 
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to remote upgrades. If a remote upgrade applies, Plexon provides instructions 
on how to use this feature.

Note: Multiple Plexon hardware keys can be installed on the computer. CinePlex Edi-
tor can find and use a license on any of the keys attached to the computer. If 
Plexon software detects multiple Plexon keys on the computer, additional Next 
Key>> and <<Previous Key buttons appear in the license window. Use these 
buttons to step through the keys to individually examine each key.
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A.4 Plexon Technical Support

A.4.1 Technical Support

Assistance is available with the CinePlex System via e-mail at sup-
port@plexon.com.

A.4.2 Demo Mode

If there is not a valid Plexon hardware key connected to the computer, CinePlex 
Editor runs in Demo Mode. CinePlex Editor opens a startup message box to indi-
cating that it is running in Demo mode. Plexon provides all CinePlex Editor fea-
tures in Demo mode, except the file saving functionality.
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Appendix B 
Problem Resolution
B.1 Physical Installation Issues ....................................................B-2

B.2 Other Issues...........................................................................B-4

B.3 CinePlex Studio Messages .................................................. B-11

CAUTION
Never plug or unplug a camera FireWire cable with the PC Power ON. 
Permanent damage to the camera may result.
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CinePlex Version 3 is a powerful, complex product that gives its users extensive 
control over the video portions of their neural data collection process. This com-
plexity gives rise to possible interactions and issues that were not present in ear-
lier versions. For that reason Plexon has compiled this list of common problems 
reported from the field, together with their normal solutions. If the steps here do 
not solve the problem, or if the problem is not listed, please contact Plexon Sup-
port at support@plexon.com or 214-369-4957.

B.1 Physical Installation Issues

In general, all of the following should be checked when unexplained problems 
are occurring. For more detailed installation instructions of CinePlex V3 hard-
ware, please refer to the relevant documents.

Missing/Improper Wire and Cable Connections - Single Systems

Be sure that all required cable connections are in place and tight. Unpredict-
able results may occur if they are not. See “Appendix A-Installation” for com-
plete detailed instructions for installing CinePlex. The most likely items to 
check are:

1 Short purple wire from TIM card nose board to the XS2 BNC connector on the 
TIM card.

2 Trigger cable(s) from the AccesIO tail board to the camera(s).

3 FireWire cable(s) from the FireWire card in the computer to the camera(s). If 
there are two cameras, there must be an empty FireWire socket between the 
two connections to the FireWire board or maximum frame rates will not be 
achievable.

4 Control cable from the TIM card nose board to the AccesIO tail board. If this 
cable is not in place, video frames may not be clocked and/or Studio may not 
start recording correctly.

Missing/Improper Wire and Cable Connections - Synchronized Systems

Cabling is slightly different when CinePlex and MAPs are deployed as multi-
ple synchronized systems using a Quad MAP Controller (QMC). Again, be 
sure that all required cable connections are in place and tight. This includes:

1 BNC cable and start button to the “BUTTON” input on the QMC OR BNC 
cable from the “PULSE” input on the QMC to an external experiment control 
system.

2 Control cable from the Master MAP TIM nose board to the QMC “CPX CTRL 
IN” socket.

3 Control cables from the QMC “CPX CONTROL OUT” for each system to their 
respective AccesIO tail boards. If this cable is not in place, video frames may 
not be clocked and/or Studio may not start recording correctly.

4 BNC Start cable from the QMC “START” socket to the “XS2” BNC connector 
on the TIM card on each synchronized MAP system.

5 BNC clock cable from the Quad MAP controller “CLK OUT” connector to the 
“Remote CLK” on each of the respective TIM boards. Also make sure that the 
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toggle switch above these connectors is in the down position to select the 
remote clock.

6 Optionally, digital input signals from an external system can be input to the 
“DIGITAL INPUT” socket on the QMC where they are made available on the 
“DIGITAL OUTPUT” sockets to all MAP boxes.

7 Trigger cable(s) from the AccesIO tail board to the camera(s).

8 FireWire cable(s) from the FireWire card in the computer to the camera(s). If 
there are two cameras, there must be an empty FireWire socket between the 
two connections to the FireWire board or maximum frame rates will not be 
achievable.

Cables Too Short between Camera(s) and MAP/CinePlex Computer

Plexon supplies several lengths of these cables from 7 feet (2 meters) to 26 
feet (8 meters). Please contact Plexon if one of these standard lengths will 
work in the installation. Note that cable lengths over 26 feet result in intermit-
tent video signals at higher frame rates and are NOT RECOMMENDED.

Unstable Camera Mounting

Camera mounts must be stable or the resulting video data will shake and not 
be repeatable. This can be the case, for example, when a tripod is used to 
mount a camera, instead of the preferred wall or ceiling mount. Please refer to 
“Appendix C- Lens Selection, Experiment Design, and Camera Installation”.
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B.2 Other Issues

General Problem Solution - No Video from Camera and Other Problems

The correct starting sequence must be applied to the MAP box, Sort Client, 
and CinePlex Studio. Not following the sequence completely is the cause of 
many types of errors, including no video being shown from the cameras. The 
startup sequence is as follows:

1 Power up the MAP.

2 Power up the computer, log in as Administrator, bring up the Server program, 
and then bring up the Sort Client program. Select the desired Parameters file.

3 In Sort Client, press “START” button and then the start recording triangular 
icon. Then press the stop recording rectangular icon.

4 Bring up CinePlex Studio. Verify that video is showing and select a tracking 
mode. Adjust parameters so that objects are being tracked successfully.

5 Contact Plexon support if problem is not resolved.

Error Messages While Running the Software Installation Package

The installation package adds programs and DLLs to the system. Therefore, 
the installation software:

1 Must be run from a computer account with administrator privileges.

2 Cannot be installed on a Vista computer.

3 Cannot be installed on a 64 bit computer.

4 Must be downloaded to and run from a local hard drive. Removable drives, 
including USB flash drives and USB hard drives, are not acceptable. Neither 
are networked drives.

5 Contact Plexon support if problem is not resolved.

Antivirus Software

Some MAP/CPX systems come from Plexon with antivirus software pre-
installed. The system has been tested with this antivirus software in place and 
should operated without problem as long as software and update settings are 
not changed. If problems occur that can be traced to the pre-installed antivirus 
software, please contact Plexon Support. It could be that a new set of virus 
signature files has caused some CinePlex components to be flagged as 
untrustworthy.

Please do not install any other antivirus software on the MAP/CPX computer 
without consulting Plexon Support first. There are two reasons for this:

1 First, some antivirus tools have been know to quarantine or remove key 
components of the CinePlex system, rendering it unusable. A reinstallation of 
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the CinePlex software will be required after the antivirus tool is removed from 
the computer.

2 Second, periodic downloads of updates or periodic scans for infections can 
disrupt video streams and processing, causing lost frames and delayed 
events.

3 Contact Plexon support if problem is not resolved.

Studio Will Not Start At All

There can be many causes for Studio failing to start when its icon is clicked or 
displaying an error and failing to start when OK is clicked. The most common 
causes and their solutions are shown below.

1 Missing CinePlex license key. Obtain or find the correct license key and 
restart CinePlex.

2 If CinePlex still will not start and reports a missing license key, install the 
Sentinel drivers (this is done by the CinePlex installation software or by 
running the file C:\Program Files\Plexon Inc\CinePlex\Common Files\Sentinel 
System Driver Installer 7.4.0.exe).

3 If CinePlex reports missing DLLs, reinstall CinePlex. All the required DLLs are 
in the installation package.

4 Contact Plexon support if problem is not resolved.

Studio Will Not Start In or Switch to Camera Mode

There can be many causes for Studio failing to go into camera mode. The 
most common causes and their solutions are shown below.

1 Missing MAP and/or CinePlex license key. Obtain or find the correct license 
key, install the Sentinel drivers (this is done by the CinePlex installation 
software), and restart CinePlex.

2 Missing or inoperative IO card or drivers.

3 Camera cables are loose or unplugged. Power all components of the system 
down, then check and reseat both ends of the two cables to the camera. 
Power the system back up, and follow the normal startup steps.

4 Contact Plexon support if problem is not resolved.

Studio Cannot Find AccesIO Drivers

1 Check for and disable any antivirus software. If the AccessIO drivers are in 
quarantine, restore them.

2 Try running Studio again. If the system still cannot find the AccesIO drivers go 
o the next step.

3 Reinstall CinePlex.

4 Contact Plexon support if problem is not resolved.

No Video in Studio

1 Sort Client must have a valid configuration file and the button labeled 
“START” must have been pushed. Until this has been done, no CinePlex 
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clock (or MAP clock from which it is derived) is being generated, so there is 
not video frame trigger.

2 After powering the system down, check the camera cables, especially the 
CPX control cables.

3 Power the system back up and follow the normal startup steps.

4 If there is still a problem ensure that the manual iris control on the lens is fully 
open.

5 If the problem is still not resolved, there is a standalone un-triggered tool that 
will display video from the camera(s) if it is connected correctly and 
operational. Open the file below:

C:\Program Files\Plexon Inc\CinePlex\Common 
Files\AVT_SmartView_1_8.exe

6 If there is video for a particular camera using this tool, the camera and its 
FireWire cables are OK, and something is wrong with MAP cabling or 
operation. If no video, contact Plexon Support.

Cannot Focus the Video Image

The video is present, but blurry and cannot be focused at any zoom or focus 
setting. Note that the nearest focus for Plexon supplied lenses is from 0.2 to 
1.6 meters depending on the lens.

1 Check for the presence of an annular spacer between the lens and the 
camera. The spacer should be present if the lens is a C-mount lens like 
Plexon’s H6Z0812. The spacer should be absent for CS-mount lenses like the 
H32Z4512.

2 Adjust the zoom and focus rings on the lens until a clear picture is obtained. 
See figure above.

3 Contact Plexon support if problem is not resolved.

Slow Video in Studio

The video is present, but is updating very, very slowly - perhaps once every 
several minutes.
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1 Remove the TIM card and check that the DIVCLK jumper is on the 1 MHz 
position instead of the 1 kHz setting. If not, move it to the 1 MHz setting.

2 Contact Plexon support if problem not resolved.

Filtering Video

Video is present, but the image is flickering.

1 Turn off any fluorescent lights illuminating the arena and use incandescent 
lights instead. If the flickering goes away, there may be problems with the 
fluorescent bulbs themselves, the starters, or the ballast. If fluorescent 
fixtures must be used, these problems must be fixed. Otherwise, look for 
alternative lighting sources

2 Contact Plexon support if problem is not resolved.

Arena is Too Small or Too Large within the Video Image

Once video has been obtained, the camera and lens must be adjusted so that 
the maximum dimension of the arena nearly fills the long dimension of the 
video image while ensuring that all other parts of the arena are within the 
video image as well.

1 If the arena image is too small, move the camera closer to the arena (outside 
of the near limit) or adjust the zoom ring towards the T (telephoto). Then 
adjust the lens focus ring until the video image is clear, if possible.

2 If the arena image is too large, move the camera away from the arena (within 
the physical limits of the environment) or adjust zoom ring towards the W 
(Wide Angle). Then adjust the lens focus ring until the image is clear, if 
possible.

3 Contact Plexon support if the arena cannot be adjusted to fill the video 
window.

Studio Will Not Start Recording When the Sort Client Start Icon is 
Pushed

1 Check that the Rasputin Datafile Options are set up for CPX operation If Sort 
Client does not have these options available, contact Plexon Support to 
obtain the latest version.

2 Check that Studio is in the armed mode, waiting for Sort Client to start 
recording.

3 Check cables, especially the control cables - see the Physical Installation 
section of this document.

4 Check that the disk selected for recording video files is not full.

5 Contact Plexon support if problem is not resolved.

No Strobed Data Showing in Sort Client after Initial Startup

Usually, this occurs because the correct starting sequence has not been 
applied to the MAP box, Sort Client, and CinePlex Studio. The startup 
sequence is detailed in the section above General Problem Solution - Startup 
Sequence Not Followed.
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1 Follow the start sequence. Go to LED or Markers mode. Press the PLX button 
next to up to three colors.

2 In Sort Client, ensure that the Strobed Data box is checked on the Settings/
Events tab. Press the Activity tab icon so that tab appears.

3 Scroll down to the bottom of the Activity tab window and verify that strobed 
data hash marks are being displayed.

4 Earlier version of Sort Client may not always display strobed data even 
though it is being received and written to the PLX data file successfully. Use 
the section below to verify strobed data in earlier versions of Sort Client.

5 Contact Plexon support if problem is not resolved.

No Strobed Data Showing in Earlier Versions of Sort Client - Use 
VTViewer

Sometimes, strobed data may not appear on the Activity tab after recording 
has been started. This is due to a display fault in earlier versions of Sort Cli-
ent. The simple VTViewer client may be used to verify the generation of 
strobed data in this case.

1 Use the VTViewer icon or open the file below (on the MAP/CPX computer) to 
bring up the VTViewer program

C:\Program Files\Plexon Inc\CinePlex\Common Files\VTViewer.exe

2 Drop down the File menu and select the Connect option.

3 If the connection to Sort Client has been successful, colored spots 
representing current reported positions of the tracked objects will appear on 
the VTViewer grid.

4 If no colored spots are shown, please contact Plexon support.

Live Video Being Corrupted or Neural Data Being Dropped

Sometimes the live data will be corrupted or neural data will be dropped.

1 Try reducing monitor count, monitor resolution, or both.

2 If cards have recently been added to the PC bus, remove them to see if the 
problem is solved.

3 Contact Plexon Support for help in rearranging the order that existing cards 
are plugged into the PC bus.

Dropped Frame Count Non-zero While Recording

When the MAP/CPX computer is heavily loaded causing available video buff-
ering to fill, video frames may be dropped. The count of dropped frames is 
incremented each time this happens. This is not a normal condition and prob-
ably indicates that the computer is being asked to perform more than MAP/
CPX processing.
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1 Stop running all unnecessary applications on the computer while recording. 
This includes CinePlex Editor, which can initiate intensive hard drive activity. 
Use the Task Manager to display and end unneeded tasks.

2 Disable scheduled tasks such as backup and Windows Update. These can 
cause dropped frames when they run. Use the Task Scheduler to view all 
tasks. Contact the system administrator to disable unwanted tasks.

3 Internet activity, especially that involving heavy downloads such as from 
YouTube or similar sites should be prohibited on the MAP/CPX computer. To 
avoid this possibility Plexon recommends placing the computer on a subnet 
isolated from intensive internet traffic.

4 If dropped frames still persist after these steps, please contact Plexon 
Support.

B.3.16 Other Typical Problems and Solutions

This section includes a list of some of the other typical problems with remedies 
for each one. 

Note: The following problem refers to CinePlex Capture (earlier version of CinePlex 
Studio).

The following dialog appears when trying to run CinePlex Capture: 

1 If the following CinePlex Capture dialog box appears after starting CinePlex 
Capture, read the instructions in the box. Verify the camera connections as 
detailed in the steps that follow.

2 Check the 1394 cable between the camera and the CinePlex Capture 
computer. Make sure the cable is undamaged. Make sure to connect the 
cable to the “In” port on the camera. Do not connect the cable to the 
“DaisyChain” port on the camera.

3 Make sure the camera is the same camera that Plexon shipped with the 
CinePlex Capture computer. CinePlex cameras and computers are uniquely 
calibrated to each another and they are not interchangeable.
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The video preview display is black

1 Set the manual iris control on the camera by twisting middle ring (iris) on the 
camera lens from closed to open.

2 From the File menu, click Set Defaults.

The video preview display is out of focus

1 Set the zoom and the focus controls on the camera by twisting the outer and 
inner rings on the camera lens until a clear picture displays in the Video 
window.

2 On CS mount cameras, ensure that the C to CS adaptor ring is not installed 
between the lens and the camera.

Dropped Frame Counts

1 Stop running all unnecessary applications on the computer while recording. 
This includes CinePlex Editor, which has file intensive activity. Use the Task 
Manager to display and end unneeded tasks.

2 Disable tasks such as backup and Windows Update. These can cause DFC 
increments when they run. Use the Task Scheduler to vie all scheduled tasks.

3 Place the CinePlex System computer on a subnet isolated from intensive 
internet traffic.

4 If the problem persists, please contact Plexon Support.

For details on DFC counts, see “Status Information  on Page 149” and/or 
“Dropped Frames  on Page 56”.
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B.3 CinePlex Studio Messages

The table below lists the CinePlex Studio system simple messages. In the table 
below %s, %d, and \%s\ are variable text strings that differ between messages.

Table 1: CinePlex Studio Simple Messages

Error # Message

C100 CinePlex Studio version %s Starting...

C101 Current date:

C102 Date change. Current date:

C103 Current display frequency

C104 Display frequency successfully changed to %d Hz

C107 Factory default settings loaded

C108 Loading startup settings from \%s\ failed because this version of settings file is not 
supported by Current version of CinePlex Studio

C109 Current CinePlex Studio does not support this version of settings file. Try to read 
another file.

C110 Loading last saved settings file \%s\ failed because the file is missing. Factory 
default settings have been applied

C111 Settings loading failed because file \%s\ is missing. Factory default settings have 
been applied

C112 No settings file to load. Factory default settings have been applied

C113 Startup settings loaded from \%s\

C114 Settings loaded from \%s\

C115 Background image loaded from \%s\

C116 Settings stored in the file \%s\

C117 Background image stored in the file \%s\

C118 Play file started

C119 Combination Events view presented

C120 Video view presented

C121 Recorder Properties view presented

C122 Area Properties view presented

C123 Messages view presented

C124 Previous video configuration is not applicable due to hardware changes or absence 
of Rasputin key

C125 Video configuration has been automatically reset to One File
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C126 The layout loaded contains panels incompatible with the current license. These pan-
els are removed.

C127 Remote start received and discarded

C128 Remote stop received and discarded

C129 Remote pause received and discarded

C130 Video configuration has been automatically set to two cameras

C131 Video configuration has been automatically set to Camera 1

C132 Video configuration has been automatically set to One File

C133 Video configuration has been automatically reset to Camera 1

C135 Armed for remote control - DVR control by MAP is now enabled

C136 Remote control disabled -

C137 Recording \%s\ started by MAP

C138 Recording \%s\ paused by MAP

C139 Recording \%s\ resumed by MAP

C140 Recording \%s\ stopped by MAP (%d dropped frame(s), %d MQU)

C141 Recording \%s\ started locally

C142 Recording \%s\ stopped locally (%d dropped frame(s), %d MQU)

C143 Recording \%s\ paused locally

C144 Recording \%s\ resumed locally

C145 Tracking switched to Object Contour mode

C146 Object Contour tracking stopped

C147 No LEDs are active. The objects for dynamic zones will be switched to N/A.

C148 Tracking switched to LED mode

C149 LED tracking stopped

C150 Can not switch to LED mode, since tracking license is not detected

C151 Tracking switched to Reflective Colors mode

C152 Reflective Colors tracking stopped

C153 Can not switch to Reflective Colors mode, since tracking license is not detected 

C154 Recording \%s\ stopped due to missing license key

C155 Tracking stopped due to missing license

Table 1: CinePlex Studio Simple Messages

Error # Message
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C156 No markers are active. The objects used in dynamic zones will be switched to N/A.

C158 Recording \%s\ stopped since file size on FAT32 drive cannot exceed 4GB (%d 
dropped frame(s), %d MQU)

C159 Recording \%s\ stopped due to low disk space (%d dropped frame(s), %d MQU)

C160 Can not start recording since disk information can not be retrieved

C162 Can not start recording due to low disk space.

C163 Wizard opened

C164 Wizard finished

C165 CPX Studio window size reduced by Shrink button

C166 CPX Studio window size restored by Expand button

C167 Date has changed since the last file was recorded. The file number reset to 001

C168 Can not add sequence due to missing license key

C169 Tracking settings ignored since missing license

C171 Tracker Properties view presented

C172 New shape added to Arena

C173 New shape added to Zone

C174 Shape #%d deleted from Arena

C175 Shape #%d deleted from Zone

C176 Tracking Events view presented

C177 Event Statistics view presented

C178 Output lines for the loaded tracking events ignored since no digital output device 
found

C179 All shapes deleted from Arena

C180 All shapes deleted from Zone

C181 Temporary AVI file \%s\ renamed to \%s\

C182 Renaming temporary AVI file \%s\ failed

C183 Temporary DVT file \%s\ renamed to \%s\

C184 Renaming temporary DVT file \%s\ failed

C190 Zone Sequences view presented

C193 Video Properties view presented

C194 Previous video configuration was \%s\

Table 1: CinePlex Studio Simple Messages

Error # Message



B  

B-14  CinePlex

The table below lists the CinePlex Studio critical messages.

Table 2: CinePlex Studio Critical Messages

Error # Message

C898 MAP and CinePlex Studio out of synch.

C900 Clock signal not detected

C901 Clock signal detected

C902 Recording \%s\ stopped due to loss of clock

C904 Current CinePlex Studio does not support this version of settings file. Try to read 
another file.

C905 Can not be armed for remote recording before arena definition is finished

C906 Apparently Adobe Acrobat Reader is not installed on this system
           This is required to display the help file.
            Please go to http://www.adobe.com, download the latest version, and install it.

C907 Cannot find the manual at: %s

C908 Error code %d has occurred while trying to open %s.

C999 Polygon can not have less than 3 points.

C910 Can not create self-intersecting polygons.

C911 Recording folder doesn’t exist. Please choose another one.

C912 Saved layout does not exist

C913 Unable to load the requested layout! The default layout applied

C914 Can not be armed for remote recording until Wizard is exited.

C915 Can not start recording until Wizard is exited.

C916 Can not add new zone: number of zones of interest can not exceed 100.

C917 Can not add new zone: the boundary of the last existing zone is not defined.

C918 The number of shapes in arena can not exceed 100.

C919 The number of shapes in zone can not exceed 100.

C920 Overlapped zones are not allowed in sequence

C921 Can't delete selected zone since it is used for generation of tracking event(s). Modify 
the event(s) first.

C922 Can't delete selected zone since it is used in sequence(s). Modify sequence(s) first.

C923 The number of events can not exceed 100.

C924 Can't delete the last remaining shape from the selected zone since it is used for gen-
eration of tracking event(s). Modify the event(s) first.

C925 Can not be armed for remote recording due to missing license key
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C926 Can not add event since LED or Marker tracking mode is not selected.

C927 Can not add event since no LEDs selected.

C928 Can not add event since no markers selected.

C929 Can't delete selected sequence since it is used for generation of tracking event(s). 
Modify the event(s) first

C930 Unable to save current layout

C931 Can not add combination event since tracking mode is not selected.

C932 Can not add combination combination since no single events are defined.

C933 Can not add new combination event since not all events for the last combination are 
defined.

C934 Can not add new combination event since not all events for the last combination are 
defined.

C935 Can't uncheck selected LED since it is used for generation of tracking event(s). Mod-
ify the event(s) first.

C936 Can't uncheck selected marker since it is used for generation of tracking event(s). 
Modify the event(s) first.

C937 Can not add event since tracking mode is not selected.

C938 Can not add event since no LEDs selected

C939 Can not add event since no markers selected.

C940 No Rasputin key found. Switching to offline mode

C941 Access I//O board is not found, but cameras are detected. Switch to test mode? 
Clicking YES will switch Studio to the test mode. Otherwise Studio will start in offline 
mode.

C942 Access I//O board is not found. Switching to test mode

C943 Access I//O board is not found. Switching to offline mode

C944 No clock signal from MAP, but cameras are detected. Switch to test mode? Clicking 
YES will switch Studio to the test mode. Otherwise Studio will start in offline mode.

C945 No clock signal from MAP. Switching to test mode

C946 No clock signal from MAP. Switching to offline mode

C947 Recording is stopped, since recordings longer than 1 min. are not allowed in test 
mode

C948 Can not add new sequence since the previously added sequence contains no zones.

C949 Can not add new sequence since the last zone in the previously added sequence is 
undefined.

Table 2: CinePlex Studio Critical Messages

Error # Message
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C950 The number of sequences can not exceed 100.

C951 Can't delete selected sequence since it is used for generation of tracking event(s). 
Modify the event(s) first.

C952 Can not add new zone to the current sequence since the last zone in the sequence 
is undefined.

C953 Sequence can not contain more than 100 zones.

C954 Can not add new zone to the current sequence since no zones is defined.

Table 2: CinePlex Studio Critical Messages

Error # Message
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Appendix C 
Lens Selection, Experiment Design, and 
Camera Installation
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C.4.2 Bracket Mounting Choices to Make .................................. C-11
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C.4.4 Examples Using Optional Accessories .............................C-18

C.4.5 Camera Removal..............................................................C-19

CAUTION
Never plug or unplug a camera FireWire cable with the PC Power ON. 
Permanent damage to the camera may result.
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C.1 Introduction

This appendix is intended to assist current and prospective customers with ques-
tions and advice regarding physical implementation of a CinePlex Version 3 sys-
tem in their laboratories.

In any experiment where video recording would enhance experimental results or 
is required in a particular experiment, there is a particular area of interest in 
which it would be meaningful to record video. This area of interest can be a sim-
ple enclosure, a maze, a geometrical track, or any other area needed for the exper-
iment. For video recording of behaving animals, this area of interest is known as 
the arena. The arena shape and size are critical in determining the lens used and 
the distance from the camera to the arena. Colors used and target visibility are 
also extremely important.

The second section explains how to select the best lens for the video camera 
within the limits of the experiment’s environment. The third section discusses 
general experiment design issues that relate to video recording, including arena 
layout. The fourth section describes requirements and procedures for video cam-
era installation.

The result should be that an experimenter achieves the capability to set up for and 
install CinePlex Version 3 to conduct successful experiments collecting neural 
and video data.

Plexon hopes that this procedure solves these issues for most installations. Plexon 
welcomes feedback as to how to improve the experience. Please contact Plexon 
support at support@plexoninc.com (+1 214 369 4957) with comments.
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C.2 Lens Selection

For CinePlex Version 3, Plexon currently offers the AVT Stingray camera (Type 
1/2 CCD) and several lenses - both varifocal and zoom. Experimental setups may 
have to be changed to accommodate camera and lens limitations. The limiting 
factors are that the lens must be able to focus the arena image and that the arena 
image should fill the screen. If the camera’s distance to the arena is fixed, the 
arena size must be kept within certain limits for best results. Alternatively, if the 
arena size is fixed, the distance between the camera and arena must be kept 
within limits for best results.

Most investigators will find that they need to compromise arena size and/or cam-
era distance to accommodate the physical limitations of the camera/lens combi-
nations.

Procedure for Lens Selection

1 Determine Optimal Arena Setups

Use the charts below to determine if a particular lens can be used with the 
current experimental setup. The area between the green and blue lines in the 
charts represents arena size and camera distance combinations that are 
acceptable for best results.
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2 Determine the distance from the camera to the arena in meters

This distance should be as far as possible from the arena, while still close 
enough to allow the zoom function to fill the sensor with the arena image. Be 
sure to allow space for camera mounting. Find that distance on the X-axis 
(Camera Distance) of the Standard Varifocal chart.

3 Determine the size of the arena in meters

Imagine a circle, square or 4:3 rectangle drawn around the arena, completely 
enclosing it. The Arena Size in the charts above is the diameter of the circle, 
the side of the square, or the longer side of the 4:3 rectangle. Find that size on 
the Y-axis (Arena Size) of the Standard Varifocal chart.

4 Determine if the arena size and camera distance are optimal

If the (X,Y) position specified by the Camera Distance and Arena Size is in the 
area between the Green and Blue lines, the setup should yield optimal results 
when the camera is zoomed appropriately. It is not necessary to proceed. The 
Standard Varifocal lens will work. If the (X,Y) position specified by the Arena 
Size and Camera Distance is NOT in the area between the Green and Blue 
lines, the setup is sub-optimal. The image will be smaller than desirable, 
larger than desirable, or out of focus.

5 If the position is not optimal, try the steps above on the chart for the Zoom 
lens

If this lens yields an optimal result, contact Plexon to obtain the lens. If not, try 
adjusting Arena Size and Camera Distance to find an optimal combination 
with one of the lenses.

6 If an optimal result cannot be obtained using this procedure, contact Plexon 
for other lens possibilities

Note: The charts are derived from calculated numbers. Small variations in 
lens and camera manufacturing can result in as much as 10% varia-
tion.
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C.3 Experiment Design

C.3.1 Field of View

The field of view (what the sensor of the camera sees) depends on the distance 
between the camera and the surface and the angles of view of the lens that is used 
with the camera. The cameras supplied by Plexon generate screen images that are 
4 units wide by 3 units high as shown by the diagram below. This aspect ratio cor-
responds to the sensor image size of 640 by 480 pixels.

Orient the camera to the experimental area to take maximum advantage of the 
rectangular field of view. As shown in the following illustration, the 4:3 ratio cor-
responds to a horizontal dimension (H) that is 1.33 times the vertical dimension 
(V).

When the camera is placed so that it is directed towards the experimental area, it 
has a horizontal angle of view and a different vertical angle of view because of 
the aspect ratio described above. The image producing sensor in the camera is 
also rectangular in the same proportion. So the ideal experimental layout will 
have a rectangular 4:3 arena with the camera aligned so that its longer (horizon-
tal) sensor dimension is parallel to the arena’s long side. Actual arenas may not be 
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4:3 rectangles, but in all cases, best results will be obtained when the longest 
dimension of the arena is parallel to the longer sensor dimension of the camera.

When the camera and lens are viewed as shown in the image below, the long axis 
of the sensor is in the horizontal plane. This axis should be parallel to the longest 
dimension of the experimental area.

The table below shows the horizontal and vertical angles of view that correspond 
with maximum and minimum zoom of the camera, using the standard lens as an 
example. Other lenses will differ.

The best way to avoid optical distortions is to set the lens at Maximum Zoom and 
move the camera far enough away from the experiment that the maze, cage, track 
or other setup is completely imaged This is the optimum height. See figure below.

Figure C-1

Field of View Estimation (Maze Size)

Table C-1 Angles of View

normal lens)

Maximum zoom 
(minimum angle and 

area covered)

Minimum zoom 
(maximum angle and 

area covered)

Horizontal 30 degrees 83 degrees

Vertical 22 degrees 61 degrees
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The formula to calculate the optimum height (H) of a camera over a square maze 
of side L (or a circular maze of diameter L) is:

If the maze is round or square, use the Vertical Maximum zoom angle (or 22 
degrees for the normal lens). If the maze is rectangular, use the Horizontal Maxi-
mum Zoom angle (30 degrees for the normal lens).

C.3.2 Colors

In contour tracking, to achieve the best tracking accuracy, choose colors with 
maximum contrast. For example, if the target animal is white, choose black or 
another dark color for the arena floor. Likewise, if the target is dark-colored, 
choose a bright white or other light color for the floor. For multi-colored animals 
like Long-Evans rats, red has been shown to have good contrast to the animal’s 
fur colors. It may be necessary to experiment to determine the best background 
color in individual situations.

In all tracking modes, use materials with solid colors as floors, if at all possible. 
Avoid floor materials with patterns or textures.

C.3.3 Visibility

Unless otherwise required, the design of the arena should ensure that the target is 
completely visible to the camera in all areas. If the target is partially obscured by 
overhangs or other obstacles during its travel around the arena, the centroid cal-
culations that determine target position and orientation can be affected.

H L

2

2
--- 
 tan

---------------------=
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C.4 Camera Installation

C.4.1 The Plexon Camera Mounting Kit and Accessories

For repeatable, reliable video recording, the video camera(s) must be mounted 
stably and and securely with respect to the experimental area. Cameras that 
vibrate or move can result in not just partial recordings or blurred images, but 
also in inaccurate position metrics, event triggers at undesired times, and, worst 
of all, non-repeatable experimental trials.

C.4.1.1 Plexon Mounting Kit

The Plexon mounting kit consists of both purchased and Plexon manufactured 
parts. It is included with CinePlex Version 3 and later cameras. The parts have 
been selected to apply in most of the situations encountered while doing CinePlex 
installations. Note that because of the general nature of the kit, not all parts will 
be used in all cases. In addition, there will be some cases where a particular 
installation will require that the customer purchase some additional parts locally.

1 Mounting Bracket (Plexon 07-05-M-01)

2 Sandwich Plate (Plexon 07-05-M-02)

1

3

4

2

5
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3 Three Arm Phenolic Knob (small) - 1/4”-20 (3 ea.)(McMaster Carr 
57715K16)

4 Three Arm Phenolic Knob (large) - 3/8”-16 (McMaster Carr 57715K83)

5 Quick Change Mounting Assembly (Bogen-Manfrotto)

a  Rectangular Plate Adaptor (323)

b  Rectangular Plate (200PL)

C.4.1.2 Customer Supplied Parts as needed

The mounting kit does not include the small parts required for securing the 
mounting bracket to the desired surface. In those cases the customer will need to 
acquire the needed parts locally. Depending on the nature of the surface; screws, 
bolts, wall anchors, adhesive, or other items may be needed for a particular exper-
imental setup. The customer should acquire these as needed.

C.4.1.3 Optional Mounting Accessories

Some experimental setups may require hard-to-find parts over and above those 
supplied in the Plexon Mounting Kit. Plexon has some optional parts available 
that can help provide secure mounting in many non-typical situations. See pages 
X and Y for some examples using these optional accessories.

1 Camera Mounting Plate 3x6” (Plexon 07-03-M-01)

1
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2 Stud 036-014 (1/4”-20 m x 1/4” 20 f)(Bogen Manfrotto 036-014)*

3 Stud 036-038 (3/8” m x 3/8” f)(Bogen Manfrotto 036-038)*

4 Stud 037 (1/4”-20 m x 3/8” m)(Bogen Manfrotto 037)*

5 Stud 066 (1/4”-20 f x 2/8” f)(Bogen Manfrotto 066)*

6 Ball Head - Micro (Bogen Manfrotto 482)*

7 Ball Head - Mini w/ RC2 (Bogen Manfrotto 484RC2)*

8 Ball Head - Compact w/ RC2 (Bogen Manfrotto 486RC2)*

* Starred optional items are available from:

• Plexon - please contact the Plexon salesperson

• Online - search for “Manfrotto” and the item number from many sources such 
as:

— http://www.amazon.com/

— http://www.ritzcamera.com/

— http://www.bhphotovideo.com/

2
3

4
5

6 7 8
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• A local professional camera or video store

C.4.2 Bracket Mounting Choices to Make

First, choose where the camera should be mounted. Common choices are shown 
below:

C.4.2.1 Above the Experiment

1 Ceiling mount

2 Top of enclosure

a  Inside of enclosure with room for cables

b  Above the enclosure through an opening

c  Inside of cage with room for cables

C.4.2.2 From the side of the Experiment

1 Wall mount

2 Side of enclosure

a  Inside of enclosure with room for cables

b  Outside of enclosure through an opening

c  Inside of cage with room for cables

C.4.2.3 Below the Experiment

1 Up through a glass or cage floor to view the undersides of animals or for birds 
in perches

2 Floor mount aimed up an animals in the air or above the floor

3 Below enclosure

a  Inside of enclosure with room for cables

b  Below the enclosure through an opening

c  Inside of cage with room for cables

CAUTION ABOUT TRIPODS
Note specifically that tripod mounting of the camera is NOT RECOM-
MENDED. This is because tripod adjustments, particularly leg locking 
mechanisms, can loosen and become unstable. Tripods can also be 
jostled or moved easily since they are generally not secured to a sur-
face.
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C.4.2.4 Bracket Attachment Methods

Then, choose the most appropriate method of attaching the camera mounting 
bracket to the desired location.

1 On a surface of a wall or ceiling over 0.4 in (1 cm) thick, use one of the fol-
lowing methods or devise a custom method.

a  Customer provided screws through the three threaded holes in the bracket 
into the wall. Wall anchors should be used as necessary.

b  Customer provided bolts through the three threaded holes in the bracket 
into a wooden surface. Pilot holes can be drilled, if needed, using the sand-
wich plate as a template.

c  Customer provided adhesive or epoxy to glue the surface of the mounting 
bracket containing the three threaded holes to the surface.

2 On a cage:
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a  Place the sandwich plate on the outside of the cage, then

b  Insert the three small knobs through the sandwich plate holes and through 
openings in the cage, then

c  Thread the three small knobs into the threaded holes in the mounting plate.

3 On a wall or surface under 0.4 inches (1 cm) thick:

a  Drill three 9/32” (7 mm) holes using the sandwich plate as a template, then

b  Insert the three small knobs through the wall into the threaded holes in the 
mounting plate.
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C.4.3 Installing the Camera

Procedure for Camera Installation

1 Power down all system components - computer, MAP, etc.

2 Select the bracket attachment method suitable for the experiment and install 
the mounting bracket. Make sure that the mounting bracket is firmly attached 
and stable.

3 Install the rectangular plate adaptor on the mounting bracket using the large 
phenolic knob. For most applications, the point of large lever should be 
pointing away from the experiment when secured. Tighten finger-tight.

4 Make sure that the large lever on the plate adaptor is in the open position and 
ready to accept the plate. If the large lever cannot be moved easily, move the 
small brass level to the unlock position, and try again.

5 Remove any cables from the camera, if present.

6 Attach lens to camera by screwing it on finger-tight.
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7 The tripod adaptor should already be attached to the camera - if not, do so at 
this time.

8 Attach the rectangular plate to the camera tripod adaptor. For most 
applications, the lens should be oriented in the position labeled “2 LENS”. use 
the attached wire loop to finger-tighten the camera and then fold the loop 
down.

a Position “1 LENS” shown below

b Position “2 LENS” shown below
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9 Snap the camera/plate combination into the plate adaptor that is already 
attached to the mounting bracket. Note that there is only one possible 
orientation. The large lever will snap closed. Move the small brass lever to the 
lock position. Make sure that the large lever cannot be unlocked.

10 Attach the FireWire cable(s) to the camera(s). Use the FireWire socket 
labeled “1” in the photo.

11 Connect the other end(s) of the camera FireWire cable(s) to the FireWire 
board in the computer. The cable for Camera 1 should be connected to Port1 
or Port2 on the FireWire board. If  there is a second camera, it should be 
connected to Port3 or Port4. Tighten the screws so that each plug is secure in 
its socket.

CAUTION
Never plug or unplug a camera FireWire cable with the PC Power ON. 
Permanent damage to the camera may result.

1 2
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12 Now connect the trigger cable(s) to the BNC connector on the AccesIO 
adaptor on the computer. If there are two cameras, a BNC T-adaptor will also 
be required.

13 Make sure all other system cables are attached as required. Apply power to 
all components, bring up the MAP Server and Sort Client and press the Start 
button on Sort Client. Bring up CinePlex and ensure that video is present. If 
not, go to the Troubleshooting section of the CinePlex manual and work 
through those procedures until a picture is present. If unable to get a picture, 
please contact Plexon support.

14 Loosen the large phenolic knob holding the camera/plate assembly to the 
mounting bracket and adjust the camera orientation until the experimental 
area is centered. Then tighten the large phenolic knob. It may also be 
necessary to repeat Step 8 with the camera in the “1 Lens” position of more 
adjustment latitude is needed.

15 Adjust the camera zoom until the experimental area fills the viewable image. If 
this is not possible the camera may need to be moved closer to or further 
away from the experiment. This can be done by selecting a different hole in 
the mounting bracket for the adaptor plate attachment. If there is space 
available, the mounting bracket may even be moved to the other side of its 
mounting surface. If a satisfactory view is still not possible, contact Plexon 
support for additional lens options.

16 Adjust focus, and iris as needed for a good image.

C.4.3.1 Mounting Options for Multi-camera Systems

Place each camera as needed to record its area of interest. Make the choices 
required for each position. Install each camera using the procedure.

Port 1      Port 2        Port 3         Port 4

Camera
To To

Camera

Port 1

Port 2

Port 3

Port 4
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C.4.4 Examples Using Optional Accessories

Some difficult mounting situations require the use of some of the optional mount-
ing accessories mounted shown earlier. Here are some examples.

1 Using the optional Mini Ball Head between the camera and the mounting 
plate.

2 Using multiple ball heads to achieve difficult angles.
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3 Using the Plexon camera mounting plate together with a ball head and stud 
037 to achieve an offset camera mount at a difficult angle.

C.4.5 Camera Removal

Procedure for Camera Removal

1 Power down all systems.

2 Remove all cables from the camera.

3 Move the small brass level to the unlock position if not already there.

4 Place a hand on the camera to catch it as it releases.

5 Move the large lever to the unlock position.

6 Catch the camera and place it in a safe location.
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C.5 CinePlex Screen Capture

It is possible to record the operation of CinePlex as well as other applications by 
the use of a screen capture program, such as Camtasia StudioThe procedure 
below describes how to use a screen capture program to record the activities on 
the computer screen. For illustrative purposes, the procedure describes the use of 
Camtasia Studio. The procedure for using other screen capture applications 
would be similar.

1 From the Start->All Programs menu, locate the screen capture program and 
open it.

2 From the Camtasia Recorder Capture->Input menu select what to record.

3 Ensure Camtasia Recorder is minimized and hit the F9 key when ready to 
record.

4 When finished recording, hit the F10 key. A dialog box will appear to allow 
naming of the recorded file and also to decide where to store the file.

5 The recorded file will be saved as an AVI file in the directory specified and the 
file will be presented for viewing immediately after saving.
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D.1 Plexon User Interface

The Plexon User Interface embodies a standard look-and-feel for Plexon soft-
ware products. To illustrate the underlying concepts behind the look-and-feel, this 
appendix uses screenshots from Plexon’s CinePlex Editor and CinePlex Studio 
applications. Although there will be differences in menus and toolbars between 
different applications, how to use, handle, and operate the user interface compo-
nents will be fundamentally the same across future generations of Plexon’s soft-
ware products including:

• CinePlex Studio

• CinePlex Editor

• Offline Sorter

This appendix covers common functionality of the look-and-feel between differ-
ent Plexon software applications. The discussion includes the following sections:

• Screen Elements

• Standard Menu Items and Dialogs

• Customization
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D.2 Screen Elements

D.2.1 Menus

The menu bar of the application contains the names of all of the menus for the 
application. Each menu name has a letter underlined which indicates the hot-key 
combination for that menu. To activate a particular menu the user may click the 
left mouse button on the name or press and hold the ALT key while pressing the 
underlined letter. The illustration below is the main menu of CinePlex Editor.

Each menu of the Plexon User Interface contain menu commands and may also 
contain Icons, Hot Keys and a Tear-off Menu Handle as shown by the illustration 
below of the Edit menu of CinePlex Editor.

While all Plexon applications are shipped with their available menu commands 
organized into a set of menus, the contents of the menus can be customized and 
new menus can be created.

• Icons - Icons may be located immediately to the left of the menu commands. 
These icons will be displayed on the toolbar associated with the menu. In the 

Icons

Tear-off Handle
Menu Commands

Hot Key



D  

D-4  CinePlex

example menu, there are icons associated with all but the last three of the 
menu commands. The presence of an icon next to a menu command means 
that the icon is also a label on a toolbar button and will execute the same com-
mand when clicked as the menu command on the menu.

• Hot Keys - Hot Keys are key combinations that will cause a menu command 
to execute without having to click the command on the menu. Typically, hot 
keys will contain two keys that must be pressed simultaneously for the com-
bination to execute. The area at the far right of the menu commands may dis-
play the hot key combinations for the menu commands. In the example menu, 
there is a hot key combination (CTRL + C) for the Copy command. Hot keys 
may be added or customized via the Tools-Customize dialog.

• Tear-off Menu Handle - The Tear-off Menu Handle is an area (the one 
containing the dots) at the top of the menu, present on many menus. The tear-
off feature allows the quick creation of a toolbar that contains all of the com-
mands in the menu that have command icons. The user may hover the mouse 
over the tool to highlight it, drag the mouse to the toolbar area and place the 
menu as a toolbar there. The illustrations below show highlighting the Tear-
off Menu Handle to begin dragging the toolbar, dragging the toolbar across 
the screen, and finally docking the toolbar in place.
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D.2.2 Toolbars

Each toolbar has a dropdown button at the right that will allow the user to add or 
remove buttons from toolbars and will also allow the user to access the Custom-
ize dialog box. When the user clicks the dropdown button the Add or Remove 
Buttons dropdown menu will appear as shown below.

The dropdown menu also has a dropdown button. Clicking that button displays a 
menu list of the available toolbars and a menu command to allow access to the 
Customize dialog box.

Expanding one of the toolbar menus will display all of the available toolbar but-
tons for that particular toolbar and a checkbox beside each one that will indicate 
whether or not the button is visible on the toolbar. There is also an option to reset 
the toolbar back to its factory default setting.
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Clicking the Customize menu command will open the Customize dialog box. 
This dialog box is common to Plexon software applications but may have differ-
ent content on the tabs according to the software application.

For details on using the Customize dialog box, see “Customization” on 
page D-19

D.2.3 Windows

The illustration below shows a typical window title bar. It contains (from left to 
right) a Title, a Auto Hide button, a Maximize button, and a Close button.

• Auto Hide Button  - The Auto Hide button “pins” a window to the 
screen to keep it visible or “rolls up” a visible window into a tab. When the 
window is pinned, the Auto Hide button points in a vertical direction. If the 
window is rolled up, the Auto Hide button points in a horizontal direction.

• Maximize Button  - The Maximize button may not appear on all win-
dows. It is the standard Windows maximize button. Clicking the Maximize 
button on a window will maximize the original window and hide other win-
dows occupying the same horizontal or vertical space. Clicking the Maxi-
mize button again will restore the previous layout. When clicked the image 
on the button toggles between one window and overlapping windows.
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• Close Button  - The Close button closes the window.

Plexon software applications often display several windows simultaneously. 
These windows may be resized by using standard resizing methods and may also 
be repositioned by dragging and dropping and by using Docking Stickers. The 
illustration below shows the repositioning of a window (denoted by the blue 
transparent rectangle) and various Docking Stickers (with red circles around 
them). These Docking Stickers allow the user to dock the window being moved 
in one of several ways described below.

The user may position a window by floating it, docking it at the desired docking 
sticker at a window edge or in a tab.

• Floating a Window - The user may drag a window by the Caption Bar 
near the center of the screen and release it causing the window to float. Hold-
ing down the CTRL key while dragging will always float the window. Dou-
ble-clicking on the Caption Bar will also float a window. Note that the size 
and position of the floating window is remembered.

— Rolled-up Windows -  Floating windows may be enabled for roll up up 
by pressing the Auto Hide button. The window will roll up when the 
focus is changed to a different window. The first illustration below 
shows a floating window before rolling it up. The second illustration 
below shows the rolled-up window after the focus has changed.
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• Docking a Window at the Application Frame - When the user begins to 
drag a window, a transparent blue rectangle appears to indicate the position of 
the window and the four Docking Stickers appear individually at each edge 
of the application frame to allow the user to dock the window to the respec-
tive edge. To dock just move the mouse to the desired Docking Sticker and 
release the mouse button. The docked window will extend along the entire 
length of the edge to which it is docked. The illustration below shows all four 
screen Docking Stickers.

• Docking a Window at a Window Edge - When the user moves the win-
dow inside another window, the window Docking Stickers appear inside the 
window grouped together near the center of the window. Releasing the mouse 
button while it is over one of these stickers (except the center one) will dock 
the moving window to the respective edge of the window associated with the 
window Docking Stickers. The illustration below shows the window Dock-
ing Stickers. Note that the shading of these Docking Stickers is different that 
the shading of the Docking Stickers in the previous illustration.

• Placing Windows into Tabs - Releasing the mouse button over the center 
Docking Sticker will allow the moving window to occupy the same space as 
the window beneath and will create tabs along the bottom for switching the 
view between the two windows. The illustration below shows the Marker 
Occurrences window without sidebar tabs on the left. On the right, a Chan-
nels window has been placed into the same space by using the center docking 
sticker. Note that there are two sidebar tabs at the bottom of the window.
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— Hidden Windows - Docked windows whose access is not needed often 
can be hidden or “rolled up” by pressing the Auto Hide button. When 
hidden, the window is represented by a sidebar tab. Sidebar tabs may 
be located at the left, right, or bottom of the screen and indicate hidden 
windows. To show one of these windows, just hover the mouse over 
one of the tabs and the window will appear. The File Info window of 
CinePlex Editor opened by the sidebar tab is shown below on the left. 
If the user clicks the Auto Hide control, the window will be pinned and 
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remain open after the user moves the mouse away from the sidebar tab 
as shown on the right. The Auto Hide button will also have changed 
direction and be pointed downward. Note also that the File Info sidebar 
tab is gone on the right illustration.
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D.3 Standard Menu Items and Dialogs

In Plexon software applications, some menu items may have the same functional-
ity across several applications. These items are standard menu items and consist 
of the Window menu, the Run menu, and the Help menu.

D.3.1 Window Menu

The Window menu contains three items: Theme, Layout, and Customize.

• Theme - Clicking on Theme displays a menu as shown below.  A theme is a 
color scheme that is part of the look-and-feel of the user interface.

— Theme Group - The top group of items are theme toggle items that 
may be selected to apply to the user interface look-and-feel. Only one 
of the themes may be selected at a time. 

— Text Below Toolbar Icons - This item is a toggle item to show or not 
show text below the toolbar icons.

— Hide Window Title Bars - This item is a toggle item to hide or show 
window title bars.

• Layout - Clicking on Layout displays a menu as shown below. A layout is 
the size and placement of the windows on the screen. It also remembers the 
number and placement of toolbars.
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— Reset to Default Layout - Clicking on this item resets the layout to the 
factory default.

— Load Layout Group - Clicking on Apply Layout 1 or Apply Layout 
2 applies one of the standard layouts to the user interface. Clicking on 
Load Layout From File will allow the user to select a layout file to 
apply to the user interface.

— Save Layout Group - Clicking on Save As Layout 1 or Save As Lay-
out 2 saves the current screen layout as one of the two standard layouts. 
The user may also click Save Layout to File to save the current screen 
layout to a file that can be loaded by the Load Layout From File item.

• Customize - Clicking Customize displays the Customize dialog box as 
shown below

For details on using the Customize dialog box, see “Customization” on 
page D-19.
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D.3.2 Run Menu

The purpose of the Run menu is to launch other applications quickly. The Run 
menu will be populated by default with some common Plexon applications. To 
launch other applications from within the current application, the user may add 
new entries to the Run menu. A sample Run menu is shown below. For addi-
tional information about customizing the Run menu, see “Run Menu Customiza-
tion” on page D-22.

D.3.3 Help Menu

The Help menu contains four items: Help, Quick Reference, Web Update, and 
About XXXXX where XXXXX is the name of the application.

• Help - Clicking Help displays the User’s Guide for the application.

• Quick Reference - Quick Reference may be missing in some applications. 
When present, clicking Quick Reference displays a dialog box similar to the 
one shown below. The purpose of the Quick Reference dialog box is to show 
keys and mouse buttons that control some of the commonly used functions in 
various views. The user may print it by clicking Print or close it by clicking 
OK.
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— Print – Click Print to print a copy of the Quick Reference. 

• Web Update - This item allows the user to update software via the internet. 
Clicking Web Update will first check to see if an update is available. If an 
update is available, it will be downloaded and installed.

• About - Clicking the About item displays the About dialog box. The text of 
the About item varies according to the application. The About dialog con-
tains the version number and build data of the application, links to the Plexon 
website and support e-mail, and buttons for Licensing, System Report, and 
Manage File Extensions.
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— Licensing - Clicking the Licensing button displays the Plexon License 
Management dialog box. The Plexon License Management window 
includes the complete licensing information for Plexon products. The 
window includes the following three areas: information, key testing, 
and code entry.

– The information area includes information on license keys and a list 
of all the Plexon products and their licensed status on this computer. 

– If the user has moved or added a key, the Test the Key Again but-
ton provides a convenient tool to test license keys to ensure they 
function correctly.

– If the user has more than one key installed, the Next Key>> and 
<<Prev Key buttons appear. The user may use these buttons to 
cycle through and test all keys.

– The code entry area is used to enter the unlock codes for optional 
programs and features. If the user has licensed optional items, 
instructions for entering codes and testing keys are included with 
Plexon installation programs.

— System Report - The purpose of the System Report button is to help 
Plexon Support diagnose problems by listing system information. 
Clicking the System Report button will first display a dialog box to 
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allow the user to display the system report on the monitor or save the 
report to a file that can be sent via E-mail to Plexon Support. 

– After selecting a choice, clicking OK will launch the standard 
Microsoft System Information tool. The illustration below shows 
the System Information report displayed on the monitor.

— Manage File Extensions - Clicking the Manage File Extensions 
button opens the Manage File Associations dialog box. The Manage 
File Associations dialog box allows the user to review and select 
which file types are associated with Plexon software applications. For 
example, when the PLX file type is associated with Offline Sorter, 
double-clicking on a PLX file will open Offline Sorter and load that 
PLX file. If the user has not installed some of the applications, their file 
extension radio buttons will be disabled.
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D.3.4 Messages Window

The Messages window displays a log of timestamps and associated application 
events that Plexon Support can use for troubleshooting purposes.

Note: The Messages window is not available for all applications.

Right-clicking the mouse in the Messages window will display a right-click 
menu with the following items:

• Erase - This item clears the window of all messages

• Pause - This item stops the logging of messages

• Show Debug Messages - This item is a toggle to show or hide debug 
messages

• Select and Copy All - This item allows the user to copy all of the messages 
to another application - such as a word processor

• Save Log to File - This item allows the user to save the messages to a log 
file.

• Mail Log to Plexon - This item allows the user to send the message log to 
Plexon for troubleshooting purposes
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D.3.5 Right-click Menus

Most windows have right-click menus that control their behavior and options. To 
open a right-click menu, place the cursor inside a window and click and release 
the right mouse button. The right-click menu appears where the mouse is clicked. 
To select a menu item, move the cursor over it and click the left mouse button.

D.3.6 Current Selections

In grid-based windows, the currently selected item always appears with a >> or 
> in the left column of the appropriate grid-based window.

D.3.7 . Undo

Plexon applications provide multiple undo levels. To undo an operation, on the 
Edit menu, click Undo or click the Undo button on the toolbar. The user may 
undo operations that change the contents of the project file but may not undo 
operations that change the user interface options or colors.
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D.4 Customization

Although the menus and toolbars offer a rich set of commands and functions that 
should meet the needs of most Plexon customers, the Customize dialog box also 
allows the user to customize several areas of the interface should the need ever 
arise. This section describes the uses of the Customize dialog box.

To open the Customize dialog box, from the Tools menu, select Customize. The 
Customize dialog box contains several tabs. The illustrations below show the 
Customize dialog box from CinePlex Editor and displays five tabs - Toolbars, 
Commands, Keyboard, Run Menu, and Options. Although the content of the 
tabs will vary according to the application, the functional operation of each tab is 
respectively the same across all Plexon software applications.

D.4.1 Toolbars Customization

An illustration of the Toolbars tab follows:

• Toolbars - This box contains a list of the toolbars for the application. Click a 
toolbar checkbox to have it appear in the main application window. 

• New - This button opens the New Toolbar dialog box. The user may use this 
feature to create a custom toolbar for commands frequently used. Enter a tool-
bar name in the Toolbar name box.

• Rename - If the user has selected a toolbar that was previously defined, click 
Rename to change the name of the toolbar. The Rename Toolbar dialog box 
displays.

• Delete - If the user has defined a new toolbar and selected it, click Delete to 
remove that toolbar. There are no default values for newly defined toolbars. 
Standard toolbars may not be deleted. A confirmation dialog box displays.
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• Reset - If the user has selected a standard toolbar, click Reset to restore the 
toolbar to its default contents. If new buttons have been dragged to a toolbar, 
click Reset to restore the default version of the toolbar. A confirmation dialog 
box displays.

D.4.2 Commands Customization

The Commands tab is used to customize which commands are available in tool-
bars. An illustration of the Commands tab follows:

• Categories - This is a list of all the toolbar categories. Select a toolbar cate-
gory to see the buttons in the Commands area.

• Commands - This area shows all the buttons and the associated menu com-
mands that belong to the selected category. The user may select the desired 
command and drag it to the toolbar.

D.4.3 Keyboard Customization

The Keyboard tab allows the user to bind keystrokes to commands. An illustra-
tion of the Keyboard tab follows:
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• Category - This is a list of all the main menu headings. Select a menu head-
ing to category to see the associated commands in the Commands area.

• Commands - This is a list of all the commands associated with the selected 
main menu heading in the Category area.

• Key assignments - This displays the current key assignment for the com-
mand selected in the Commands area.

• Press new shortcut key - This allows the user to enter a shortcut key 
combination for the command selected in the Commands area.

• Description - This area displays a description of the currently selected com-
mand in the Commands area.

• Assign - This button assigns the shortcut in the Press New Shortcut Key 
area to the selected command in the Commands area. If the shortcut key is 
already assigned to another command, a confirmation dialog box displays to 
allow or cancel the reassignment.

• Remove - This button removes the selected shortcut key in the Key Assign-
ments area from the selected command in the Commands area.

• Reset All - This button removes all custom key assignments. A confirmation 
dialog box displays to allow or cancel the operation.
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Procedure for Customizing Keystroke Shortcuts

1 From the Window menu, select Customize, and then click the Keyboard tab 
of the Customize dialog box.

2 Choose a category from the Category dropdown and from the Commands 
list, select the desired command to bind to a keystroke shortcut.

3 If there is already a key assignment listed in the Key assignments area, 
remove it by clicking the Remove button if so desired. The user may also just 
reassign a new key combination to the selected command. (See Step 5)

4 Click the mouse in the Press new shortcut key area.

5 Click the CTRL or ALT key and hold it down while clicking another key. The 
dual key combination will be displayed in the Press new shortcut key area. 
This combination will be the key assignment for the selected command.

6 Click the Assign button to assign the key combination to the selected 
command. If there already is a key assignment for the command, a 
confirmation box will display to confirm or cancel the reassignment.

Note: In CinePlex Editor do not bind menu operations to keystrokes that are 
associated with markers. Use only CTRL- or ALT- key combinations 
to bind to menu items, as these key combinations cannot be associ-
ated with markers.

D.4.4 Run Menu Customization

The Run Menu tab allows the user to manage menu items on the Run Menu. An 
illustration of the Run Menu tab follows:

• Menu contents - This is a list of all the menu items in the Run Menu. 
Select an item to see its characteristics in the Command, Arguments, and 
Initial Directory areas.
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• Buttons - The toolbar buttons allow the user to add a new menu item, delete 
a selected menu item, move the selected menu item upward in the list, and 
move the selected menu item downward in the list.

• Command - This area contains the name of the file that runs when the menu 
item is selected from the Run Menu. The browse button opens the standard 
Open dialog box filtered for executable files.

• Arguments - This is a list of all the arguments to be passed to the file in the 
Command area, if any. The browse button opens the standard Open dialog 
box filtered for all files. When applicable, the symbol “%1” can be used to 
denote the current document.

• Initial Directory - This contains the path of the file in the Command area. 
The path allows the system to find the file and execute it. The Browse button 
opens the standard Browse For Folder dialog box.

Procedure for Customizing the Run Menu

1 From the Window menu, select Customize, and click the Run Menu tab.

2 To add a menu item, click the New icon, enter the command in the Command 
text box, enter any arguments in the Arguments text box, and set the 
applications directory in the Initial Directory text box. In each case use the 
appropriate Browse button at the right of the text box. The Browse button for 
the command opens the standard File Open dialog box filtered for executable 
files. The Browse button for the arguments opens the standard File Open 
dialog box filtered for all files. Then Browse button for the initial directory 
opens the Browse for Folder dialog box.

3 To delete a menu item, select it and click the Delete button.

4 To reorder the menu items, select a menu item and use the Up and/or Down 
arrow buttons to reorder.

D.4.5 Options Customization

An illustration of the Options tab follows:
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• Personalized Menus and Toolbars - This area contains two check boxes 
and a button. The application will hide infrequently used menu items, but the 
user may customize the display of menu items using these two checkboxes. If 
the user check the Always show full menus checkbox, the application will 
always show full menus and the Show full menus after a short delay check-
box will be disabled. If the user does not check the Always show full menus 
checkbox, there will be the option of checking or clearing the Show full 
menus after a short delay checkbox. The Reset menu and toolbar usage 
data button will allow the user to delete the record of commands used in the 
application and restore the default set of visible commands to the menus and 
toolbars. A confirmation dialog displays.

• Other - This area contains three checkboxes and a dropdown list. If the user 
check the Large icons checkbox, the application will use large icons on the 
toolbar. If the user checks the Show Screentips on toolbars checkbox there 
will be the option of checking the Show shortcut keys in Screen Tips check-
box. The Menu animations dropdown list allows the user to select the type 
of animation to be used on menus that have animation.
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CAUTION
Never plug or unplug a camera FireWire cable with the PC Power ON. 
Permanent damage to the camera may result.
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E.1 Overview

This appendix is intended to assist customers and Plexon personnel with ques-
tions and advice regarding cabling their Plexon NDAQ/CinePlex Version 3 
(NDAQ/CPX) combination systems.

Before beginning the installation, it is important to determine that the Personal 
Computer on which the installation will be done meets the minimum system 
requirements. In general, for a MAP/CPX system, this means at least Windows 
XP Service Pack 3 computer running on an Intel Core 2 Duo processor operating 
at 3 GHz with three GB of memory, and a 9600 GT video card. FireWire (IEEE 
1394) capability must be installed. If two cameras will be used, a dual bus 
FireWire card is needed. Any computer supplied by Plexon for a MAP/CPX sys-
tem will meet minimum requirements.

Contact Plexon support (support@plexon.com) to obtain more detailed current 
requirements.

The first section is a high-level diagram of the cabling needed.

The second section contains more detailed photographic and pictorial representa-
tions of the cable connections needed for several standard MAP/CPX system 
configurations.

The third section contains photographs of the cables to facilitate identification.

The fourth section contains close-up images of cables plugged into their sockets.

Plexon’s goal is to enable the interconnection of the various CinePlex Version 3 
components on the MAP/CPX system.

Plexon hopes that this procedure solves cabling issues for most installations. 
Plexon welcomes feedback as to how to improve the experience. Pleas contact 
Plexon support (support@plexon.com, +1 214 369 4957) with comments.
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E.2 Typical MAP/CPX Cabling Diagram

There are five cables and wires over and above those needed for normal MAP 
operation:

• Universal timing cable between the TIM Cable Adaptor and the Access IO 
Adaptor.

• Sync start wire from the TIM Cable Adaptor to the XS2 BNC connector.

• Trigger cable(s) from the CinePlex Access IO Adaptor to the video camera(s).

• FireWire cable(s) from the FireWire card in the computer to the video cam-
era(s).

Note: Plexon supplies the Trigger and FireWire cables bundled together with plastic 
tiewraps. This combination is referred to as a Combination Cable on the follow-
ing pages.

• Optional (for customers purchasing the Behavior option) cable from a USB 
port on the computer to the Digital Output unit.

Below is a high-level block diagram of the cables and wiring required for correct 
operation of a MAP with its associated CinePlex Version 3 installation. The 
cables and wires are shown in black.
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E.3 Typical MAP/CPX System Cabling

This section contains pictorial representations of the cabling for several typical 
MAP/CPX setups:

• MAP/CPX system with one video camera and no CHUB

• MAP/CPX system with two video cameras and no CHUB

• MAP/CPX system with one video camera and CHUB

Please contact Plexon with questions about the setup or if it differs substantially 
from those represented.



E  

E-6  CinePlex

E.3.1 MAP/CPX System with One Video Camera, No CHUB
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E.3.2 MAP/CPX System with Two Video Cameras, No CHUB



E  

E-8  CinePlex

E.3.3 MAP/CPX System with One Video Camera, CHUB
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E.4 MAP/CPX Cable Images
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E.5 Close-up Images of MAP/CPX Cables Installed

E.5.1 Connections to MAP Box

E.5.1.1 No CHUB
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E.5.2.2 With CHUB



E  

E-12  CinePlex

E.5.2 Connections to Video Camera

E.5.3 Connections to Computer

E.5.3.1 One Video Camera
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E.5.3.2 Two Video Cameras
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